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Resumen 

 

Los riesgos geológicos son propios de la superficie terrestre y están asociados a 

condicionantes geológicos, fenómenos naturales y acciones antrópicas, los cuales 

presentan un peligro latente que puede considerarse como una amenaza para el 

desarrollo social y económico de un territorio determinado. 

En esta tesis se analizará el riesgo geológico a partir de una evaluación previa de 

amenazas y vulnerabilidades respectivamente, entendiéndose la amenaza como 

la probabilidad de que se manifieste un evento natural y la vulnerabilidad como la 

dificultad de la población para anticipar y enfrentar estos tipos de fenómenos 

físicos o antrópicos capaces de causar daños sociales y económicos 

principalmente. 

Es así, que se analizan metodologías para que los Planificadores de los Gobiernos 

Autónomos Descentralizados a nivel Cantonal puedan realizar este tipo de análisis 

de riegos geológicos  utilizando información secundaria disponible a través de los 

sistemas de información geográfica. 

La aplicación metodológica se realizó en el cantón Chordeleg de la provincia del 

Azuay, con la finalidad de observar los pasos a seguir en los diferentes métodos 

analizados y obtener un mapa de riesgos que permitan tomar decisiones sobre las 

acciones a realizar en  los territorios con riesgo alto y medio. 

Por tanto, este proyecto de tesis contribuye al diagnóstico, planificación y gestión 

territorial de los riesgos geológicos relacionados a fenómenos de remoción en 

masa en los Planes de Ordenamiento Territorial a nivel cantonal. 

PALABRAS CLAVES: Amenaza, vulnerabilidad, riesgo, riesgo geológico, 

fenómenos de remoción en masa. 

 
 

 

http://www.monografias.com/trabajos12/desorgan/desorgan.shtml
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Abstract 

 

Geological risks are unique to the earth's surface and are associated with 

geological conditions, natural phenomena and human actions, which have a latent 

danger that can be considered a threat to the social and economic development of 

a given territory. 

 

This thesis analyzed the geological risk is based on a prior assessment of threats 

and vulnerabilities respectively, understood the threat and the probability that a 

natural event and vulnerability manifests as difficulty of people to anticipate and 

address these kinds of phenomena physical or man capable of causing damage 

mainly social and economic. 

 

Thus, to analyze methodologies for planners of autonomous governments to 

Cantonal level can perform this type of analysis of risks using available geological 

and geographical information systems. 

 

The methodological application was made in the canton Chordeleg, Azuay 

province, in order to see the steps in the different methods analyzed and get a map 

of risks that allow decisions about the actions to be taken in areas with high risk 

and a half. 

 

Therefore, this thesis project in the diagnosis, planning and territorial management 

of risks related to geological phenomena in landslides Territorial Planning at the 

cantonal level. 

KEY WORDS: hazard, vulnerability, risk, geological risks, landslides. 
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INTRODUCCIÓN 

 

"Ecuador es un país que no está preparado aún para afrontar los desastres naturales y las 

razones están en la falta de una cultura preventiva en la población y de una política 

permanente de Estado que priorice la gestión de riesgos sobre la base de la ordenación 

territorial" (Pauta Calle, 2013).  

“La ocupación y utilización de la superficie terrestre por el hombre (asentamientos 

humanos, vías de transporte y comunicación, instalaciones industriales y mineras, 

embalses y canales, explotaciones agrarias, etc.), suponen la transformación y 

aprovechamiento de los materiales y de las formas del medio geológico, cuyo 

conocimiento debe estar presente a la hora de diseñar y ordenar actividades.  Por otro 

lado, el medio geológico, contrariamente a la idea general no es estático sino que sufre 

una serie de procesos (naturales o inducidos por el hombre) que afectan, a su vez, a todo 

cuento sobre él se asienta, son los procesos geodinámicos (internos o externos) que 

pueden convertirse en riesgos geológicos cuando interfieren sobre personas y bienes 

materiales”  (Gómez Orea, 2008). 

Los riesgos geológicos son propios de la superficie terrestre y están asociados a 

condicionantes geológicos, fenómenos naturales y acciones antrópicas, los cuales 

presentan un peligro latente que puede considerarse como una amenaza para el 

desarrollo social y económico de un territorio determinado. 

El análisis del riesgo geológico debe partir de una evaluación previa de amenazas y 

vulnerabilidades respectivamente, entendiéndose la amenaza como la probabilidad de 

que se manifieste un evento natural y la vulnerabilidad como la dificultad de la población 

para anticipar y enfrentar estos tipos de fenómenos físicos o antrópicos capaces de 

causar daños, pero también estar en condición de enfrentarlos y superarlos después de 

su ocurrencia; debido a que “la localización de varias actividades se ha  producido al 

margen de la consideración de los riesgos naturales del territorio, tales son las que 

entrañan los asentamientos humanos concentrados, las vías regionales e interurbanas, 

las minas y canteras”  (Pauta Calle, 2013). 

 

Los Gobiernos Autónomos Descentralizados Cantonales según la Código Orgánico de 

Organización Territorial Autonomía y Descentralización ejercen el control sobre el uso y 

ocupación del suelo en el cantón dentro de sus competencias exclusivas, y son ellos los 

encargados de determinar en sus planes de ordenamiento territorial las zonas con riesgos 

geológicos, con la finalidad que una vez localizados los puedan manejar y vincular al resto 

de subsistemas analizados utilizando la relación “uso del suelo/territorio”, es decir, “si las 

actividades humanas pueden alterar los elementos y procesos naturales, también algunos 

de estos, genéricamente denominados riesgos naturales, pueden producir efectos 

indeseados en la actividad según su localización. Por consiguiente condicionan la 

capacidad de acogida del territorio” (Gómez Orea, 2008). 

Gomez Orea establece como uno de los objetivos de la Ordenación Territorial, la 

utilización racional del territorio y gestión responsable de los recursos naturales, en el que 

http://www.monografias.com/trabajos12/desorgan/desorgan.shtml
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se pretende conservar los procesos ecológicos esenciales, respetar los criterios 

ecológicos para la sostenibilidad y evitar la localización de actividades vulnerables en 

zonas de riesgo, este último enfocado directamente con el tema de investigación 

propuesto. Si se realiza el análisis solamente mediante el cruce de variables de amenaza 

y vulnerabilidad se obtienen resultados que adolecen de problemas de aplicabilidad por la 

presión social que existe en el uso del territorio, por lo cual el presente trabajo introduce 

un concepto adicional que es la categorización del riesgo con el fin de que los GADs 

tengan herramientas que les permitan dar respuestas más apegadas a la realidad, a la 

población que se asienta en el territorio de injerencia del Gobierno Autónomo 

Descentralizado. 

El continuo cambio, en los territorios, generado por las diferentes actividades del ser 

humano, tras la búsqueda de tierras para darles un uso urbano o agroproductivo, ha  

incremento la vulnerabilidad frente a las amenazas naturales. Este incremento, obliga a 

Planificadores a tomar decisiones en los diferentes niveles de gobierno y a revisar los 

escenarios del uso actual y futuro del suelo que con relación a los riesgos a los que 

estarían expuestos. 

 

En este contexto, el tema de investigación propuesto es dirigido a la línea de 

investigación: “Detección y estudio de los problemas que debe atender y prever la 

ordenación territorial en el Ecuador y formulación de instrumentos destinados a su 

atención, los Planes Integrales y Sectoriales de Ordenación Territorial” de la maestría de 

Ordenación Territorial cuyo objetivo central es: 

“Establecer procedimientos, fuentes de información y requerimientos de 

consultoría para analizar el riesgo geológico con su zonificación y clasificación en 

el subsistema físico ambiental dentro de los Planes de Ordenamiento Territorial a 

nivel cantonal” 

Los objetivos específicos son: 

 Determinar factores que deberían ser considerados para la zonificación y 

clasificación riesgo geológico dentro del subsistema físico ambiental de los planes 

de ordenamiento territorial a nivel cantonal. 

 

 Proveer una herramienta metodológica para desarrollar el análisis de riesgo 

geológico dentro del territorio cantonal. 

 

 Inventariar las fuentes de información disponibles que aportan en el desarrollo del 

análisis de riesgo geológico disponibles en la Zona 6 de Planificación. 

 

 Proponer criterios que deberían ser considerados ante cierto tipo de riesgos 

geológicos al momento de elaborar la propuesta y modelo de gestión de los 

planes de ordenamiento territorial. 
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En este sentido se revisaran conceptos y definiciones acerca de amenazas, 

vulnerabilidades,  y riesgos para en función de ellos conocer las metodologías que 

podrían aplicarse para la caracterización del entorno geográfico bajo análisis, con la 

finalidad de establecer directrices que permitan a los Planificadores evitar o reducir 

riesgos geológicos a través del conocimiento del territorio, por lo que se aplicarán 

metodologías establecidas para: 

- Evaluar amenazas en función de información secundaria disponible. 

 

- Evaluar los factores físicos, sociales y económicos que generan vulnerabilidades, con 

base al procesamiento de datos e información secundaria y primaria.  

 

- Evaluar el riesgo geológico en base al análisis de las amenazas y vulnerabilidades, en 

las diferentes fases de los Planes de Ordenamiento Territorial diagnóstico, 

planificación y gestión territorial según la metodología propuesta por Domingo Gómez 

Orea. 

 

Esta investigación no pretende ser exhaustiva en los procesos metodológicos específicos 

para la evaluación, zonificación y clasificación de las amenazas, vulnerabilidades y 

riesgos geológicos. 

Debido a que la ocurrencia de estos “fenómenos esta sujeta a muchos grados de 

incertidumbre, dado que los mismos pueden presentar diferentes tipos de movimientos, 

velocidades, modos de falla, materiales, restricciones geológicas, etc” (Suarez, 1998); 

sino más bien indicar diferentes metodologías que se podrían aplicar en base a la 

información disponible en los territorios a nivel cantonal en las provincias de Azuay, Cañar 

y Morona Santiago que pertenecen a la Zona 6 de Planificación de la República del 

Ecuador. 

Este análisis está sujeto a una explicación a detalle de cómo obtener cada uno de los 

parámetros necesarios para la generación de los mapas de amenazas, vulnerabilidades y 

riesgos, aplicando métodos estadísticos a través de los  Sistemas de Información 

Geográfica -SIG-. 

Este trabajo pretende convertirse en un manual para los Planificadores en el tema de 

riesgos geológicos; debido a que este análisis no es abordado con la profundidad que el 

caso lo amerita en los Planes de Ordenamiento Territorial  a nivel cantonal, por lo que en 

algún momento estas amenazas geológicas relacionadas a fenómenos de remoción en 

masa y vulnerabilidades podrían desencadenar riesgos geológicos afectando a 

poblaciones e infraestructuras aledañas a la zona de activación. 

Los cuadros e ilustraciones han sido elaborados por el autor de este trabajo Ing. Andrea 

Brito P. 

En el capítulo 1, referente a Fundamentación Teórica, se realiza una revisión bibliográfica, 

que permite definir los factores a ser utilizados como insumos para zonificar y clasificar el 
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Riesgo Geológico en el territorio, a través del análisis de propuestas metodológicas 

planteadas por diferentes autores para este tipo de investigaciones, el tipo de proceso 

estadístico y análisis espacial seleccionado va a depender de la disponibilidad y calidad 

de información existente a la hora de determinar las amenazas, vulnerabilidades y riesgos 

geológicos en determinado territorio. 

 

El capítulo 2, detalla las fuentes de información existente a nivel de la Zona 6 de 

Planificación, para proveer los elementos de análisis necesario al Planificador.  Se incluye 

información de contactos de instituciones que cuentan con información cartográfica, 

geológica, riesgos naturales, hidrológico y ortofotos, indicando las escalas existentes y 

tipo de información. En el tema referente a población y vivienda los datos de los Censos 

Poblacionales constituyen la fuente oficial de información, sin dejar de considerar las 

diferentes proyecciones poblacionales y estudios relacionados que se encuentran en el 

Sistema Nacional de Información. Además, se indica la forma en la que los Gobiernos 

Autónomos Descentralizados a nivel cantonal podrían acceder a este tipo de información. 

 

El capítulo 3, se refiere a la identificación y caracterización del área de aplicación de las 

metodologías analizadas, en donde encontrará los justificativos de escoger al cantón 

Chordeleg como área de aplicación de las metodologías analizadas, así como la 

descripción de los principales aspectos relacionados al medio físico, social y económico 

productivo del cantón. 

 

El desarrollo del capítulo 4 referido a Amenazas, aborda la determinación de los factores 

que permiten zonificar y clasificar las amenazas, partiendo del análisis de información 

existente, para a través de un sistema de información geográfico procesar la misma en 

base a los métodos analizados en el capítulo 1, al final de capítulo se podrá observar los 

mapas de amenazas elaborados para las distintas metodologías estudiadas. 

 

En el capítulo 5, referente a Vulnerabilidades se presenta los factores considerados para 

la zonificación y clasificación de las vulnerabilidades, en base al análisis de información 

existente, para a través de un sistema de información geográfico procesar la misma en 

base a los métodos analizados en el capítulo 1, al finalizar este capítulo se podrá observar 

el mapa de vulnerabilidad. 

 

Los resultados de los capítulos 4 y 5, son utilizados en el capítulo 6 riesgos geológicos, 

para a través de un SIG procesar la información y analizar el mapa de riesgo obtenido. En 

este capítulo, se analiza el método del Índice de Deslizamiento, en el cual a través de la 

elaboración de distintos parámetros se obtiene directamente el mapa de riesgos, el cual 

se compara a los obtenidos por el cruce de amenazas y vulnerabilidades. 

 

El capítulo 7 referido a la Matriz de Decisiones, indica los pasos que los Gobiernos 

Autónomos Descentralizados a nivel cantonal deberán seguir, una vez que cuenten con 

los resultados de la zonificación y clasificación del riesgo geológico en su territorio en las 

fases de diagnóstico, planificación y gestión territorial propuestas por Domingo Gómez 
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Orea y que están en relación a lo determinado en el Artículo 42 del Código Orgánico de 

Planificación y Finanzas Públicas. 

 

Finalmente, en el capítulo 8  se exponen las conclusiones y recomendaciones de la 

investigación realizada y se citan las referencias bibliográficas revisadas y los anexos. 
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1. FUNDAMENTACIÓN TEÓRICA 

 

1.1 AMENAZA 

 

En el año 2009 la Estrategia Internacional para la Reducción de Desastres de las 

Naciones Unidas -UNISDR, publica "Terminología sobre Reducción del Riesgo de 

Desastres" con el propósito de promover un entendimiento y la utilización en común de 

conceptos relativos a la reducción del riesgo de desastres, definiendo a la amenaza como 

"Un fenómeno, sustancia, actividad humana o condición peligrosa que puede ocasionar la 

muerte, lesiones u otros impactos a la salud, al igual que daños a la propiedad, la pérdida 

de medios de sustento y de servicios, trastornos sociales y económicos, o daños 

ambientales"  (Estrategia Internacional para la Reducción de Desastres de las Naciones 

Unidas, 2009).      

La amenaza se puede expresar también a partir del Período de Retorno (T) que se 

define como el tiempo en años transcurridos entre 2 eventos o procesos de semejantes 

características, siendo la inversa de la probabilidad anual de excedencia,  

 

La amenaza o peligrosidad como se la conoce, hace referencia a la frecuencia de 

ocurrencia de un proceso y al lugar. Se define como la probabilidad de ocurrencia de un 

proceso de un nivel de intensidad o severidad determinado, dentro de un período de 

tiempo dado y dentro de un área específica, el Cuadro 1, indica el período de vida útil de 

distintas infraestructuras (González de Vallejo, Ferrer, Ortuño, & Oteo, 2002). 

 
 
En donde, el tiempo t (años) es el período de vida útil de las estructuras y  T el período de 
retorno en años. 

Cuadro 1. Período de vida útil para distintas instalaciones (t) 

Estructura o instalación T (años) 

Almacenamiento de residuos radiactivos 10.000 

Centrales nucleares 40 - 80 

Presas 100 – 150 

Puentes, túneles y grandes obras de infraestructura 100 

Almacenamiento de residuos tóxicos 250 

Edificios y construcciones convencionales 50 - 70 
Fuente: (González de Vallejo, Ferrer, Ortuño, & Oteo, 2002) 

La amenaza también se define como la “magnitud probable esperada de un fenómeno, 

dentro de  un territorio y en un período dado, que puede causar daño o falla” (González 

G., 1994). 
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Es así que el término amenaza constituye un "factor de riesgo externo de un sujeto o un 

sistema, representado por un peligro latente asociado con un fenómeno físico de origen 

natural, tecnológico o provocado por el hombre, que puede manifestarse en un sitio 

específico y en un tiempo determinado, produciendo efectos adversos en las personas, 

los bienes, y/o el medio ambiente. Matemáticamente, se expresa como la probabilidad de 

exceder un nivel de ocurrencia de un evento con una cierta intensidad, en un sitio 

específico y en un periodo de tiempo determinado"  (Cardona A., 1993). 

 
En el informe Natural Disasters and Vulnerability Analysis (UNDRO 1979) la amenaza es 

considerada como  "La probabilidad de ocurrencia de un suceso potencialmente 

desastroso durante cierto período de tiempo en un sitio dado”  (Cardona A, 1979) 

En conclusión, la amenaza representa un fenómeno externo que puede causar daño a la 

población y su infraestructura. 

En el caso de estudio las amenazas analizadas están relacionadas a los fenómenos de 

remoción en masa, que básicamente se generan como: “producto de las condiciones 

geológicas, hidrológicas y geomorfológicas y las modificaciones de éstas por procesos 

geodinámicos, vegetación, uso de la tierra y actividades humanas, así como debido a la 

frecuencia e intensidad de las precipitaciones y sismicidad”  (Suárez, 1998). 

 

1.1.1 Tipos de Amenazas 

 

Una vez definido el concepto de amenaza, la misma se pueden clasificar de acuerdo a su 

naturaleza en geológica, antropológica, hidrometereológica, industrial, etc; para el caso de 

nuestro análisis nos referiremos únicamente a la geológica. 

Amenaza Geológica 

Debido a procesos geológicos, en los que se incluyen procesos terrestres internos, tales 

como terremotos, actividades y emisiones volcánicas, afines al movimiento de masas, 

aludes, desprendimiento de rocas, derrumbes en la superficie y corrientes de barro o 

escombros, siendo los factores hidrometeorológicos, geodinámicos y las actividades 

humanas, principalmente, los que contribuyen a la activación de algunos de estos 

procesos.  

La Ilustración 1, muestra rocas caídas en la carretera Cuenca – Azogues, de la provincia 

del Azuay, lo cual constituye una amenaza geológica para los usuarios de esta arteria vial, 

de lo que se conoce los factores hidrometeorológicos son los responsables de la 

activación de este proceso. 
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Ilustración 1. Caída de rocas, autopista Cuenca - Azogues 

 

Fuente: Diario El Mercurio, 14 de enero de 2010 

1.1.2 Zonificación de Amenazas 

 

“La zonificación de amenazas y riesgos permite evaluar, parcialmente, esa incertidumbre 

y es una herramienta muy útil para la toma de decisiones, especialmente en las primeras 

etapas de planeaciónde un proyecto. La zonificación consiste en la división del terreno en 

áreas homogéneas y la calificación de cada una de estas áreas de acuerdo al grado real o 

potencial de amenaza o de riesgo”  (Suárez, 1998). 

 

Para realizar la zonificación se puede partir de un mapeo en donde se identifica las áreas 

que cuentan con información de la ocurrencia de deslizamientos  o de un inventario de 

estos eventos, o sobre áreas de las cuales se tenga la información base, en las cuales no 

se tiene conocimiento de deslizamientos en el pasado, para lo cual es necesario predecir 

la posibilidad de amenazas en el futuro. 

 

La metodología aplicada para zonificar las amenazas puede realizarse a través de un 

mapeo directo en base a la experiencia o un mapeo indirecto en base a los factores que 

contribuyen a su ocurrencia. 

 

Existen dos técnicas a través de las cuales se puede realizar la zonificación, el análisis 

relativo referido a la posibilidad referencial de ocurrencia de deslizamientos sin dar valores 

exactos y el análisis absoluto a través de factores de seguridad o probabilidad real de 

ocurrencia de movimientos. 

 

La Ilustración 2, nos indica el resultado al que tendríamos que llegar una vez realizada la 

zonificación de la amenaza, en función de los diferentes parámetros ha analizar. 
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Ilustración 2. Zonificación de amenazas a los deslizamientos 

 

Fuente: (Suárez, 1998) 

 (Suárez, 1998) ha diferenciado las técnicas de zonificación en tres formatos: 

 

 Modelos de caja blanca (White box model), los cuales se basan en modelos físicos 

de estabilidad de taludes y modelos hidrológicos. A estos se les conocen como 

modelos determinísticos. 

 Modelos de caja negra (Black box model), los cuales se basan en análisis 

estadístico solamente. 

 Modelo de caja gris (Gray box model), basados parcialmente en modelos físicos y 

parcialmente en estadística. 

 

Además, la zonificación se puede realizar en diferentes escalas de acuerdo a la 

Asociación Internacional de Ingeniería Geológica 1976 como puede observarse a 

continuación: 

 

 Escala nacional (más de 1:1.000.000).  

 Escala regional (1:100.000 a 1:500.000). 

 Escala de cuenca (1:25.000 a 1:50.000). Esta escala da información de la 

amenaza o riesgo y permite realizar evaluaciones de costos. 

 Escala grande (1:5.000 a 1:15.000). A esta escala se puede tomar decisiones 

sobre las acciones a realizar durante la prevención y manejo del riesgo 

 

Dependiendo de la escala se pueden obtener mapas de utilidad diversa, por ejemplo para 

planeación general se pueden utilizar mapas a escala regional, trabajando áreas de hasta 
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1.000 kilómetros cuadrados pero para zonificacion urbana se requiere trabajar en escalas 

grandes que permitan trazar líneas muy claras de delimitación de las áreas de amenazas. 

 

Para realizar la zonificación de las amenazas se van a revisar los métodos de la 

Secretaría de Gestión de Riesgos, Brabb 1972 y Mora y Vahrson 1994, que son los que 

más se utilizan por el número de parámetros de análisis que intervienen para la 

determinación de las amenazas, además, es importante decir que los parámetros son de 

fácil determinación en nuestro medio y permiten realizar el análisis sin mucha 

complejidad. 

 

Método de Brabb (1972) 

El método de Brabb es de tipo explícito empírico y su metodología es utilizada para 

evaluar la susceptibilidad de los fenómenos de remoción en masa (FRM) en el cual se 

utilizan tres factores:  

 Inventario de fenómenos de remoción en masa 

 Unidades litológicas  

 Pendientes 

Para realizar la aplicación de esta metodología en un caso práctico es necesario que se 

sigan los siguientes pasos: 

Definir las áreas que corresponden a cada unidad y subunidad litológica. Dichas unidades 

litológicas deben ser separadas por sus características mecánicas e hidráulicas. 

Sobreponer el inventario de FRM sobre las unidades litológicas, con la finalidad de 

identificar el número de áreas deslizadas en cada Unidad. 

Ordenar en orden creciente los porcentajes de masas deslizadas por unidad litológica, 

con la finalidad de determinar la susceptibilidad relativa o parcial (SP) e identificarlas con 

numerales I, II, III, IV, V y VI. 

La clase más alta de susceptibilidad (L) se asigna a los depósitos de FRM, porque 

contienen mucha más área deslizada que las unidades litológicas de las cuales ellos 

provienen, así los depósitos de FRM se consideran como una unidad litológica. 

Las otras clases de susceptibilidad parcial (I a VI) se determinan en función de intervalos 

convenientes de los porcentajes de masa deslizada identificados para cada unidad 

litológica, asignándole un símbolo a cada uno de ellos. 

Sobreponer el mapa de pendientes al mapa litológico y al de inventario de FRM 

combinados; determinar los intervalos de pendiente que muestran la máxima frecuencia 

de FRM para cada unidad litológica. Los intervalos de pendiente que presentan los 

valores máximos, son etiquetados con las clases de susceptibilidad más alta (números 

romanos). 
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Los intervalos de pendiente que muestran significativamente menos FRM son etiquetados 

con numerales de clases de susceptibilidad menores. Así, la unidad litológica que tenga 

una susceptibilidad parcial (SP) máxima de III, puede ser designada con ese numeral 

solamente donde las pendientes excedan el 30% y debido a que se espera tener menor 

número de FRM en las pendientes menores pueden ser II o inclusive I, dependiendo de la 

razón de cambio entre la susceptibilidad parcial y la pendiente. Los rangos de pendientes 

determinados en la metodología no tienen una solución estadística y no son uniformes (5, 

10, 15, 20%)  (Varnes, 1984). 

El mapa de susceptibilidad por FRM obtenido con esta metodología puede incluir dentro 

de la misma clase de susceptibilidad unidades de rocas resistentes en terrenos con 

pendientes fuertes y unidades litológicas con rocas de baja resistencia en terrenos de 

media y baja pendientes. De igual forma, los límites de clases de susceptibilidad pueden 

separar rocas de igual resistencia que tengan diferentes susceptibilidades en cada rango 

de pendientes. 

Este mapa además, no muestra distinción cartográfica entre los diferentes tipos de FRM o 

sobre el grado de actividad, aunque los FRM activos fueron identificados en el mapa de 

Inventario de FRM. 

La Ilustración 3, muestra la esquematización de los paso a seguir utilizando el método de 

Brabb. 

 

Ilustración 3. Esquematización método de Brabb, 1972 

 

 

 

 

 

 

 

 

Fuente: Autor 

 

Mora y Vahrson (1994) 

La metodología propuesta por Sergio Mora y Wilhelm-Guenther Vahrson fue desarrollado 

en Costa Rica y tiene por objeto predecir las amenazas. El método presenta un modelo 

Inventario de Fenómenos 

de Remoción en Masa (L) 

Mapa Cartográfico del 
área de estudio 

Mapa Geológico del 
área de estudio 

Mapa de Pendientes  Mapa de Unidades 
Litológicas (I a VI) 

Mapa de Susceptibilidad Parcial (I a VI y L) 

Mapa de Susceptibilidad por Fenómenos de Remoción en Masa 
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para el análisis de la amenaza relativa de deslizamientos utilizando indicadores 

morfodinámicos, teniendo como fin la definición y jerarquización de posibles áreas 

críticas, por medio de una estimación semiprobabilística del potencial de deslizamientos  

(González, 2005). 

Mora y Vahrson son claros al establecer que su planteamiento es un método preliminar y 

como tal debe tratarse, de tal forma que las áreas definidas como críticas deben ser 

sometidas a un análisis detallado y más profundo que permita comprobar tales resultados. 

A la vez señalan que la forma de combinar los valores (multiplicación y adición) 

representa de una manera relativamente fiel, la interacción de los procesos analizados, 

según su propia experiencia  (Mora & Vahrson, 1994). 

La metodología requiere un inventario de laderas inestables, que consiste en identificar y 

cartografiar todos los indicios de inestabilidades presentes en el terreno, aunque la 

metodología no involucra dentro de sus parámetros, el uso del suelo, ni la intervención 

antrópica, es útil conocer las áreas que, aún sin intervención del hombre, representan una 

amenaza natural. 

La esencia de la metodología se basa en la combinación de factores intrínsecos de 

susceptibilidad, tales como el relieve relativo, las condiciones litológicas y la humedad 

natural del suelo, y factores detonantes, tales como las intensidades sísmicas y las 

pluviométricas. La calificación de dichos factores se establece en términos de 

susceptibilidad a los movimientos en masa, en la caso de los primeros, y de favorabilidad 

para la ocurrencia de los mismos en el caso de los factores detonantes, siendo mayor el 

puntaje para las condiciones de mayor susceptibilidad y para las de mayor favorabilidad 

en la ocurrencia de movimientos en masa. 

La formulación matemática del método se resume en la siguiente expresión (González, 

2005): 

 

Donde: 

 Es el índice de amenaza relativa por deslizamiento 

 Es el índice de relieve relativo 

  Es el índice de influencia litológica 

  Es el índice relacionado con la humedad del suelo 

  Es el índice de influencia de la actividad sísmica 

 Es el índice de influencia de las lluvias intensas 

Según las particularidades tectónicas y climáticas de determinada región, puede dársele 

prioridad a la consideración de determinado detonante así: 
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Potencial generador de deslizamientos por la Intensidad Pluviométrica 

 

Potencial generador de deslizamientos por la Sismicidad 

 

Para la aplicación de la metodología, en escalas de trabajo intermedias (1:25.000 a 

1:50.000), el área deber ser subdividida de acuerdo a un retícula, cuyo ancho de rejilla se 

establece según la escala de trabajo; en este caso, el ancho de la rejilla debería estar 

entre 100 y 1000 metros (Mora & Vahrson, 1994). 

El resultado de la aplicación de esta metodología indica condiciones de relatividad, al 

comparar situaciones adyacentes, es decir entre los píxeles circunscritos en el área de 

estudio. 

A continuación, se detalla  cada uno de los parámetros de la formulación matemática del 

método de Mora y Vahrson 1994. 

 

Índice de Relieve Relativo 

Se define como la mayor diferencia de elevación en el área de cada píxel , por 

Km2. 

 

 

Mora y Vahrson (1994), señala que algunas correlaciones indican un crecimiento 

exponencial de la susceptibilidad a deslizamientos, hasta que alcanzan valores muy altos 

, luego de los cuales se estima que las elevadas pendientes 

corresponden con la presencia de rocas, lo cual reduce significativamente la posibilidad 

de que se presente un deslizamiento, contrario a lo que ocurrirá para valores bajos de 

este parámetro. 

La mejor forma de analizar el índice de relieve relativo, según recomiendan los autores, es 

clasificándolo por medio de una distribución estadística, generalmente la distribución 

normal, para obtener así una forma adecuada de calificar la influencia del relieve y su 

peso relativo dentro de la zonificación. El Cuadro 2, indica los valores del parámetro de 

calificación original del Factor de Relieve Relativo. 
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Cuadro 2. Calificación original del factor de relieve relativo Rr. 

Relieve Relativo 
(m/Km

2
) 

Calificativo 
Valor del Parámetro 

Rr 

0 – 75 Muy Bajo 0 

75 – 175 Bajo 1 

175 – 300 Moderado 2 

300 – 500 Mediano 3 

500 – 800 Alto 4 

> 800 Muy Alto 5 
Fuente: (González, 2005) 

 

 

Índice de Influencia de la Litología 

Se valora en función de la descripción litológica establecida por Mora y Vahrson como se 

observa en el Cuadro 3. Es claro que ante la ausencia de datos geotécnicos cuantitativos, 

estos deben sustituirse con la aplicación de calificativos subjetivos, para lo cual se hace 

necesario revisar los criterios y adaptarlos, redefiniendo las clases de influencia sugeridas 

por los autores  (González, 2005). 

Cuadro 3. Calificación original de diferentes litologías y su susceptibilidad 

Litología Calificación 
Factor 

L 

Aluvión compacto permeable , calizas permeables, rocas intrusivas 
ligeramente fisuradas, basaltos, ignimbritas, andesitas; bajo grado de 
meteorización, niveles freáticos bajos, poco fisuradas y altas 
resistencias al corte 

Baja 1 

Alto grado de meteorización de las litologías mencionadas anteriormente 
y de rocas sedimentarias masivas; baja resistencia al corte y fracturas 
de cizalla 

Moderada 2 

Rocas sedimentarias, intrusivas, metamórficas y volcánicas 
considerablemente meteorizadas; suelos regolíticos arenosos 
compactos, fracturación considerable y nivel freático fluctuante. 

Media 3 

Meteorización considerable, alteración hidrotermal de cualquier clase de 
rocas; rocas fuertemente fracturadas y con fisuras llenas de arcilla; 
suelos piroclásticos y fluvio lacustres pobremente compactados, niveles 
freáticos poco profundos. 

Alta 4 

Rocas extremadamente alteradas; suelos residuales, coluviales y 
aluviales con baja resistencia cortante, niveles freáticos poco profundos. 

Muy Alta 5 

Fuente: (Mora & Vahrson, 1994) 

 

Índice de Influencia de la Humedad del Suelo 

Para determinar el índice de influencia de la humedad del suelo, se utilizan valores 

promedios mensuales de precipitación y evapotranspiración, efectuando con estos datos 

un balance hídrico simplificado. Los autores asumieron una evapotranspiración potencial 

promedio de 125 mm mensuales, para lo cual precipitaciones mensuales inferiores a 125 
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mm no implican aumento de humedad en el suelo, mientras que una precipitación entre 

125 y 250 mm si produce aumento, y precipitaciones superiores a 250 mm conducen a 

una humedad muy alta. Asignándose de esta manera valores a las precipitaciones como 

se indica en la Cuadro 4. 

Cuadro 4. Valores asignados a los promedios mensuales de lluvias 

Precipitación Mensual 
(mm) 

Valor 
Asignado 

< 125 0 

125 - 250 1 

> 250 2 
Fuente: (González, 2005) 

Posteriormente, los valores asignados se sumaron, obteniéndose así un resultado que 

varía, según la estación meteorológica, entre 0 y 24 unidades. El resultado refleja 

aspectos de la saturación del suelo, así como la distribución temporal de la presencia de 

humedad. Su clasificación se muestra en el Cuadro 5. 

Cuadro 5. Clasificación del parámetro de humedad 

Suma de los valores 
asignados 

Calificativo 
Valor de 

parámetro Sh 

0-4 Muy Bajo 1 

5-9 Bajo 2 

10-14 Medio 3 

15-19 Alto 4 

20-24 Muy Alto 5 
Fuente: (González, 2005) 

 

 

Índice de Influencia de Actividad Sísmica 

Mora y Vahrson (1993) analizaron varios eventos sísmicos, a partir de 1888, que 

generaron fenómenos de remoción en masa –FRM- importantes en el Valle Central de 

Costa Rica. Considerando las condiciones litológicas, de relieve y de lluvias, además, 

observaron que el potencial de deslizamientos a partir de sismos puede correlacionarse 

con la Escala de Intensidades de Mercalli Modificada –MM-, Cuadro 6. El Cuadro 6 indica 

la capacidad generadora de deslizamientos de los sismos según su intensidad MM y el 

valor del factor respectivo. 

Cuadro 6. Calificación del factor sismicidad 

Intensidad 
Mercalli 

Modificada 
Calificativo 

Valor de 
parámetro 

Ts 

III Leve 1 

IV Muy Bajo 2 

V Bajo 3 

VI Moderado 4 

VII Medio 5 

VII Elevado 6 



 
Universidad de Cuenca                                                                                                                 
Facultad de Arquitectura y Urbanismo 
Maestría en Ordenación Territorial II Cohorte                                                                     

32 
Ing. Andrea Valerie Brito Puni 

IX Fuerte 7 

X Bastante Fuerte 8 

XI Muy Fuerte 9 

XII 
Extremadamente 

Fuerte 
10 

Fuente: (González, 2005) 

Índice de influencia de las lluvias intensas 

Para determinar el índice de influencia de las intensidades potenciales de las lluvias, los 

autores utilizaron los valores de lluvias máxima diaria para un período de retorno de 100 

años, aplicando la distribución GUMBEL a series temporales de lluvias extremas con 

tiempo de registro de más de 10 años. En el Cuadro 7 se observa la ponderación 

posterior de los valores para series mayores y menores a 10 años. 

 

Cuadro 7. Clasificación de los valores de las lluvias máximas de una duración del día 

con un período de retorno de 100 años 

Precipitaciones máx. 
en 24 horas (mm) 

n>10 años, Tr = 100 
años (GUMBEL) 

Precipitaciones máx. 
en 24 horas (mm) 

N<10 años, Tr = 100 
años, Promedio 

Calificativo 
Valor del Parámetro 

Tp 

< 100 < 50 Muy Bajo 1 

100 – 200 51 – 90 Bajo 2 

200 – 300 91 – 130 Mediano 3 

300 – 400 130 – 175 Alto 4 

> 400 > 175 Muy Alto 5 
Fuente: (González, 2005) 

Con los valores descritos, Mora y Vahrson (1993) determinaron los valores de 

Clasificación de niveles de amenaza para el Valle Central de Costa Rica, según valores 

potenciales que se observan en el Cuadro 8. 

Cuadro 8. Clasificación del nivel de amenaza por FRM 

Potencial Clase Calificativo 

0 – 6 I Muy Bajo 

7 – 32 II Bajo 

33 – 162 III Moderado 

163 – 512 IV Medio 

513 – 1250 V Alto 

> 1250 VI Muy Alto 
Fuente  (González, 2005) 

1.1.3 Clasificación de Amenazas 

 

Para clasificar las amenazas se sugieren cinco zonas, que representarán zonas de 

amenazas: Muy Alta, Alta, Media, Baja y Nula; los valores de frontera entre estas 

cualificaciones se definen a partir del Histograma de Frecuencias de los valores de peso 

total obtenidos al combinar los raster de análisis de manera que los mismos representen 
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cambios cualitativos importantes y sean cotejados con observaciones realizadas en 

campo. 

  

El resultado obtenido es un mapa en donde encontramos cualificaciones de amenazas 

que pueden ser clasificadas por varios métodos mediante la utilización de sistemas de 

información geográfica, para nuestro caso en particular se utilizará el ArcGis pudiendo 

estos métodos ser: Manual, Equal Interval, Defined Interval, Quantile, Natural Breaks 

(Jenks), Geometrical Interval y Standar Deviation, lo cual dependerá del análisis que se 

encuentre realizando el Planificador. 
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1.2 VULNERABILIDAD 

 

De acuerdo a la terminología publicada por la Estrategia Internacional para la Reducción 

de Desastres de las Naciones Unidas (UNISDR), se define vulnerabilidad como "las 

características y las circunstancias  de una comunidad, sistema o bien que los hacen 

susceptibles a los efectos dañinos de una amenaza" (Estrategia Internacional para la 

Reducción de Desastres de las Naciones Unidas, 2009). 

 

Según (Cardona A., 1993), la Vulnerabilidad se define como la predisposición intrínseca 

de un sujeto o elemento a sufrir daño, debido a posibles acciones externas, o también 

como el grado de pérdida de un elemento o grupo de elementos bajo riesgo, resultado de 

la probable ocurrencia de un evento desastroso, expresada en una escala que va de 0, 

sin daño a 1, pérdida total. 

 

La vulnerabilidad está bajo la óptica de las interacciones de variables sociales, 

económicas, y políticas como desigualdades regionales, de ubicación social, étnica y de 

género, la operación de los mercados de tierras e inmuebles y los mecanismos políticos 

de toma de decisiones; los cuales condicionan y determina procesos más amplios como 

urbanización, movimientos y desplazamientos demográficos masivos, problemas de 

sobreacumulación, endeudamiento, guerras externas y civiles (Maskrey, 1993). 

 

Posteriormente, redefine a la vulnerabilidad como una visión dinámica y multidimensional 

de procesos, a la vez permite saltar de una visión que justifica desastres cotidianos como 

males necesarios para mantener una determinada organización de la sociedad, la 

economía y el territorio, hacia una visión que prioriza cambios en la forma de organización 

de la sociedad, la economía y el territorio como el "costo" necesario para reducir la 

vulnerabilidad y evitar catástrofes futuras mayores  (Maskrey, 1993). 

 

Por tanto, la vulnerabilidad es un proceso y se convierte en un factor central, para explicar 

el riesgo a desastre como en muchos casos, la magnitud e intensidad de la amenaza. 

 

Wilches-Chaux la define en cambio como "la incapacidad de una comunidad para 

'absorber' mediante el autoajuste, los efectos de un determinado cambio en su medio 

ambiente, o sea su 'inflexibilidad' o incapacidad para adaptarse a ese cambio, que para la 

comunidad constituye, por las razones expuestas un riesgo" (Wilches Chaux, 1993). 

 

Según el informe Natural Disasters and Vulnerability Analysis  (UNDRO, 1979), se define 

la vulnerabilidad como "el grado de pérdida de un elemento o grupo de elementos bajo 

riesgo resultado de la probable ocurrencia de un suceso desastroso, expresada en una 

escala desde 0 sin daño a 1 pérdida total".   

 

La vulnerabilidad de la población a eventos extremos que puedan causar consecuencias 

adversas sobre las comunidades o grupos humanos expuestos a tales eventos, es un 

concepto multidimensional  
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Un concepto adicional es el de vulnerabilidad social, la cual depende de la densidad de 

la población, condiciones de los edificios y estructuras, sistemas de aviso y alerta y planes 

de emergencia y evacuación. 

 

Entre los elementos a considerar para la zonificación de la vulnerabilidad estarían 

personas, bienes, propiedades, infraestructuras, servicios, actividades económicas, etc., 

las cuales podrían sufrir consecuencias directas o indirectas de un proceso geológico en 

una determinada zona. 

 

1.2.1 Factores condicionantes de la vulnerabilidad  

 

(Llanos, 2012), indica que los factores condicionantes de la vulnerabilidad están 

relacionados: 

 

 Grado de exposición, referido al tiempo y modo de sostenimiento de un 

ecosistema a los efectos de una actividad o energía potencialmente peligrosa. 

 

 Protección, relacionado a las defensas de sus elementos, que reducen o eliminan 

los efectos que puede causar una actividad potencialmente destructiva, y que 

debe estar activa en el momento de la exposición a la fuerza desestabilizadora. 

 

 Reconstrucción, concebido como la restauración del equilibrio y  de las 

condiciones normales de vida de un ecosistema, por su retorno a la condición 

anterior, o con frecuencia, a un nuevo estado más evolucionado y menos 

vulnerable. 

 

 Reacción Inmediata, constituye el restablecimiento de las condiciones esenciales 

de subsistencia de todos los componentes de un ecosistema, evitando su muerte o 

deterioro luego del evento destructivo. 

 

 Recuperación Básica o Rehabilitación, referido a la capacidad para reaccionar, 

protegerse y evitar el daño. 

 

1.2.2 Tipología de la Vulnerabilidad 

 

La Comisión Económica para América Latina –CEPAL-, en su libro “Elementos 

conceptuales para la prevención y reducción de daños originados por amenazas socio 

naturales” indica que la tipología de la Vulnerabilidad en América Latina y El Caribe se 

caracteriza por los siguientes factores  (Chaparro A & Renard R, 2005): 
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Debilidad Institucional, esto es, ineficiencia, restricciones e inexistencias de políticas 

públicas. Legislación y normas de prevención. Sistemas de información, observación y 

alerta temprana insuficiente, escasos recursos financieros, humanos y de equipamiento, 

conflictos interinstitucionales y centralización administrativa. 

 

Ignorancia del nexo conceptual entre actividad humana, e impacto ambiental y desastre, y 

ausencia de conceptos claros del correcto uso del espacio y otros recursos naturales. 

 

Baja calidad de las obras. Debido a la inexistencia o incumplimiento de normas, 

procedimientos preventivos y de gestión ambiental. 

 

Falta de mentalidad preventiva en la valoración y el tratamiento de amenazas y desastres 

por parte de la población, relacionada con la carencia de memoria histórica sobre causas 

y consecuencias de los desastres y la ausencia de opciones para los más pobres, lo que 

los hace aún más vulnerables. 

 

Poca participación de sector privado, las organizaciones de la sociedad civil y los 

gobiernos locales, lo que hace insuficiente la prevención de los desastres y su atención. 

La debilidad de la democracia  y los problemas de gobernabilidad limitan el desarrollo 

participativo. 

 

Ausencia o escasa importancia de la prevención en el discurso político y las directrices los 

gobiernos y del Estado. 

 

Incomprensión e ignorancia del impacto socioeconómico y ambiental de los desastres; 

consideración de los costos de prevención con una perspectiva economicista y no de 

inversión. La opción de privatizar el costo de los desastres por medio de los seguros no 

encuentra espacio de inversión. 

 

Poca vinculación entre la comunidad científica, y el resultado de sus estudios, con el 

proceso de formulación de políticas en materia de desastres y prevención. 

 

 

1.2.3 Zonificación de las Vulnerabilidades 

 

La zonificación de las Vulnerabilidades tomará en consideración los parámetros de 

densidad poblacional, ubicación de equipamientos de salud y educación, red hidrográfica 

y conectividad vial, accesos a servicios, actividades económicas y una vez procesados y 

reclasificados cada uno de estos parámetros, se realizará una superposición de mapas, 

para reclasificarlos y muestren zonas con iguales características de vulnerabilidad. 
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1.2.4 Clasificación de las Vulnerabilidades 

 

Para clasificar las vulnerabilidades  se sugieren cinco zonas, que representarán zonas de 

vulnerabilidad: Muy Alta, Alta, Media, Baja y Nula; los valores de frontera entre estas 

cualificaciones se definen a partir del Histograma de Frecuencias de los valores de peso 

total obtenidos al combinar los raster de análisis de manera que los mismos representen 

cambios cualitativos importantes y que sean cotejados con observaciones realizadas en 

campo. 

 

El resultado obtenido es un mapa en donde encontramos cualificaciones de 

vulnerabilidades que pueden ser clasificadas por varios métodos mediante la utilización 

de sistemas de información geográfica, para nuestro caso en particular se utilizará el 

ArcGis pudiendo estos métodos ser: Manual, Equal Interval, Defined Interval, Quantile, 

Natural Breaks (Jenks), Geometrical Interval y Standar Deviation, lo cual dependerá del 

análisis que se encuentre realizando el Planificador 

 

1.3 RIESGOS GEOLÓGICOS 

 

El análisis del riesgo geológico debe partir de una evaluación previa de amenazas y 

vulnerabilidades, debido a que “la localización de varias actividades se ha  producido al 

margen de la consideración de los riesgos naturales del territorio, tales son las que 

entrañan los asentamientos humanos concentrados, las vías regionales e interurbanas, 

las minas y canteras”  (Pauta Calle, 2013). 

En el Artículo 55 del Código Orgánico de Organización Territorial Autonomía y 

Descentralización -COOTAD- son los Gobiernos Autónomos Descentralizados 

Municipales los que ejercen control sobre el uso y ocupación del suelo en el cantón, y son 

ellos los encargados de determinar en sus planes de desarrollo y ordenamiento territorial 

estas zonas con riesgos geológicos, con la finalidad que una vez localizados los puedan 

manejar y vincular al resto de subsistemas analizados utilizando la relación “uso del 

suelo/territorio”, es decir, “si las actividades humanas pueden alterar los elementos y 

procesos naturales, también algunos de estos, genéricamente denominados riesgos 

naturales, pueden producir efectos indeseados en la actividad según su localización. Por 

consiguiente condicionan la capacidad de acogida del territorio”  (Gómez Orea, 2008). 

“La ocupación y utilización de la superficie terrestre por el hombre (asentamientos 

humanos, vías de transporte y comunicación, instalaciones industriales y mineras, 

embalses y canales, explotaciones agrarias, etc.), suponen la transformación y 

aprovechamiento de los materiales y de las formas del medio geológico, cuyo 

conocimiento debe estar presente a la hora de diseñar y ordenar actividades.  Por otro 

lado, el medio geológico, contrariamente a la idea general no es estático sino que sufre 

una serie de procesos (naturales o inducidos por el hombre) que afectan, a su vez, a todo 

cuento sobre él se asienta, son los procesos geodinámicos (internos o externos) que 

pueden convertirse en riesgos geológicos cuando interfieren sobre personas y bienes 

materiales”  (Gómez Orea, 2008). 
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Los riesgos geológicos están relacionados con procesos geodinámicos, los mismos que 

dan lugar a movimientos del terreno de diferente magnitud y características, pudiendo 

afectar de forma directa o indirecta las actividades humanas y convirtiéndose en una 

amenaza para el desarrollo social y económico de un determinado territorio. 

 

El riesgo se refiere a “la probabilidad que se presente un nivel de consecuencias 

económicas, sociales o ambientales en un sitio particular y durante un período de tiempo 

definido. Se obtiene de relacionar la amenaza con la vulnerabilidad de los elementos 

expuestos”  (Cardona & Allen, 2002). 

La distribución geográfica, frecuencia e intensidad de las amenazas, y, la vulnerabilidad 

de los elementos considerados como críticos, donde se incluye a la población, 

infraestructura, actividades económicas, hace que en los espacios donde confluyen estas 

dos condiciones, el riesgo de desastres esté en aumento y por lo tanto, los esfuerzos para 

mejorar la calidad de vida de la población, reducir los niveles de pobreza e inequidad, así 

como, el fortalecimiento de la infraestructura y funcionalidad espacial, se vean seriamente 

comprometidos.  

 

Por lo que para analizar el riesgo geológico es importante definir a que proceso 

geodinámico está relacionado, pudiendo estos ser: 

 

Externos. Cuando son provocados o desencadenados por el hombre al interferir con la 

naturaleza y modificar sus condiciones. 

 - Deslizamientos y desprendimientos 

 - Hundimientos y subsidencias 

 - Erosión 

 - Expansividad y colapsabilidad de suelos 

 

Internos. Cuando son el reflejo del carácter dinámico del medio geológico y de la 

evolución natural del relieve. 

 - Terremotos y tsunamis 

 - Vulcanismo 

 - Sismo 

 - Diapirismo 

- Expansividad y colapsabilidad de suelos 

 

1.3.1 Zonificación del Riesgo Geológico 

 

Uno de los métodos que permite obtener de manera directa una zonificación del riesgo 

geológico, es el método del Índice de Deslizamiento, desarrollado por el ITC (Faculty of 

Geo-Information Science and Earth Observation de Holanda y el cual se describe a 

continuación: 
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Método del Índice de Deslizamiento 

Este método permite caracterizar el riesgo de ocurrencia a inestabilidades a escala media, 

a través de la utilización de herramientas cartográficas básicas para la planificación 

territorial, este método utiliza el análisis espacial para establecer estadísticamente las 

ocurrencias de inestabilidades en determinadas clases de parámetros como elementos 

geográficos, geológicos, hidrográficos, antrópicos, etc, que son considerados como 

factores condicionantes o desencadenantes en los movimientos en masa. 

La determinación de la peligrosidad o amenaza a fenómenos geodinámicos es aplicable 

para la definición de áreas con riesgo medio y alto a la ocurrencia de inestabilidades, para 

ello se utilizó una herramienta GIS, e información temática generada a través de un 

análisis estadístico bivariante, la Ilustración 4 indica el número de tipo de parámetros 

utilizados para a través de esta metodología. 

Este análisis consiste en la determinación sistemática de valores de pesos de 

susceptibilidad a deslizamientos por parámetros (PESO DE PARAMETRO), por medio de 

un análisis estadístico de las áreas afectadas por inestabilidades en determinadas clases 

de un parámetro; por ejemplo para el parámetro clases de pendientes, se pretende 

determinar en qué clase de pendiente existen mayores densidades de deslizamientos, así 

a las clases con mayores densidades le corresponderán pesos mayores.  

Para la determinación de las densidades de deslizamientos (DENSCLAS) es necesario 

realizar el cruce de los mapas de cada parámetro con el de amenazas identificadas. El 

valor de densidad de deslizamiento del mapa (DENSMAP)  resulta de dividir el área total 

afectada por el área del mapa. 

La asignación de pesos en función de las densidades de deslizamientos encontradas para 

cada parámetro (DENSCLAS) utiliza la función logaritmo para conseguir pesos negativos 

para densidades que se encuentren por debajo de la media de la zona de estudio 

(DENSMAP) y positivos para los pesos que estén por encima de este valor.  

Este método está basado en la siguiente fórmula: 

 

Donde: 

PESO: La ponderación dada a una cierta clase de parámetro (p.e. un tipo de roca, 

o una clase de pendiente). 

DENSCLAS: El grado de deslizamiento dentro de la clase de parámetro. 

DENSMAP: El grado de deslizamiento de todo el mapa. 

El logaritmo natural es usado para dar un peso negativo cuando el grado de deslizamiento 

de la clase del parámetro es menor que el grado de deslizamiento del área, y positivo 

cuando sea más alto de lo normal. Combinando dos o más mapas ponderados puede ser 
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creado un mapa de riesgo. Los valores del mapa de riesgo se obtienen por una simple 

adición separada de los valores de ponderación.  

El Cuadro 9, indica los parámetros utilizados para esta evaluación han sido escogidos de 

acuerdo a la incidencia de los mismos sobre inestabilidades de terrenos, considerando 

sobre todo que su naturaleza es de ser factores condicionantes o desencadenantes de 

movimientos en masa. 

El factor con el cual se cruzan todos los parámetros analizados es el de fenómenos de 

remoción de masas, el cual puede resultar del levantamiento de información en campo,  

fotointerpretación y/o otras técnicas que permitan conseguir este tipo de información 

mapeada y georeferenciada. 

 

Cuadro 9. Parámetros considerados para la valoración del riesgo a deslizamiento 

PARAMETRO TIPO FACTOR OBSERVACIONES - CRITERIO 

Geología Condicionante 
Litologías de tipo sedimentario son más 
susceptibles a inestabilidades 

Distancia a Ríos Desencadenante 

La cercanía a ríos supone alteración 
morfológica del cauce por erosión y 
saturación del suelo lo que condiciona el 
equilibrio de taludes 

Pendientes Condicionante 
Dependiendo del tipo de inestabilidad las 
mismas serán más susceptibles en 
determinada clase de pendiente 

Lineamientos Condicionante 

Los lineamientos al relacionarse con 
estructuras como fallas, contactos o 
estratificación puede favorecer la 
ocurrencia de inestabilidades 

Uso de suelo Desencadenante 

El uso del suelo representa el factor 
desencadenante principal en el caso de 
inestabilidades, al generarse 
incompatibilidades de usos antrópicos se 
aceleran procesos erosivos y saturación 

Dirección de la 
pendiente 

Condicionante 

Con la presencia de materiales 
sedimentarios, las direcciones de 
pendientes condicionan la susceptibilidad 
de deslizamientos 

Distancia a vías Desencadenante 
La apertura de vías genera cambios 
morfológicos en los taludes de corte que 
favorecen la inestabilidad de laderas 

Caracterización 
geotécnica 

Condicionante 
El comportamiento geotécnico cualitativo 
de formaciones geológicas incide en la 
susceptibilidad de inestabilidades 

Morfología de la 
pendientes 

Condicionante 
Morfologías cóncavas o convexas de las 
laderas condicionan la susceptibilidad a 
inestabilidades 

Fuente: Plan de Riesgos del Azuay, 2012 
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Ilustración 4. Esquema de aplicación de la Metodología Utilizada 

 

Fuente: Plan de Riesgos del Azuay, 2012 
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Peso de Parámetro Geología 

Para valorar este parámetro es necesario realizar el cruce del mapa geológico con el de 

amenazas, la tabla de datos obtenida a través de esta operación permite determinar las 

densidades de deslizamiento presentes en cada clase de formación geológica. 

Peso de Parámetro Distancia a Ríos 

Para valorar este parámetro es necesario cruzar el mapa de distancia a ríos con el de 

amenazas, la tabla de datos obtenida por esta operación permite determinar las 

densidades de deslizamientos presentes en las zonas de incidencia a ríos y la que no, se 

considera la distancia a ríos y quebradas como parámetro incidente en las inestabilidades 

debido a la erosión de laderas y saturación de las mismas por el agua que transportan. 

Peso de Parámetro Pendientes 

Para valorar este parámetro es necesario cruzar el mapa de pendientes con el de 

amenazas, se utilizó el Cuadro 10,  de clases de pendientes en grados, la tabla de datos 

obtenida a través de esta operación permite determinar las densidades de los 

deslizamientos en cada clase de pendiente. 

 

Cuadro 10. Clases de pendiente en grados  

Clase de 
Pendiente 

Rango 
(Grados) 

Baja  0 - 15 

Media 15 – 35 

Alta 35 – 50 

Muy Alta > 50 
Fuente: Plan de Riesgos del Azuay, 2012 

Peso de Parámetro Fallas 

Para valorar este parámetro es necesario cruzar el mapa de incidencia de fallas con el de 

amenazas, la tabla de datos obtenida a través de esta operación permite determinar las 

densidades de deslizamiento de cada clase de incidencia de lineamientos. 

Los lineamientos son estructuras geológicas relacionadas a: fallas, contactos, 

estratificaciones, ejes anticlinales o sinclinales que potencialmente pueden incidir en las 

inestabilidades, identificados  a través de la fotointerpretación y rescatados de la geología 

regional. 

Peso de Parámetro Uso de Suelo 

Para valorar este parámetro se debe cruzar el mapa de uso de suelo con el mapa de 

amenazas, la tabla de datos obtenida a través de esta operación permite determinar las 

densidades de deslizamiento presentes en cada clase de uso de suelo.  
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Peso de Parámetro Dirección de la Pendiente 

Para valorar este parámetro es necesario cruzar el mapa de dirección de pendientes con 

amenazas, la tabla de datos obtenida por esta operación permite determinar las 

densidades de deslizamiento de cada clase de dirección de pendientes, este parámetro 

resulta importante considerarlo toda vez que en la zona se ha verificado la presencia de 

materiales sedimentarios que estructuran planos de estratificación que pueden favorecer 

la ocurrencia de inestabilidades en determinada dirección de la pendiente.  

Peso de Parámetro Cercanía a Vías 

Para valorar este parámetro se debe cruzar el mapa de cercanía a vías con el de 

amenazas, la tabla de datos obtenida por esta operación permite determinar las 

densidades de deslizamiento de cada clase de incidencia de cercanía a vías, la presencia 

de vías como parámetro de valoración tiene su influencia al considerar el cambio 

morfológico de los taludes que su construcción implica, además del cambio en las 

condiciones de escorrentía y saturación del terreno.  

Peso de Parámetro Caracterización Geotécnica 

Para valorar este parámetro se cruzó  el mapa de caracterización geotécnica con el de 

amenazas, la tabla de datos obtenida por esta operación permite determinar las 

densidades de deslizamiento de cada clase de unidad geotécnica, a partir de las 

características geológicas de las formaciones encontradas se deberá caracterizar las 

mismas de acuerdo a su comportamiento mecánico. 

Peso de Parámetro Morfología de Laderas  

El peso del parámetro Morfología de Laderas se obtiene cruzando el mapa morfológico 

con el de amenazas, la tabla de datos obtenida por esta operación permite determinar las 

densidades de deslizamiento de cada clase de unidad morfológica. 

Peso Total - Mapa de Riesgos 

El peso total obtenido resulta de la adición de los pesos parciales de los parámetros 
analizados, y se puede entender como la susceptibilidad general del territorio a que se 
produzca inestabilidades sobre el mismo.  
 
Los valores obtenidos corresponden a la suma algebraica de los pesos parciales sobre 

cada pixel del mapa de riesgos generado. 

1.3.2 Clasificación del Riesgo Geológico 

 

Para clasificar el mapa de riesgos metodológicamente se sugieren tres zonas, que 

representarán zonas de riesgo: Alto, Medio y Bajo; los valores de frontera entre estas 

cualificaciones se definen a partir del Histograma de frecuencias de los valores de peso 

total de manera de que los mismos representen cambios cualitativos importantes que 

sean cotejados con las observaciones realizadas en campo, a su vez esta delimitación 
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permitirá al Planificador tomar decisiones con fines de ordenamiento territorial y gestión 

de riesgo de la zona de estudio. 

 

El resultado obtenido es un mapa en donde encontramos cualificaciones de riesgo bajo, 

medio y alto a ocurrencia a inestabilidades. 

 

En el caso práctico estas cualificaciones pueden variar en función del tipo de método de 

clasificación que se emplee en el ArcGis pudiendo estos ser: Manual, Equal Interval, 

Defined Interval, Quantile, Natural Breaks (Jenks), Geometrical Interval y Standar 

Deviation. 
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2. RECOPILACIÓN DE INFORMACIÓN EXISTENTE 

En los últimos años los sistemas informáticos han experimentado un considerable 

desarrollo, permitiendo un fácil acceso a los sistemas de información geográfica para 

realizar procesamientos y análisis de cualquier tipo. 

En el Artículo 275 de la Constitución Política del Ecuador (2008) se indica que “El Estado 

planificará el desarrollo del país para garantizar el ejercicio de los derechos, la 

consecución de los objetivos del régimen de desarrollo y los principios consagrados en la 

Constitución. La planificación propiciará la equidad social y territorial, promoverá la 

concertación, y será participativa, descentralizada, desconcentrada y transparente”. 

En el Ecuador, el análisis de información geográfica ha tenido una gran demanda, debido, 

a los procesos de planificación que se han impulsado por las diferentes Entidades del 

Ejecutivo en los distintos territorios, es así, que la Secretaría Nacional de Planificación y 

Desarrollo –SENPLADES-, es la que actúa como Secretaría Técnica del Sistema Nacional 

Descentralizado de Planificación Participativa de acuerdo a lo establecido en el Decreto 

Ejecutivo No. 1577, publicado en el Registro Oficial No. 535, de 26 de febrero de 2009 y 

tiene a su cargo el Sistema Nacional de Información –SNI, el cual constituye un “conjunto 

organizado de elementos que permiten la interacción de actores con el objeto de acceder, 

recoger, almacenar y transformar datos en información relevante para la planificación del 

desarrollo y las finanzas públicas. Sus características, funciones, fuentes, derechos y 

responsabilidades asociadas a la provisión y uso de la información serán regulados por 

este código, su reglamento y las demás normas aplicables. La información que genere el 

Sistema Nacional de Información deberá coordinarse con la entidad responsable del 

registro de datos y la entidad rectora de las finanzas públicas, en lo que fuere pertinente”1. 

Lo que pretende este Sistema es fortalecer la difusión de datos estadísticos y geográficos 

generados por las instituciones del Estado, acorde a sus competencias y de esta manera 

promover el libre acceso a la información oficial del Estado, convirtiendo a los usuarios en 

sujetos activos del proceso, con la finalidad de mejorar la calidad de la información y 

optimizar su generación. 

Las prioridades de información están en función de los instrumentos de planificación 

establecidos en el Código Orgánico de Planificación y Finanzas Públicas, como son: 

 Plan Nacional de Desarrollo. 

 Planes de Desarrollo y Ordenamiento Territorial de los Gobiernos Autónomos 

Descentralizados. 

 Estrategia Territorial Nacional, etc. 

El Sistema Nacional de Información trabaja organizadamente con todas las instituciones 

generadoras de información, dentro de las cuales resaltan el Instituto Nacional de 

                                                           
1
 Código Orgánico de Planificación y Finanzas Públicas, Capítulo Tercero. Art. 33, Registro oficial No. 306, 

Año 2010 
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Estadísticas y Censos –INEC y el Instituto Geográfico Militar –IGM, como rectores en los 

temas estadísticos y geográficos respectivamente. 

La información que genera el Sistema Nacional de Información es de libre acceso, 

sustentada en instrumentos técnicos como fichas metodológicas, bases de datos y 

formularios, que facilitan a los usuarios el cálculo de indicadores y el uso, en general, de 

la información. 

El Sistema Nacional de Información –SNI, se encuentra disponible en la siguiente 

dirección electrónica www.sni.gob.ec, en donde se podrá encontrar información a nivel 

nacional referente a: 

Consultas Interactivas: Estadísticas generadas por los censos, encuestas y registros 

administrativos en temas relacionados a: 

 Indicadores del Plan Nacional del Buen Vivir 

 Seguimiento a Proyectos de Inversión Pública en vivo 

 Distritos y Circuitos 

 Inversión Pública 

 Socio-Demográfica 

 Educación 

 Salud 

 Vivienda y Hogar 

 Economía 

 Sector Estratégico 

 Gobiernos Autónomos Descentralizados 

 Información Agropecuaria 

Descarga de Información para Planes de Desarrollo y Ordenamiento Territorial: 

Información estadística y geográfica de los Gobiernos Autónomos Descentralizados por: 

Zonas de Planificación, Existen 9 a nivel nacional 

- Nivel de PDyOT: Escala de trabajo a nivel provincial y cantonal 

- Provincias 

- Cantones 

- Tipo de PDyOT: Información Geográfica e Información Estadística 

- Subsistema: Asentamientos Humanos, Biofísico, Económico Productivo, Movilidad 

Energía y Conectividad, Social, Todos. 

Descarga de Información: Mapas de cartografía básica y temática por cantones del 

Ecuador. 

Proyecciones y Estudios Demográficos: Proyecciones y estudios demográficos que 

pretenden visualizar a la población como eje central de la planificación, información 

clasificada por autor, año de publicación y fuente. 

http://www.sni.gob.ec/
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Normas y Estándares de Información: Se encuentra normas, estándares y lineamientos 

para la generación, procesamiento y publicación de información estadística y geográfica. 

Integrador Nacional de IDES: Podrá visualizar y descargar información geográfica de 

Instituciones del Gobierno, Gobiernos Autónomos Descentralizados, y Universidades. 

Coberturas: Se encuentran coberturas geográficas en formato shape (shp) de acuerdo a 

la escala de información, las cuales pueden ser descargadas ingresando a la fuente de 

los cuadros que se presentan a continuación. 

INFORMACIÓN 1:50.000 Actualización: 31/dic/2012 

SISTEMAS OBJETO FUENTE AÑO TIPO DESCRIPCIÓN 

Sistema de 

Asentamientos 

Humanos 

CENTRO 

EDUCATIVO  

MINISTERIO 

DE 

EDUCACIÓN 

2013 PUNTO 

Localización de 

centros educativos, 

nombre, tipo, 

especialidad 

Sistema de 

Asentamientos 

Humanos 

CENTRO DE 

SALUD  

MINISTERIO 

DE SALUD 
2012 PUNTO 

Localización de 

centros de salud, 

nombre, tipo, origen 

Sistema de 

Asentamientos 

Humanos 

PELIGRO 

VOLCANICO  

IGENP- 

STGR 
V/A POLÍGONO 

Zonas susceptibles a 

eventos volcánicos 

Sistema de 

Movilidad, Energía 

y Conectividad 

PROYECTO 

GENERACION  

CONELEC 2009 PUNTO 

Ubicación de 

proyectos de 

generación eléctrica 

Sistema 

Económico 
RIEGO SIERRA  

CNRH-

MAGAP 
2000 POLIGONO 

Distribución del riego 

en la sierra 

ecuatoriana 

Planificación 
ZONAS DE 

PLANIFICACION  

SENPLADES 2010 POLÍGONO 

Nueve Zonas de 

Planificación del 

Ecuador 

Información Base 
INFORMACION 

IGM BASE  

IGM 2013 *.SHP Coberturas Base IGM 

DPA Referencial CANTONES 2011 INEC 2011 POLIGONO 

División 

administrativa 

referencial 

DPA Referencial 
PARROQUIAS 

2011 
INEC 2011 POLIGONO 

División 

administrativa 

referencial 

DPA Referencial PROVINCIAS 2011 INEC 2011 POLIGONO 

División 

administrativa 

referencial 

Sistema 

Sociocultural 

RUTA QHAPAQ 

ÑAN 
INPC 2011 LÍNEA 

Trayecto y 

descripción del 

KapacÑan  

Sistema Ambiental 

SISTEMA 

NACIONAL DE 

BOSQUES Y 

MAE 2013 POLIGONO 

Identificación de 

áreas pertenecientes 

al Sistema Nacional 

http://app.sni.gob.ec/sni-link/sni/Portal%20SNI%202014/GEOGRAFICA/Informacion%20desacargable/coberturas/Coberturas/50.000/CENTROS%20EDUCATIVOS.rar
http://app.sni.gob.ec/sni-link/sni/Portal%20SNI%202014/GEOGRAFICA/Informacion%20desacargable/coberturas/Coberturas/50.000/CENTROS%20EDUCATIVOS.rar
http://app.sni.gob.ec/sni-link/sni/Portal%20SNI%202014/GEOGRAFICA/Informacion%20desacargable/coberturas/Coberturas/50.000/CENTROS%20DE%20SALUD.rar
http://app.sni.gob.ec/sni-link/sni/Portal%20SNI%202014/GEOGRAFICA/Informacion%20desacargable/coberturas/Coberturas/50.000/CENTROS%20DE%20SALUD.rar
http://portal.sni.gob.ec/documents/10156/dee9b727-c41d-4820-bb82-0e9f1783451d
http://portal.sni.gob.ec/documents/10156/dee9b727-c41d-4820-bb82-0e9f1783451d
http://portal.sni.gob.ec/documents/10156/99f87c2e-4cd2-4f8e-99b8-e894a67ace9e
http://portal.sni.gob.ec/documents/10156/99f87c2e-4cd2-4f8e-99b8-e894a67ace9e
http://portal.sni.gob.ec/documents/10156/aae545ca-8e94-4856-aae8-cf8cc63e70ee
http://portal.sni.gob.ec/documents/10156/a3b46778-f762-4ee1-b1ae-71efaa876623
http://portal.sni.gob.ec/documents/10156/a3b46778-f762-4ee1-b1ae-71efaa876623
http://www.geoportaligm.gob.ec/portal/cartografia-libre#ecuador-1-50-000
http://www.geoportaligm.gob.ec/portal/cartografia-libre#ecuador-1-50-000
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VEGETACION 

PROTECTORA 

de Bosques 

Protectores y 

vegetación 

protectora. 

Sistema Ambiental 
SUSCEPTIBILIDAD 

A EROSION 

MAGAP - 

SIGAGRO 
  POLIGONO 

Descripción de 

susceptibilidad, 

suelos. 

Sistema 

Económico 

AGROLOGICO 

SIERRA 
SIGAGRO 2003 POLIGONO 

Descripción de tipos 

agrologicos en la 

sierra 

Sistema Ambiental 

APTITUD 

FORESTAL 

SIERRA 

SIGAGRO 2003 POLIGONO 

Caracterización de 

aptitud forestal en la 

sierra 

Sistema Ambiental 

CONFLICTO DE 

USO DE LA 

TIERRA 

SIGAGRO 2003 POLIGONO 

Definición de 

conflictos de uso en 

la Sierra, hectáreas, 

simbología 

Sistema 

Económico 

CULTIVO 

PREDOMINANTE 

SIERRA 

SIGAGRO 2003 POLIGONO Clases de cultivos 

Sistema Ambiental 
ECOLOGICO 

SIERRA 
SIGAGRO 2003 POLIGONO 

Identificación de 

zonas de vida 

Sistema Ambiental 
PENDIENTE 

SIERRA 
SIGAGRO V/A POLIGONO 

Rangos de 

pendientes Sierra 

Sistema 

Económico 

SISTEMAS DE 

PRODUCCION 

SIERRA 

SIGAGRO 2003 POLIGONO 

Tipología de sistemas 

de producción en la 

sierra 

Sistema Ambiental 
TAXONOMIA 

SIERRA 
SIGAGRO V/A POLIGONO 

Clasificación de 

suelos y descripción 

del material 

Sistema Ambiental TEXTURA SIERRA SIGAGRO V/A POLIGONO 
Clasificación de 

texturas de suelo 

Sistema 

Económico 

USO DEL SUELO 

SIERRA 
SIGAGRO 2003 POLIGONO 

Definición de áreas 

de uso en la Sierra 

Fuente: sni.gob.ec/coberturas 

 

INFORMACIÓN 1:100.000 Actualización: 31/dic/2012 

SISTEMAS OBJETO FUENTE AÑO TIPO DESCRIPCIÓN 

Geológico 

CARTAS 

GEOLOGICAS MAGAP 2005 PUNTO 

Geología, fallas, sismos por 

cartas topográficas 

Hidro - 

Geológico HIDROGEOLOGICO MAGAP 2005 POLIGONO Formaciones, litología 

Fuente: sni.gob.ec/coberturas 

 

INFORMACIÓN 1:250.000 Actualización: 31/dic/2012 

SISTEMAS 
OBJETO 

(DESCARGA) 
FUENTE AÑO TIPO DESCRIPCIÓN 
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Sistema 

Económico 

CATASTRO 

TURISTICO 

MINISTERIO DE 

TURISMO 
2002 PUNTO 

Principales sitios 

turísticos 

Sistema 

Ambiental 
DEFICIT HIDRICO  MAGAP-INAMHI 2002 POLÍGONO 

Zonas con poca 

irrigación en el 

Ecuador 

Sistema 

Ambiental 
EROSIÓN ACTUAL  MAGAP 2002 POLÍGONO 

Zonas erosionadas 

en el Ecuador 

continental 

Sistema 

Ambiental 

INTENSIDAD 

SISMICA  

IGEPN-STRG 2002 POLÍGONO 

Ubicación de 

lugares con mayor 

intensidad sísmica 

Sistema 

Ambiental 
PANE  MAE 2013 POLÍGONO 

Áreas protegidas 

del país 

Sistema de 

Asentamientos 

Humanos 

PUERTO INOCAR 
 

PUNTO 
Principales puertos 

del país 

Sistema de 

Movilidad, 

Energía y 

Conectividad 

RED VIAL 

ESTATAL  

MTOP 2013 LINEA 
Estado actual de la 

red vial estatal 

Sistema 

Ambiental 

UNIDADES 

HIDROGRAFICAS 

N5  

SENAGUA 2011 POLÍGONO 

División 

hidrográfica 

mediante 

metodología 

Pfafstetter 

Información Base AEROPUERTO IGM 2013 PUNTO 

Capas de 

Información 

Geográfica Base 

Información Base CANTERA IGM 2013 POLIGONO 

Capas de 

Información 

Geográfica Base 

Información Base CIENEGA IGM 2013 POLÍGONO 

Capas de 

Información 

Geográfica Base 

Información Base DIQUE IGM 2013 PUNTO 

Capas de 

Información 

Geográfica Base 

Información Base EMBALSE IGM 2013 POLÍGONO 

Capas de 

Información 

Geográfica Base 

Información Base ISLA IGM 2013 POLÍGONO 

Capas de 

Información 

Geográfica Base 

Información Base LAGO/LAGUNA IGM 2013 POLÍGONO 

Capas de 

Información 

Geográfica Base 

Información Base 
LIMITE 

ADMINISTRATIVO 
IGM 2013 LINEA 

Capas de 

Información 

Geográfica Base 

http://portal.sni.gob.ec/documents/10156/0e0a65b2-a568-4979-8f16-15236f873c6e
http://portal.sni.gob.ec/documents/10156/0e0a65b2-a568-4979-8f16-15236f873c6e
http://portal.sni.gob.ec/documents/10156/84520dc2-56a4-4dd6-bf60-66d2e3f3aabe
http://portal.sni.gob.ec/documents/10156/dbcb1668-9c74-46dc-aed4-eea92ae01c57
http://portal.sni.gob.ec/documents/10156/6b895406-d41f-400c-bc28-2bc41d804958
http://portal.sni.gob.ec/documents/10156/6b895406-d41f-400c-bc28-2bc41d804958
http://portal.sni.gob.ec/documents/10156/c29081d5-0568-493e-b33d-371c8bdafd43
http://portal.sni.gob.ec/documents/10156/dd721e80-94d0-4ef0-8788-afda4bee8359
http://portal.sni.gob.ec/documents/10156/bbdd9d8e-0be7-456f-861b-694ea7461212
http://portal.sni.gob.ec/documents/10156/bbdd9d8e-0be7-456f-861b-694ea7461212
http://portal.sni.gob.ec/documents/10156/43935221-8434-4f1a-a207-ab1b9f11a25c
http://portal.sni.gob.ec/documents/10156/43935221-8434-4f1a-a207-ab1b9f11a25c
http://portal.sni.gob.ec/documents/10156/43935221-8434-4f1a-a207-ab1b9f11a25c
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Información Base LINEA DE TREN IGM 2013 LINEA 

Capas de 

Información 

Geográfica Base 

Información Base MINA IGM 2013 PUNTO 

Capas de 

Información 

Geográfica Base 

Información Base 
NOMBRES DE 

AREAS 
IGM 2013 PUNTO 

Capas de 

Información 

Geográfica Base 

Información Base 
PISTAS DE 

ATERRIZAJE 
IGM 2013 LINEA 

Capas de 

Información 

Geográfica Base 

Información Base POBLADO IGM 2013 PUNTOS 

Capas de 

Información 

Geográfica Base 

Información Base PUENTE IGM 2013 LINEA 

Capas de 

Información 

Geográfica Base 

Información Base RIO IGM 2013 LINEA 

Capas de 

Información 

Geográfica Base 

Información Base TUNEL IGM 2013 LINEA 

Capas de 

Información 

Geográfica Base 

Información Base VIAS IGM 2013 LINEA 

Capas de 

Información 

Geográfica Base 

Información Base ZONA URBANA IGM 2013 POLIGONO 

Capas de 

Información 

Geográfica Base 

Sistema 

Sociocultural 

RED CIUDADES 

PATRIMONIALES 
INPC 2010 LINEA 

Trayecto imperial 

inca 

Sistema 

Ambiental 
SNAP MAE 2008 POLIGONO 

Sistema Nacional 

de Áreas 

Protegidas 

Sistema 

Ambiental 

RESERVA 

BIOSFERA 
MAE 2008 POLIGONO 

Área Reserva de 

Biosfera 

Sistema 

Ambiental 

ZONA 

INTANGIBLE 
MAE 2008 POLIGONO 

Áreas declaradas 

zonas intangibles 

Sistema 

Ambiental 

PRIORIZACION 

SOCIOBOSQUE 

MAE 

SOCIOBOSQUE 
2012 POLIGONO 

Áreas de 

priorización del 

proyecto Socio 

Bosque 

Sistema 

Económico 

APTITUD 

AGRÍCOLA 
MAGAP V/A POLIGONO 

Tipologías de 

aptitud agrícola 

Sistema 

Ambiental 

COBERTURA 

VEGETAL 1982 
MAGAP 1982 POLIGONO 

Clasificación de 

cobertura vegetal 

Sistema 

Ambiental 

COBERTURA 

VEGETAL 1990 
MAGAP 1990 POLIGONO 

Clasificación de 

cobertura vegetal 
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Sistema 

Económico 

COBERTURA Y 

USO DE LA 

TIERRA 

MAGAP 2002 POLIGONO 
Caracterización de 

uso del suelo 

Sistema 

Económico 

USO ADECUADO 

Y CONFLICTOS 

DE USO DE LA 

TIERRA 

MAGAP 2002 POLIGONO 

Zonas erosionadas 

en el Ecuador 

continental 

Sistema 

Ambiental 
TIPO DE CLIMA MAGAP 2003 POLIGONO 

Tipología de 

climas 

Sistema 

Ambiental 
TAXONOMIA 

MAGAP 

PRONAREG 
V/A POLIGONO 

Descripción 

taxonómica de 

suelos 

Sistema 

Ambiental 
TEXTURA 

MAGAP 

PRONAREG 
V/A POLIGONO 

Descripción de 

texturas de suelos 

Sistema 

Ambiental 

MOVIMIENTO 

MASA 
MAGAP - STGR 

 
POLIGONO 

Susceptibilidad a 

movimientos en 

masa 

Sistema 

Ambiental 

ZONAS DE VIDA 

(ECOLÓGICO) 
MAGAP 2003 POLIGONO 

Tipología de zonas 

de vida 

Sistema 

Ambiental 

ESTACIÓN 

METEOROLÓGICA 
MAGAP INAMHI 2002 PUNTO 

Estaciones para 

medir condiciones 

meteorológicas 

Sistema 

Ambiental 
PENDIENTE 

MAGAP 

PRONAREG 
V/A POLIGONO 

Rangos de 

inclinación del 

terreno 

Fuente: sni.gob.ec/coberturas 

 

 

 

 

INFORMACIÓN 1:500.000 Actualización: 31/dic/2012 

SISTEMAS OBJETO FUENTE AÑO TIPO DESCRIPCIÓN 

Sistema 

Ambiental 

BOSQUES 

PROTECTORES MAE 2012 POLIGONO 

Identificación de bosques 

protectores 

Fuente: sni.gob.ec/coberturas 

 

INFORMACIÓN 1:1'000.000Actualización: 31/dic/2012 

SISTEMAS OBJETO FUENTE AÑO TIPO DESCRIPCIÓN 

Sistema de 

movilidad, energía y 

conectividad 

AREA DE 

CONCESION 

ELECTRICA 

CONELEC 2009 POLIGONO 

Espacialización de 

la concesión a 

nivel nacional 

Sistema Ambiental 
AREA 

INUNDACION 

INAMHI-

MAGAP 
2002 POLIGONO 

Áreas de 

inundación 

permanente 

Sistema de 

movilidad, energía y 

conectividad  

CENTRAL 

ELECTRICA 
CONELEC 2009 PUNTO 

Localización, 

empresa, 

ubicación 
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Sistema Ambiental ISOTERMA 
MAGAP 

INAMHI 
2002 POLIGONO 

Representación de 

las temperaturas 

medias 

Sistema Ambiental ISOYETA 
MAGAP 

INAMHI 
2002 POLIGONO 

Representación de 

las precipitaciones 

medias 

Sistema de 

movilidad, energía y 

conectividad  

LINEA 

SUBTRANSMISION 
CONELEC 2009 LINEA 

Red de 

subdistribución, 

nombre, agente, 

tipo, voltaje 

Sistema de 

movilidad, energía y 

conectividad  

LINEA 

TRANSMISION 
CONELEC 2009 LINEA 

Red de 

transmisión, 

voltaje, nombre 

Fuente: sni.gob.ec/coberturas 

 

INFORMACIÓN PROYECTOS Actualización: 31/dic/2012 

SISTEMA PROYECTO FUENTE AÑO DESCRIPCIÓN 

WGS 84/17S 
CUENCA DEL RÍO 

GUAYAS 
CLIRSEN 

2009, 

2010, 2011 

Información base, 

temática, ortofotos, 

memoria técnica de los 

cantones de la Cuenca del 

Río Guayas 

WGS 84/17S 

MAPAS 

PRELIMINARES DE 

INUNDACIONES 

SNGR 2011 

Mapas preliminares de 

inundaciones de diversos 

cantones del país, 

generados por la 

Secretaría Nacional de 

Gestión del Riesgo. 

PSAD 56/17S 
PROYECTO 

PASTAZA 
CLIRSEN   

DTM, Información base y 

temática 

PSAD 56/18S PROYECTO NAPO CLIRSEN   
DTM, Información base y 

temática 

Fuente: sni.gob.ec/coberturas 

 

INFORMACIÓN RASTER Actualización: 31/dic/2012 

INFORMACIÓN NOMBRE FUENTE AÑO DESCRIPCIÓN 
PAG 

WEB 

SRTM 

MODELOS 

DIGITALES DEL 

TERRENO 

    
30M, 50M Y 90M, DE 2 

Y 1 BANDAS 
IGM 

JPG2000 

CARTAS 

TOPOGRÁFICAS 

*.JPG2000 

IGM V/A 

Cartas Topográficas de 

las provincias del 

Ecuador en formato 

*.jpg2000 

IGM 

FOTOGRAFÍAS 

AÉREAS 

FOTOGRAFÍAS 

AÉREAS 

PROVINCIAS DEL 

ECUADOR 

IGM - 

SIGTIERRAS 
2011 

Fotografías Aéreas de 

diferentes provincias del 

Ecuador. 

IGM 
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ORTOFOTOS 
ORTOFOTOGRAFÍAS 

AÉREAS 

IGM - 

SIGTIERRAS 
V/A 

Ortofotos de cantones 

del País 
IGM 

IMAGENES 

SATELITALES 
ASTER CLIRSEN V/A 

Imágenes ASTER de 

provincias del País 
CLIRSEN 

IMAGENES 

SATELITALES 
LANDSAT CLIRSEN V/A 

Imágenes LANDSAT de 

provincias del País 
CLIRSEN 

IMAGENES 

SATELITALES 
QUICKBIRD CLIRSEN V/A 

Imágenes QUICKBIRD 

del cantón San Lorenzo 

provincia de 

Esmeraldas 

CLIRSEN 

IMAGENES 

SATELITALES 
SPOT CLIRSEN V/A 

Imágenes SPOT de 

provincias del País 
CLIRSEN 

Fuente: sni.gob.ec/coberturas 

 

 

SNI Territorial: Información de las distintas Zonas de Planificación, se puede encontrar 

en el Sistema Nacional de Información Territorial, en el caso de requerir de la Zona 6 de 

Planificación se podrá encontrar en la siguiente dirección electrónica: 

http://app.sni.gob.ec/zonal6austro/index.php?option=com_content&view=frontpage&Itemid

=1# o sino en las oficinas en la ciudad de Cuenca, ubicadas en el Gobierno Zonal 6, Av. 

México y Unidad Nacional en la Dirección de Planificación, Información y Políticas 

Públicas. 

Para analizar el componente de riesgo geológico en los Planes de Ordenamiento 

Territorial a Nivel Cantonal se deberá contar con información Cartográfica, Geológica, 

Geotécnica, Hidrológica, Uso de Suelo y Lineamientos, este último referido a fallas 

principalmente y con escalas mínimas de información. 

En la Secretaría Nacional de Planificación y Desarrollo –SENPLADES, Zona 6 Austro se 

puede obtener información, la cual podrán solicitar los Gobiernos Autónomos 

Descentralizados a través de una comunicación dirigida a la Subsecretaría Zonal 6 de 

SENPLADES. 

Entre la información más relevante disponible está: 

 

Cartografía a escala 1:50.000, Datum WGS84 

Las hojas cartográficas a escala 1:50.000 elaboradas y publicadas por el Instituto 

Geográfico Militar –IGM, las de la Zona 6 (Azuay, Cañar y Morona Santiago) se 

encuentran disponibles en digital en formato tipo shape (shp), en la Subsecretaria Zonal 6 

Austro de SENPLADES. 

Geología a escala 1:100.000, Datum WGS84 

Las hojas geológicas a escala 1:100.000 de la Zona 6, elaboradas y publicadas por el 

Instituto Nacional de Investigación Geológico Minero Metalúrgico –INIGEMM, las mismas 

se encuentran en formato digital tipo shape (shp). 

http://app.sni.gob.ec/zonal6austro/index.php?option=com_content&view=frontpage&Itemid=1
http://app.sni.gob.ec/zonal6austro/index.php?option=com_content&view=frontpage&Itemid=1
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Ortofotografía a escala 1:5.000 

Las ortofotos así como los MDT de todos los cantones de la Zona 6 de Planificación a   

escala 1:5.000 elaborados y publicados por SIG - Tierras, Ilustración 5, se puede revisar 

visitando el siguiente link: 

http://www.sigtierras.gob.ec/Informacion_Digital/Ortofotos_Cuadricula.html, o acercándose 

a la Subsecretaria Zonal 6 Austro de SENPLADES. 

Ilustración 5. Cartografía de fotografías aéreas existentes en la zona 6 de Planificación 

 

Fuente: SNI Territorial/Cuadrícula de fotografías aéreas existentes 

 

Uso de Suelo, a escala 1:200.000 

 

Mapas de uso de suelo a escala 1:200.000 de la Cuenca del río Paute, se encuentran 

disponibles en las oficinas de la Secretaría de Gestión del Agua o en la Subsecretaria 

Zonal 6 Austro de SENPLADES. 

 

Además, se podría utilizar de ser el caso el mapa de cobertura vegetal en caso de no 

existir el de uso de suelo para los cantones de las provincias del Cañar y Morona 

Santiago que no se encuentran en la Cuenca del Paute y que dispone el Ministerio del 

Ambiente. 

http://www.sigtierras.gob.ec/Informacion_Digital/Ortofotos_Cuadricula.html
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Plan de Riesgos de la Provincia del Azuay 

 

El Gobierno Autónomo Descentralizado Provincial del Azuay cuenta con el Plan de 

Riesgos de la provincia, elaborado en el año 2012,  y el cual contiene mapas de riesgos 

de los 15 cantones que conforman la provincia del Azuay a escala 1:25.000; este 

documento elaborado mediante la realización de visitas técnicas a cada uno de los 

cantones, ha permitido realizar un análisis con conocimiento real del territorio, en el que la 

información proporcionada por la población  a través de reuniones, mapeos en campo y 

validación de los técnicos encargados de realizar la Consultoría ha permitido mapear de 

mejor manera las inestabilidades existentes en cada territorio a nivel local y determinar su 

grado de impacto a poblaciones e infraestructuras existentes. La propuesta documenta el 

tipo de estudios que se deben realizar a corto y mediano plazo, así como el monto de 

inversión que se requiere para estudiar cada uno de los lugares priorizados y en base a 

eso  contar con resultados que permitan plantear soluciones para mitigar el riesgo en 

cada uno de los territorios afectados. 

La metodología aplicada por la obtención del mapa de riesgos de la provincia ha 

considerado los siguientes  aspectos durante su desarrollo: 

1. Reuniones con los representantes de los diferentes Gobiernos Autónomos 

Descentralizados –GADs- a nivel provincial,  en la cual los Asistentes de campo 

visitaron los sitios con problemas de deslizamientos los cuales fueron 

georeferenciados, hasta obtener una base de datos con los deslizamientos 

detectados y mostrar la problemática presentada en las diferentes áreas de 

estudio.  

 

2. Generación de una base de datos en función de la información levantada en el 

punto anterior, en la que se analizó su influencia con respecto a centros poblados, 

vías de acceso y cursos de agua, además de su magnitud y nivel de actividad. 

 

3. Comprobación de los sitios seleccionados en función de los criterios anteriores, 

considerando como insumo las hojas cartográficas y geológicas a diferentes 

escalas; análisis uno por uno los deslizamientos a los cuales se les denominará 

deslizamientos verificados en campo, indicando a nivel técnico sus posibles 

causas, tipo de ensayos a ser realizados, especificando el número de calicatas 

con sus respectivas profundidades de excavación o de ser el caso recomendando 

perforaciones profundas de acuerdo al tipo de evento presentado, si se requiere 

de topografía o únicamente perfiles topográficos, modelos de estabilidad, informes 

técnicos, etc. 

 

4. Visita a todos los deslizamientos priorizados en el Proyecto PRECUPA con lo cual 

se ha confirmado que la mayoría de ellos continúan activos. 

 

5. Base de datos generada con los deslizamientos priorizados, en los cuales se 

consideró: 
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 Población y viviendas afectadas 

 Vías incomunicadas 

 Cursos de agua en peligro de represamiento 

 Grandes masas de movimiento de tierra, con presencia de grietas de tracción, 

reptaciones, escarpes de alturas considerables, acumulaciones de agua, zonas 

contra pendientes. 

 Área afectada 

 Concentración de deslizamientos 

 

6. En base a la fotointepretación se han determinado otros sitios de interés, los 

cuales han sido consolidados en un archivo digital con los detectados y verificados 

en campo. 

 

7. Presentación de la matriz de priorización de  los deslizamientos a intervenir y 

análisis de los estudios que se requieren para darles solución definitiva a los 

mismos. 

 

8. Caracterización de riesgos geológicos desde el punto de vista geológico se ha 

realizado un análisis espacial combinando toda la información obtenida en campo 

y gabinete, se ha determinado pesos para cada una de las características 

evaluadas y se ha combinado los factores con el fin de obtener los mapas de 

riesgos geológicos. 

9. Elaboración del mapa de riesgos utilizando la metodología del índice de 

Deslizamiento en la que considera parámetros de análisis como: geología, 

distancia a ríos, pendientes, fallas, uso de suelo, dirección de pendiente, cercanía 

a vías, caracterización geotécnica y morfología de laderas, todos estos parámetros 

considerados multiplicados por cada uno de sus pesos dan como resultado el 

mapa de riesgos de la provincia del Azuay 

La información geológica y de riesgos se encuentra en formato .pdf de cada uno de los 

cantones de la provincia, pero en caso de necesitar los archivos tipo shape, los mismos 

se encuentran disponibles en la Dirección de Planificación con el Arq. Juan Carlos 

Macancela del Gobierno Provincial del Azuay, y a la misma se puede acceder mediante 

una solicitud dirigida al Señor Prefecto de la provincia Ing. Paúl Carrasco. 

 

Proyecto PRECUPA - Prevención de Desastres Naturales en la Cuenca del Paute 

 

Un año después del deslizamiento de la Josefina y de gestiones pertinentes, el 30 de 

marzo de 1994, los gobiernos de Ecuador y Suiza firmaron un convenio de cooperación 

técnica, científica y económica en el marco de la prevención de desastres naturales. 

 

El objetivo fundamental de este proyecto era apoyar al Ecuador de una manera concreta, 

fortaleciendo su capacidad en este campo, gracias a un proyecto piloto denominado 

Prevención-Ecuador-Cuenca-Paute, el mismo que se basa en una fuerte cooperación 
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entre instituciones ecuatorianas y el Cuerpo Suizo de Socorro en caso de catástrofe CSS2  

(Basabe R, 1998).  

El proyecto se desarrolló entre los años 1994 y 1998, cubrió un área de 3.700 km2 en las 

cuencas alta y media del río Paute, la Ilustración 6 muestra las áreas de actuación del 

proyecto; con la ejecución del proyecto se beneficiaron alrededor de 700.000 habitantes, 

además la información generada constituye un insumo importante para los proyectos que 

se realizan en esta área. 

Ilustración 6. Zona de acción del proyecto PRECUPA 
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Fuente: (Basabe R, 1998) 

Entre los campos de acción en los que trabajaron están: 

Topografía/geodesia: Incluye cartografía de la zona con fotografías aéreas en escala 

1:30.000 de toda la cuenca del río Paute desde El Cajas a la Cola de San Pablo y desde 

El Portete a El Tambo, en un total de 552 fotografías e imágenes satelitales 1:100.000, 

1:50.000 y 1:25.000. Se implementó una red geodésica de I y II orden para monitorear 20 

zonas con mayor vulnerabilidad a terrenos inestables. 

Geología: Mapas geológicos esquemáticos elaborados conjuntamente con técnicos de 

INECEL, mapas de detección de terrenos inestables y mapas de peligrosidad de las hojas 

                                                           
2
Cuerpo Suizo de Socorro en caso de desastres 
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cartográficas en escala 1:25.000 de Gualaceo, Cuenca Este, Sinincay, Biblián, Azogues, 

Déleg y Paute. Cubriendo un área de 900 km2 (90.000 ha). 

Geotecnia: Cuenta con la caracterización geológico-geotécnica de las unidades y 

formaciones geológicas que abarcan una amplia gama. Se indican parámetros físico-

mecánicos y análisis sobre la susceptibilidad a terrenos inestables, en formato de 

aplicación, útil, no solo para la región sino para extrapolaciones al resto del país. Para las 

zonas de mayor vulnerabilidad se desarrolló los mapas de zonificación de unidades 

geotécnicas en las hojas 1:25.000 de Cuenca Este y Gualaceo.  

Sismología: Implementada la Red Sísmica del Austro (RSA) ha permitido desarrollar 

capacidades locales así como nuevos “softwares” y adaptación de equipos. 

Hidrometeorología: Se cuenta con el inventario de estaciones hidrológicas y 

meteorológicas en la cuenca del Paute lo cual permitió el diseño de la Red 

Hidrometeorológica Unificada (RHU), gracias a la cooperación interinstitucional. La 

adquisición, implementación y puesta en servicio de  10 pluviógrafos en las cabeceras de 

las cuencas y 11 limnígrafos repartidas en las cuencas de los ríos Tarqui, Yanuncay, 

Tomebamba, Cuenca, Burgay y Gualaceo permiten un monitoreo lluvia-escorrentía, que 

gracias a la transmisión a tiempo real con 5 repetidoras VHF puede enviarse señales en 

caso de alerta, al pasar un umbral definido por los modelos hidrológicos. 

Secretaría  de Gestión de Riesgos 

 

La Secretaría de Gestión de Riesgos –SGR, tiene como objetivo dentro de su accionar el 

"Garantizar la protección de personas y colectividades de los efectos negativos de 

desastres de origen natural o antrópico mediante la generación de políticas, estrategias y 

normas que promuevan capacidades orientadas a identificar, analizar, prevenir y mitigar 

riesgos para enfrentar y manejar eventos de desastre; así como para recuperar y 

reconstruir las condiciones sociales, económicas y ambientales afectadas por eventuales 

emergencias o desastres". 

 

Dentro de su accionar ha publicado mapas de amenazas por inundaciones y movimientos 

en masa a escala 1:50.000, de todos los cantones a nivel nacional, los cuales se 

encuentran disponible en formato pdf, existen además archivos tipo shape para ser 

utilizados en caso de requerir los mismos para realizar algún procesamiento, esta 

información la pueden obtener ingresando al siguiente link: 

http://www.gestionderiesgos.gob.ec/biblioteca/ o visitando las oficinas de la Coordinación 

Regional 6 ubicada en calle Paseo de Milchichig S/N y Av. Gonzales Suárez. 

Amenazas por Movimientos en Masa – Escala 1:50.000 

Para determinar las amenazas por movimientos en masa, la Secretaría de Riesgos ha 

utilizado el siguiente diagrama de flujo, tal como se muestra en la Ilustración 7. 

La metodología utilizada para su análisis emplea 8 factores para su determinación y sus 

pesos están en función de un factor de ponderación. 
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Pendiente: Factor obtenido a través del Modelo Digital de Elevación del Terreno –DEM, 

en base a la cartografía existente. 

Una vez obtenidas las pendientes, se procede a reclasificarlas del 1 al 5. El Cuadro 11, 

muestra las clases de pendientes en grados, el valor 1 indica que la pendiente presenta 

las condiciones menos favorables para que se produzcan movimientos en masa, mientras 

que el valor 5 indica las condiciones más favorables para que se produzcan los 

movimientos en masa. 

 
Cuadro 11. Clases de pendiente en grados 

Clases de Pendientes 

Categoría 
Clases 

% 
Peso 

Muy Baja 0 - 15 1 

Baja 15 - 30 2 

Media 30 - 50 3 

Alta 50 - 100 4 

Muy Alta > 100 5 
Fuente: (Secretaria de Gestion de Riesgos, 2010) 

 
Uso de Suelo: Se representa a través de los diferentes usos de suelo y cobertura vegetal 

existente. El Cuadro 12 muestra las 5 clases de usos de suelo y a cada una se les 

atribuye un valor entre 1 a 5. El valor de 1 significa que la clase va a tener menor 

influencia para la generación de movimientos de masa, y el valor 5 significa que la clase 

va a tener mayor influencia para incrementar la amenaza a los movimientos en masa. 

 
Cuadro 12.  Clases de usos de suelo  

Clase Valor 

Arbórea (Bosque natural, plantación de pino, eucalipto) 1 

Arbustiva (Matorral, chilca, chaparro, etc) 2 

Herbácea (Pastizales, paramo, etc) 3 

Cultivos (Ciclo corto y permanente) 4 

Área Urbana, espacios construidos y cuerpos de agua 
(edificaciones, excavaciones mineras, canteras, carreteras, 
oleoductos, etc., lagunas, reservorios, pantanos, canales, 
etc.) y suelo desnudo. 

5 

Fuente: (Secretaria de Gestion de Riesgos, 2010) 
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Ilustración 7. Diagrama de flujo – amenaza por movimientos en masa 

 

Fuente: (Secretaria de Gestion de Riesgos, 2010)
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Textura del Suelo: Se expresa a través de la granulometría del suelo. Su clasificación se 

realiza en 3 clases. El Cuadro 13 muestra las clases de texturas de suelo a ser 

clasificadas, el menor valor significa que el factor va a tener menos influencia para que se 

generen movimientos en masa, por lo contrario el valor 3 significa que el factor tendrá una 

mayor influencia. 

 
Cuadro 13.  Clases de textura de suelo  

Clase Valor 

Fina (Limo, arcilla) 1 

Media (Arenas) 2 

Gruesa (Gravas y 
bloques) 

3 

Fuente: (Secretaria de Gestion de Riesgos, 2010) 

 
Profundidad o Espesor del Suelo: La profundidad es la dimensión que se mide en 

sentido vertical, mientras que el espesor se refiere a la dimensión que se mide en un 

plano perpendicular a la capa de suelo. El Cuadro 14, muestra el factor de profundidad o 

espesor del suelo, el cual se lo clasifica en 3 clases. Este parámetro puede ser difícil de 

obtener y evaluar con la información oficial que existe en el país. 

 
Cuadro 14.  Profundidad o espesor del Suelo 

Clase Valor 

Poco profundo (menor a 1 m) 1 

Moderadamente profundo (entre 1 a 3 
m) 

2 

Profundo (mayor a 3 m) 3 
Fuente: (Secretaria de Gestion de Riesgos, 2010) 

 

 

Este factor puede ser difícil de obtener y evaluar con la información oficial que existe en el 

país. En general la información del suelo se presenta en estudios taxonómicos para fines 

agrícolas, y puede no tener en gran parte la medida o estimación del parámetro, o tener 

una medida o estimación incompleta de la profundidad del suelo, no cubrir todo el 

territorio nacional, o estar representada a escala pequeña, como la revisada para este 

trabajo (información proporcionada por SGR). En el caso que este factor no se pueda 

evaluar con la información existente es mejor no utilizarlo, esta afirmación es válida para 

cualquiera de los parámetros indicados dentro de este documento, cuando la información 

disponible es escasa o de poca confiabilidad es mejor no utilizar el parámetro o hacer un 

estudio de sensibilidad para ver la influencia en los resultados del mismo. 

 
Geología: Este factor se expresa a través de la litología o geología del basamento. Para 

clasificarlo se utiliza la clasificación de Mora y Vahrson, el Cuadro 15, describe las 

características de las unidades litológicas. 
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Cuadro 15.  Clases de unidades litológicas 

Litologías Calificativo 
Valor del 
Parámetro 

Aluvión grueso, permeable, compacto, nivel freático bajo. 
Calizas duras, permeables. Rocas intrusivas poco fisuradas, nivel 
freático bajo. Basaltos, andesitas, ignimbritas y otras rocas 
efusivas, sanas permeables y poco fisuradas. Rocas 
metamórficas, sanas poco fisuradas, nivel freático bajo. Materiales 
sanos con poca o ninguna meteorización, resistencia al corte 
elevada, fisuras sanas sin relleno. 

Baja 1 

Rocas sedimentarias no o muy poco alteradas, estratificación 
maciza (decimétrica o métrica), poco fisuradas, nivel freático bajo. 
Rocas intrusitas, calizas duras, lavas, ignimbritas, rocas 
metamórficas poco o medianamente alteradas y fisuradas. 
Aluviones levemente compactos, con proporciones considerables 
de finos, drenaje moderado, nivel freático a profundidades 
intermedias. Resistencia al corte media a elevada, fracturas 
cizallables. 

Moderada 2 

Rocas sedimentarias, intrusivas, lavas, ignimbritas, tobas poco 
soldadas, rocas metamórficas, mediana a fuertemente alteradas, 
coluviales, lahares, arenas, suelos regolíticos levemente 
compactos, drenaje poco desarrollado, niveles freáticos 
relativamente altos. Resistencia alcorte moderado a media, 
fracturación importante. 

Media 3 

Depósitos fluvio-lacustres, suelos piroclásticos poco compactos, 
sectores de alteración hidrotermal, rocas fuertemente alteradas y 
fracturadas con estratificaciones y foliación a favor de la pendiente 
y rellenos arcillosos, niveles freáticos someros. Resistencia al corte 
de moderada a baja. 

Alta 4 

Materiales aluviales, coluviales y regolíticos de muy baja calidad 
mecánica, rocas con estado de alteración avanzado, drenaje 
pobre. Se incluyen los casos 3 y 4 con niveles freáticos muy 
someros, sometidos a gradientes hidrodinámicos elevados. 
Resistencia al corte baja a muy baja. 

Muy Alta 5 

Fuente: (Mora & Vahrson, 1994) 
 
Geomorfológico: Este parámetro expresa el relieve relativo y está representado como la 

diferencia de la altura por unidad de área, el mismo se obtiene a través del Modelo de 

Elevación Digital –DEM.  

 

El Cuadro 16, muestra las Unidades Geomorfológicas, Su clasificación presenta 5 valores 

diferentes, con la opción de que los intervalos se reflejen más adecuadamente a las 

condiciones locales del parámetro. 

 
Cuadro 16.  Unidades geomorfológicas a través del relieve 

Clase Valor 

Muy bajo 1 

Bajo 2 

Medio 3 

Alto 4 

Muy Alto 5 
Fuente: (Secretaria de Gestion de Riesgos, 2010) 
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Isoyetas o de Precipitaciones: Este parámetro expresa la influencia de las lluvias como 

factor preparatorio o desencadenante de los movimientos en masa. Siendo analizado de 

dos maneras de acuerdo a la información disponible: 1) Intensidad de precipitaciones 

máximas en 24 horas 2) Isoyetas anuales de la zona de estudio. 

 
Intensidad de precipitaciones máximas en 24 horas, se utilizan los valores de lluvias 

máxima diaria para un período de retorno (Tr) de 100 años, aplicando la distribución 

Gumbel a series temporales de lluvias extremas con tiempo de registro de más de 10 

años. 

Para series mayores y menores a 10 años, tal como lo propone Mora y Vahrson, para las 

condiciones del Valle Central en Costa Rica (1991). Los valores y la clasificación de 

intervalos deben ser determinados para cada zona de estudio, en función de la 

clasificación de los valores de las lluvias máximas en 24 horas para un período de retorno 

de 100 años, Cuadro 17. 

Cuadro 17.  Clasificación de los valores de las lluvias máximas en 24 horas para un período de retorno 

de 100 años  

(n = número de años de registro) 

Precipitaciones máx. 
en 24 horas (mm) 

n>10 años, Tr = 100 
años (GUMBEL) 

Precipitaciones máx. 
en 24 horas (mm) 

N<10 años, Tr = 100 
años, Promedio 

Calificativo 
Valor del Parámetro 

Tp 

< 100 < 50 Muy Bajo 1 

100 – 200 51 – 90 Bajo 2 

200 – 300 91 – 130 Mediano 3 

300 – 400 130 – 175 Alto 4 

> 400 > 175 Muy Alto 5 
Fuente: (Mora & Vahrson, 1994) 

 
Isoyetas anuales de la zona de estudio, para analizar este factor hay que considerar el 

uso actual de suelo y la cobertura vegetal, para la cual se deberá combinar la vegetación 

y el rango medio de las isoyetas asignando un peso que varía de 1 a 5.  

El valor 1 significa que la clase va a tener menor influencia para la generación de zonas 

susceptibles a inundaciones mientras que, el valor de 5 indica que la clase va a tener 

mayor influencia en la generación de zonas susceptibles a inundaciones. 

Estructuras y Lineamientos o Intensidad Sísmica: Este parámetro indica la densidad 

de lineamientos y estructuras geológicas existentes en una determinada zona de estudio. 

El Cuadro 18, muestra las clases de estructuras y lineamientos o intensidad sísmica. 

 
Cuadro 18.  Clases de estructuras y lineamientos o intensidad sísmica 

Clase Valor 

Concentración  estructural muy 
baja 

1 

Concentración estructural baja 2 

Concentración estructural media 3 

Concentración estructural alta 4 

Concentración estructural muy alta 5 



 
Universidad de Cuenca                                                                                                                 
Facultad de Arquitectura y Urbanismo 
Maestría en Ordenación Territorial II Cohorte                                                                     

64 
Ing. Andrea Valerie Brito Puni 

Fuente: (Secretaria de Gestion de Riesgos, 2010) 

 

Para clasificar este factor se debe realizar un histrograma de densidad estructural, el área 

de análisis dependerá de la escala a la cual se está realizando el análisis. 
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3. IDENTIFICACIÓN Y CARACTERIZACIÓN DEL ÁREA DE APLICACIÓN DE LAS 

METODOLOGÍAS ANALIZADAS 

Con el fin de poner en práctica lo expuesto respecto a los factores determinantes para la 

zonificación y clasificación del riesgo geológico, en todas las fases que comprende la 

evaluación de estos fenómenos se ha seleccionado el cantón Chordeleg para utilizarlo 

como una guía práctica. 

 

Las principales razones para escoger este cantón son las siguientes: 

 

a) Existen zonas afectadas por movimientos en masa en el cantón que han afectado 

la infraestructura existente, así como la planificación del territorio. 

 

b) Existe información secundaria actualizada del cantón, la cual se encuentra 

disponible y está a libre acceso de la población si se ingresa a los sitios webs del 

Estado como pueden ser SNI, INEC, IGM; INIGEMMN, etc, o siguiendo las 

indicaciones que se encuentran en el punto 2 de este documento. 

 

c) Hubo la apertura de las autoridades cantonales para facilitar la información 

existente y aportar con datos adicionales para permitir la aplicación de las 

metodologías propuestas. 

 

3.1 CARACTERÍSTICAS DEL ÁREA DE ESTUDIO 

El cantón Chordeleg, se encuentra ubicado al noreste de la provincia del Azuay y forma 

parte de la Zona 6 de Planificación, la superficie del cantón es de 104.7 km2 la cual 

representa el 1.3% de la provincia del Azuay, colinda con el río Santa Bárbara y se 

encuentra a aproximadamente 42 km de la ciudad de Cuenca. 

Chordeleg forma parte dentro de la cuenca del río Paute en la vertiente Atlántica del 

Santiago, sus límites son: al norte con el cantón Gualaceo, al sur con el río Burroplaya; al 

este con el cantón Gualaceo y la provincia del Morona Santiago y al oeste con los 

cantones Sígsig y Gualaceo. 

La Ilustración 8, muestra las 5 parroquias del cantón Chordeleg,  una urbana Chordeleg, y 

cuatro rurales: Principal, Luis Galarza Orellana (Delegsol), San Martín de Puzhío y La 

Unión, además se observa la Red Vial Estatal –RVE- en color rojo que atraviesa el norte 

del cantón y comunica a la provincia del Azuay con Morona Santiago, la línea en color 

amarillo muestra la vialidad local (Vías principales) del territorio la cual está a cargo del 

Gobierno Provincial del Azuay y atraviesa de norte a sur el cantón por el lado occidental; 

presencia de vías secundarias encontramos en todas las parroquias, en mayor cantidad 

en Chordeleg y La Unión. 
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El territorio del cantón Chordeleg se desarrolla entre los 2.220 m s.n.m. en las playas del 

río Santa Bárbara y los 3.940 m s.n.m. en la zona más alta de páramo que actualmente 

corresponde al Área de Bosque y Vegetación Protectora del río Zhío, el 38% del cantón 

tiene pendientes mayores al 50% en las cuales es difícil desarrollar actividades agrícolas 

y ganaderas. 

Desde el punto de vista climático, Chordeleg posee un clima bastante estable sin 

variaciones mayores, en donde se observan precipitaciones entre 750 y 1.750 mm de 

lluvia anual, la temperatura varía entre 2 y 16°C, presentándose las máximas en los 

meses de octubre a mayo y las mínimas entre julio y agosto. La humedad relativa está 

entre el 70 y 72%.  

De acuerdo al piso altitudinal, Chordeleg presenta 3 clasificaciones: Montano Alto en 

donde la mayor parte de esta área está considerada como zona de protección y 

representa más del 50% del territorio; Montano, área destinada para el desarrollo de 

actividades agropecuarias y que ocupa el 31.38% y finalmente el área correspondiente a 

Páramo y que debe ser considerada de conservación estricta en un 17.56%. 

Con respecto a las amenazas o peligros en el cantón, la Secretaria Gestión de Riesgos 

indica que en el territorio existen zonas vulnerables a amenazas o peligros como son las 

heladas que se presentan en todo el cantón y que tienen un nivel de ocurrencia baja, la 

eutrofización de las lagunas que tienen una ocurrencia media y los movimientos en masa 

que tienen una ocurrencia media a alta que se hallan por lo general en la parte Sur del 

cantón. Entre las amenazas antrópicas se mencionan la quema de pajonales y chaparros, 

tala, caza, erosión y contaminación.  

De acuerdo al Censo de Población y Vivienda 2010,  en el cantón Chordeleg existen 

12.577 habitantes, de los cuales el 53.7% son mujeres y el 46.3% son hombres, la 

población urbana representa el 33.5% y la rural el 66.5%. La tasa de crecimiento 

poblacional con respecto al último período censal es de 1.04% anual inferior a la 

provincial del 1.9%, con respecto a los grupos étnicos presentes en el territorio, el 93.8% 

se autoidentifica como mestizo, el 4.4% como blanco, el 1.2% como afroecuatoriano y el 

0.7% como otros. 

La composición poblacional confirma que el cantón Chordeleg presenta características 

propias de un cantón con altos índices de migración, especialmente de los hombres hacia 

otras ciudades del país como al exterior debido principalmente a la falta de fuentes de 

trabajo. 

La densidad poblacional del cantón Chordeleg es de 120 hab/km2, esta medida es mayor 

a la media nacional que es de 47 hab/km2 y representa un alto nivel de dispersión de la 

población rural en comparación con la cantonal que está concentrada.  

En el cantón Chordeleg, la población de 12 años y más que ha accedido a la primaria 

completa representa un 50,46%, el número de analfabetos asciende a 764 personas de 

las cuales el 70.5% son mujeres. El número de establecimientos educativos asciende a 16 

de los cuales 7 están ubicados en el área rural y 9 en el área urbana con un total de 3316 

estudiantes. 
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Ilustración 8. División política administrativa del cantón Chordeleg 

 
Fuente: SNI - SENPLADES 

Elaboración: Autor 
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Con respecto a la cobertura de los servicios de salud, esta se ha incrementado 

notablemente en el último quinquenio debido a la atención médica proporcionada por los 2 

Centros de Salud del Ministerio de Salud Pública ubicados en Chordeleg y Principal, 2 

puestos de Salud del Seguro Campesino en La Unión y Delegsol, una Unidad de 

Fisioterapia de sostenimiento Municipal y un consultorio privado. 

Las principales actividades económicas en el cantón, se concentran en cinco ramas de 

actividad, según los resultados del Censo de Población y Vivienda 2010 siendo el de 

mayor importancia el de las industrias manufactureras representando en 49.64% de la 

Población Económicamente Activa -PEA, la segunda actividad es la agricultura, 

ganadería, silvicultura y pesa con un 19,35% que no ha tendido un desarrollo ni 

crecimiento representativo en el territorio, en tercer lugar tenemos actividades 

relacionadas con el comercio al por mayor y menor 7.31%, construcción 6.09% y la 

enseñanza 2.29%. Otras actividades representan el 15.32%. 

Entre los atractivos turísticos con los que cuenta el cantón Chordeleg están las artesanías 

en paja toquilla, las cuales al ser trabajadas con mucho cuidado presentan una calidad y 

belleza inigualable, exportándose a varios países del mundo, los tejidos confeccionados 

utilizan  la técnica del Ikat, que luego de ser hiladas finamente son urdidas en el telar, los 

bordados utilizados en ornamentos religiosos  pero que en la actualidad están presentes 

en blusas y polleras de cholas azuayas, tapes y otros elementos, la joyería en la que la 

técnica particular y característica utilizada es la filigrana, destacándose la elaboración de 

las "candongas" además de modelos precolombinos, modernos y originales  (Gobierno 

Autónomo Descentralizado Cantonal de Chordeleg, 2015). 
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4. AMENAZAS 

 

4.1 ANÁLISIS DE INFORMACIÓN EXISTENTE 

4.1.1 Secretaría de Gestión de Riesgos  

 

Con respecto a la información existente en cuanto a presencia de amenazas en el cantón 

Chordeleg se puede mencionar la publicada por la Secretaría de Gestión de Riesgos  

quienes en el año 2014 publican mapas de amenazas por inundaciones y movimientos en 

masa de todos los cantones a nivel nacional a escala 1:50.000 e indican los factores y su 

valoración para obtenerlos. 

Movimientos en Masa 

Con respecto al mapa de movimientos en masa la Secretaría de Gestión de Riesgos ha 

utilizado para su análisis 8 factores para su determinación y sus pesos están en función 

de la siguiente fórmula: 

 

En donde, ha sido necesario la generación de  mapas de pendientes, uso de suelo, 

textura de suelo, profundidad de suelo, litología existente, geomorfología, estructuras e 

isoyetas. 

Al revisar el mapa de amenazas por movimientos en masa del cantón Chordeleg a escala 

1:50.000, se observa que las zonas que están entre las fallas geológicas son las más 

susceptibles al igual que sectores que se encuentran junto a la vía Chordeleg - Principal, 

además de zonas con pendientes superiores al 100% que presentan suelos poco 

consolidados y rocas muy meteorizadas y fracturadas, aceleradas por factores climáticos, 

sismotectónicos y antrópicos. Amenaza Alta se observa en zonas con pendientes entre 50 

- 100%, que para el caso en estudio se ubican hacía el centro, sureste y suroeste del 

cantón, los suelos presentan características poco cohesivas y rocas meteorizadas, 

fracturadas o de otro tipo de discontinuidad, y estos se ven acelerados por las 

precipitaciones existentes en la zona. Amenaza Media observada en la parte norte del 

cantón principalmente, presenta características en la que los materiales son muy poco o 

nada fracturados, con pendientes entre 30 - 50%, este material por lo general, esta 

propenso a sufrir inestabilidades debido a actuaciones naturales intensas y de largos 

períodos,  con precipitaciones que aceleran dichos procesos. Amenaza Baja  y Zonas sin 

amenazas se observa al norte, centro y este del cantón y está caracterizado por ser zonas 

con suelos, pendientes y geología estables, que así presenten lluvias intensas y de largos 

períodos no se ven afectadas significativamente debido a que el espacio geográfico tiene 

características estables. 
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4.1.2 Gobierno Autónomo Descentralizado Municipal de Chordeleg 

 

En el Plan de Desarrollo y Ordenamiento Territorial del cantón Chordeleg actualizado al 

año 2015, referido a amenazas se indica que existen dos deslizamientos de baja 

probabilidad, magnitud e intensidad mediana hacia norteste del cantón y un flujo de 

escombros con alta probabilidad, magnitud e intensidad elevadas junto a los 

deslizamientos antes mencionados, mientras que en el resto del cantón no evidencian 

ninguna amenaza adicional.  

Describen como el ser humano puede desatar procesos dinámicos a través de diferentes 

acciones como por ejemplo,  construcción de carreteras, infraestructuras urbanas y cierto 

tipo de manejos hidráulicos favoreciendo de esta manera procesos dinámicos de 

movimientos o remoción en masa. En definitiva el PDOT no contempla un análisis 

metódico del área que ocupa el cantón sino hace un inventario de los de masa que más 

problemas han causado en tiempos recientes, por lo cual la herramienta y resultados aquí 

presentados permitirán mejorar el tratamiento del tema en el PDOT del cantón Chordeleg. 

4.2 APORTE DE INFORMACIÓN POR PARTE DE POBLACIÓN 

 

Para conocer de una fuente más cercana como están las amenazas, vulnerabilidades y 

riesgos en la zona de estudio, se realizó una entrevista al Arq. Michael García, Director de 

Planificación del Gobierno Autónomo Descentralizado Municipal de Chordeleg, quien 

informa que el detonante principal para la activación de los movimientos en masa siempre 

es el agua. 

 

Las zonas que recién se han activado tienen como factor desencadenante el manejo del 

agua superficial y subsuperficial pero aclarando que los cambios en el manejo del agua se 

deben a acciones antrópicas, es decir, las personas llegan a ocupar zonas con pendientes 

escarpadas en donde realizan prácticas inadecuadas de riego y desencadenan 

movimientos en masa poniendo en peligro sus vidas. 

 

Otro detonante mencionado por el funcionario municipal es la imprudencia que tienen las 

personas al construir sus viviendas en pendientes escarpadas, en donde han conformado 

cortes que han servido como factor detonante para movimientos de masas, esto es 

especialmente evidente con la presencia de materiales sueltos los cuales empiezan a 

deslizarse sobre los muros construidos, una zona con alta incidencia de este fenómeno es 

la vía Chordeleg - Principal en el sector de Celel. La falta de infraestructura sanitaria 

permite las descargas de aguas residuales directamente hacia pozos ciegos o pozos 

sépticos los cuales terminan desbordándose y causando saturación en el suelo lo cual 

desencadena inestabilidades. 

 

Una serie de cortes en los taludes sin ninguna autorización se ven a lo largo de la vía 

Chordeleg - Principal, debido a que la población tiene la cultura de no pedir permiso para 

realizar intervenciones. 
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En muchas ocasiones, las Autoridades del GAD Municipal de Chordeleg han solicitado la 

intervención de la Secretaría de Gestión de Riesgos, los cuales han visitado los sitios con 

inestabilidades y han presentado un informe como resultado de la visita, el cual no es lo 

suficientemente técnico como para tomar decisiones que permitan su mitigación, 

únicamente evidencian lo observado en campo, y sugieren la contratación de un 

profesional especializado en el tema. Ante esto, las Comunidades afectadas se han visto 

en la necesidad de acudir a ellos, pero les han dado las mismas respuestas indicando que 

deben referirse al informe técnico entregado al GAD Municipal. 

 

Entre el accionar del GAD Municipal es importante mencionar que el Plan de Desarrollo y 

Ordenamiento Territorial, cuenta con normativa de aprobación y regulación que permite 

controlar y sancionar actividades que son incompatibles con el territorio. 

 

Durante los primeros meses del año, personal del GAD Municipal de Chordeleg tuvo que 

derrocar una vivienda que estaba ubicada en una zona de alta pendiente, por la 

probabilidad de que se desencadene fenómenos de remoción de masa debido a que la 

vivienda evacuaba aguas residuales ladera abajo y esto podía desencadenar algún tipo 

de inestabilidad. 

 

Dentro de su planificación se tiene previsto realizar un intercambio de tierras con las 

personas que presentan terrenos con cierto grado de inestabilidad o pendiente abrupta, 

es decir el Municipio adquiriría estas zonas para destinarlas a conservación y a cambio 

entregaría un terreno de menor tamaño pero en condiciones aptas para realizar cualquier 

tipo de infraestructura.  

 

4.3 ANÁLISIS DE LOS FACTORES A SER CONSIDERADOS PARA LA 

DETERMINACIÓN DE LAS AMENAZAS 

 

Para analizar los factores que intervienen en los métodos de Zonificación de las 

Amenazas, hemos decidido revisar aquellos que utilizan información que se encuentra al 

alcance de cada uno de los Gobiernos Autónomos Descentralizados a nivel cantonal en la 

Zona 6 de Planificación, con la finalidad de que cualquier GAD a nivel cantonal pueda 

realizar este tipo análisis en su territorio, en la fase de Diagnóstico Territorial de su Plan 

de Ordenamiento Territorial. 

 

La revisión y aplicación de las tres metodologías seleccionadas se describen de forma 

detallada a continuación: 

 

4.3.1 Metodología utilizada por la Secretaria de Gestión de Riesgos 

 

La Secretaría de Gestión de Riesgos en su análisis utiliza 8 factores: para la generación 

de los mapas de amenazas a nivel nacional, revisando la información con la que han 

trabajado el cantón Chordeleg, se observa que el shapefile correspondiente a estructuras  

(fallas) no registra información en el analisis, debe indicarse que a escala 1:100.000 si 
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existe información referente a fallas y que se utiliza en otros métodos analizados en esta 

investigación, por lo tanto, únicamente se analizarán los 7 factores para la generación del 

mapa de amenazas del cantón Chordeleg. Toda la información, archivos shapefiles se 

encuentran en el sistema geográfico de coordenadas GCS_Geographic Coordinate 

System, Datum PSAD56. 

A continuación se describen cada uno de los factores que han intervenido en el análisis: 

Mapa de Pendientes 

El mapa de pendientes elaborado para este análisis tiene una clasificación y valoración de 

pendientes en porcentaje. 

La Ilustración 9 muestra las pendientes presentes en el territorio cantonal: pendientes muy 

bajas con porcentajes entre 0 y 15% hacia el norte del cantón, pendientes bajas con 

pendientes entre 15 y 30%, pendientes medias entre 30 y 50% en la mayor parte del 

territorio, pendientes altas entre 50 y 100% hacia el oeste en mayor proporción y muy 

altas superiores al 100% al sur del cantón. 

 

Uso de Suelo 

La Ilustración 10 muestra el mapa de Uso de Suelo  del cantón Chordeleg, la mayor parte 

del territorio está ocupado por cultivos indiferenciados en donde se destacan los pastos 

plantados, le sigue en cobertura los páramos hacia el sur este, presencia de vegetación 

arbustiva en el norte y sur oeste y  bosque natural en el centro del cantón. 

 

Geológico 

El mapa geológico, Ilustración 11 utilizado para el análisis de amenazas del cantón 

Chordeleg, muestra que la mayor parte del territorio está cubierto por materiales 

pertenecientes a la formación Tarqui y en menor cobertura rocas metamórficas 

indiferenciadas que son fácilmente observables cuando se recorre la carretera Sígsig – 

Matanga – Gualaquiza. Depósitos aluviales encontramos al  norte del cantón junto al 

cauce del río Gualaceo y afloramientos de los Metavolcánicos de San Francisco. 

 

Geomorfológico 

 

La Ilustración 12, muestra el mapa geomorfológico de Chordeleg en donde se observa 

que la mayor parte del territorio presenta un relieve relativo alto, con muy pocas áreas con 

relieve medio y muy bajo. 
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Ilustración 9. Mapa de pendientes – SGR del cantón Chordeleg 

 
Fuente: Secretaria de Gestión de Riesgos - SGR 

Elaboración: Autor 
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Isoyetas 

En el mapa de isoyetas del cantón Chordeleg, las zonas más susceptibles a inundaciones 

son las que se ubican hacia el sur  este del cantón, donde el páramo es el que recoge la 

mayor cantidad de lluvias y las almacena, en cambio hacia el norte el nivel es muy bajo, 

ver Ilustración 13. 

 

Textura del Suelo 

Con respecto a la textura del suelo, la mayor parte del territorio presenta textura media, en 

el centro del territorio hacia el norte textura fina y gruesa hacia el sur, la Ilustración 14 

permite observar lo descrito. 
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Ilustración 10. Mapa de uso de suelo – SGR del cantón Chordeleg 

 
Fuente: Secretaria de Gestión de Riesgos - SGR 

Elaboración: Autor 
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Ilustración 11. Mapa geológico – SGR del cantón Chordeleg 

 
Fuente: Secretaria de Gestión de Riesgos – SGR 

Elaboración: Autor 
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Ilustración 12. Mapa geomorfológico – SGR del cantón Chordeleg 

 
Fuente: Secretaria de Gestión de Riesgos - SGR 

Elaboración: Autor 
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Ilustración 13. Mapa de isoyetas – SGR del cantón Chordeleg 

 
Fuente: Secretaria de Gestión de Riesgos - SGR 

Elaboración: Autor 
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Ilustración 14. Mapa de textura del suelo – SGR del cantón Chordeleg 

 
Fuente: Secretaria de Gestión de Riesgos - SGR 

Elaboración: Autor 
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Profundidad de Suelo 

De acuerdo a la metodología  propuesta para la determinación de la profundidad del suelo 

resulta complicado definir exactamente la profundidad del suelo, de acuerdo a la 

información presentada por la Secretaría de Gestión de Riesgos, se tiene que suelos con 

profundidades mayores a 3 metros se observan al norte y sur del cantón, en el centro 

suelos entre 1 y 3 metros de profundidad y menores a 1 metro hacia el este del cantón. Lo 

descrito se puede observar en la Ilustración 15.  

 

4.3.2 Método de Brabb 

 

En el método de Brabb los factores a ser considerados para la determinación de las 

amenazas están referidos a los fenómenos de remoción en masas, unidades litológicas y 

pendientes. 

 

Fenómenos de Remoción en Masa - FRM 

Los procesos de remoción en masa son aquellos que involucran el movimiento de los 

materiales formadores de las laderas bajo la influencia de la gravedad (por la cual también 

se les conoce como procesos gravitacionales) y sin la asistencia primordial de algún 

agente de transporte fluido  (Brunsden, 1979). 

Para el caso del cantón Chordeleg, se utilizará como información para el análisis de los 

fenómenos de remoción en masa los mapeados para la elaboración del informe del Plan 

de Riesgos de la provincia del Azuay, el Cuadro 19 muestra la valoración de los 

fenómenos de remoción en masa,  los cuales se encuentran consolidados en un archivo 

digital en base a información verificada en campo y fotointerpretación realizada en el año 

2012, para el resto de cantones de la Zona 6 de Planificación se podría utilizar la 

información presentada por INFOPLAN y a la cual se puede acceder a través de una 

solicitud a la Subsecretaría Zonal 6 de Planificación -SENPLADES. 

La Ilustración 16, muestra los fenómenos de remoción en masa que se encuentran 

mapeados corresponden a deslizamientos, flujos de escombros y reptaciones los cuales 

representan 4.32 km2 que corresponde al 4.11% del territorio, de acuerdo a su magnitud 

los hemos clasificado en altos, medios y bajos con su respectiva valoración, al resto de 

territorio cantonal se le asignó una valoración de 1. 

Según la UNESCO RAPCA, los deslizamientos se definen como "un movimiento en masa 

de roca, detritos, o tierra pendiente abajo bajo la acción de la gravedad, cuando el 

esfuerzo de corte excede el esfuerzo de resistencia del material" (UNESCO-RAPCA, 

1999). 
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Ilustración 15. Mapa de profundidad del suelo – SGR del cantón Chordeleg 

 
Fuente: Secretaria de Gestión de Riesgos - SGR 

Elaboración: Autor 
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Los flujos de escombros a su vez son movimientos que se producen en rocas, escombros 

y suelos; en los últimos dos casos están relacionados con una saturación de agua, 

principalmente en los períodos de lluvia intensa. El movimiento generalmente es muy 

rápido y por eso es muy peligroso  (GTZ, 2007).  

Las reptaciones a su vez se las identifican cuando la masa de suelo o roca ha sufrido 

deformaciones, como consecuencia de movimientos muy lentos por acción de la 

gravedad. Se suele manifestar en la curvatura de las rocas y troncos de los árboles, el 

corrimiento de carreteras y líneas férreas y la aparición de grietas  (GTZ, 2007).  

Cuadro 19.  Valoración de los Fenómenos de Remoción en Masa 

Descripción Clasificación Valoración 

Deslizamientos Alta 5 

Flujo de escombros Media 4 

Reptación Baja 3 

Fuente: (Gobierno Provincial del Azuay, 2012) 

 

Unidades Litológicas 

 

Para analizar las unidades geológicas presentes en el cantón Chordeleg, se utilizará 

como insumo los mapas geológicos elaborados para el Plan de Riesgos del Azuay a 

escala 1:50.000, ya que esta fuente de información es una de las más actuales para el 

análisis geológico de la provincia. 

Para el resto de provincias de la Zona 6 de Planificación se podría utilizar las hojas 

geológicas a escala 1:100.000 elaboradas por el Instituto Nacional de investigación 

Geológico Minero -INIGEMM, esta información se encuentra en SENPLADES en caso de 

necesitar este insumo. 

Los mapas de geología regional describen las características litológicas de las 

formaciones presentes en el cantón Chordeleg, en las cuales se puede mencionar:  

Depósito Aluvial – Da 

Depósitos recientes post-glaciares (Holóceno) hasta nuestros días, material transportado 

y depositado por los ríos, el cual forma parte de las llanuras de inundación (especialmente 

en los valles amplios). Está compuesto por bloques, gravas y arenas limosas en 

diferentes porcentajes y composición, sus formas van de redondeadas a subangulares 

según la dinámica y morfología del curso fluvial. 

Tillitas – gt 

Corresponde a material de origen glacial compuesto por bloques de dimensiones 

heterogéneas y matriz fina muy compacta pero con escasa o sin plasticidad.  Tienen 

características geomecánicas muy buenas y es muy raro que se vean involucrados en 

fenómenos geodinámicos a menos que se saturen de manera importante. 
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Ilustración 16. Mapa de fenómenos de remoción en masa del cantón Chordeleg 

 
Fuente: (Gobierno Provincial del Azuay, 2012) 
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Elaboración: Autor 

 

Depósitos Coluviales – Co 

Depósitos de ladera y de pie de talud con materiales que han sufrido poco transporte, son 

muy      heterogéneos dependiendo de la zona y el fenómeno inestable que les dio origen: 

deslizamientos,  derrumbes, flujos, etc.  De manera general se componen de mezclas 

heterogéneas de bloques y   fragmentos angulares y subangulares en matriz limo arcillosa 

con microfragmentos. 

Los coluviales más recientes fueron producidos por el desagüe del lago de “La Josefina” 

localizándose en Challuabamba, “La Josefina”, Shishío, Chicticay etc.; en los mapas - 

esquemas geológicos se indican además coluviales recientes post-glaciares (Holoceno) 

hasta nuestros días.  Otros depósitos de ladera están diferenciados como de piemonte 

sobre todo aquellos con influencia glaciar (Pleistoceno). 

Por su naturaleza es muy fácil que si cambian las condiciones de drenaje o existe erosión 

al pie de los depósitos se vuelvan a producir problemas de estabilidad en su masa. 

Terraza Fluvial Glaciar – T  

Depósitos de origen mayormente aluvial. En la zona de Cuenca cubren en extensas áreas 

planas con cinco diferentes niveles de terrazas, compuestas por potentes capas 

conglomeráticas de matriz areno-arcillosa distribuidas en las márgenes de los ríos 

Tomebamba, Yanuncay, Machángara y Tarqui, desde Sayausí (UTM 9683000  714000) 

hasta El Descanso (UTM 9686000  736200).  

El área de aporte es el flanco este de la Cordillera Occidental y el Norte del Nudo en 

dirección al Portete de Tarqui. La depositación tuvo lugar durante el período Cuaternario, 

con incidencia glaciar en las zonas altas y medias durante las épocas de glaciación del 

Pleistoceno. Las relaciones estratigráficas entre los diferentes niveles son poco 

conocidas. 

Las terrazas (t1-t4) están formadas por bloques y boleos subangulares a redondeados y 

subesféricos (ocurrencia 40 y 70%) en matriz de grava areno arcillosa (ocurrencia 60 y 

30%), la terraza t5 está formada por estratos erráticos de arena, limo y depósito aluvial de 

potencia variada. 

Otros sectores como la cuenca del Burgay y del Gualaceo presentan terrazas menos 

desarrolladas. 

Formación Tarqui – Pt  

Fue considerada como el manto volcánico que cobre extensas regiones en la sierra sur 

del Ecuador en discordancia sobre capas más antiguas. En la secuencia hay depósitos de 

piroclástos y aglomerados de composición riolítica a andesítica; tobas, cenizas volcánicas 

e ignimbritas y localmente lavas. No se conoce con claridad las fuentes de emisión. Dos 
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dataciones de radiocarbón en madera fósil indican edades jóvenes  de 34.300 y 24.900 

años o sea del Pleistoceno Superior (UNDP, 1969 y Huss, F. 1973, en Bristow, 1974). 

 

Tobas de Gualaceo – QG 

Afloran en la hoja Gualaceo, en los alrededores de la ciudad del mismo nombre, en 

discordancia sobre las rocas metamórficas y parcialmente rellenando el valle.  Son flujos 

piroclásticos riolíticos tipo “ash flow” de color claro (pómez, cuarzo, biotita y hornblenda), 

localmente se presentan depósitos de lapilli de pómez en estratos que representan la 

erupción pliniana precursora de los flujos piroclásticos y una lava andesítica fracturada y 

medianamente alterada que genéticamente no está relacionada con los materiales 

piroclásticos.  Los flujos piroclásticos tienen una potencia de unos 200 m y se encuentran 

bien preservados, según Bristow y Guevara (1974), estos volcánicos son contemporáneos 

con la formación Llacao. 

Unidad El Pan – EP 

Esta constituida esencialmente los esquistos El Pan de Bristow (1973), esta Unidad es 

una facies volcano sedimentaria metamorfizada del afloramiento del terreno Alao. 

Unidad Granitoide Tres Lagunas - TrL 

Representa una parte de la división litotectónica “Terreno Loja”. Se trata de un cuerpo de 

granito de un cuarzo azul, asociadas a rocas metasedimentárias de las unidades 

Chiguinda y Agoyán.  

Unidad Maguazo – Mz 

Rocas turbidíticas y volcánicas (andesitas-basalto) ligeramente meteorizadas. Se extiende 

desde las cercanías de San José de Paolo hacia el N (Norte)  hasta el río Paute hacia el S 

(Sur) (aprox. 200Km). Exhibe contactos tectónicos con la Unidad Peltetec hacia el 

occidente y la Unidad Paute hacia el este (a lo largo de la falla de San Antonio). Tiene 

abundantes e importantes fósiles que señalan una edad Jurásica (Litherland et al..1994). 

Estos actores la interpretan como una secuencia marina de antearco del arco de la isla 

oceánica Alao Paute. La presenciad e turbiditas y acritarcos retrabajados podría indicar un 

ambiente de alta temperatura y la proximidad de rocas ordovícicas con ningún o escaso 

metamorfismo. 

La Ilustración 17, muestra la disposición de las Unidades Litológicas presentes en el 

cantón Chordeleg, como se puede observar la formación Tarqui, es la que cubre la mayor 

área del territorio cantonal, presencia de depósitos aluviales junto a la margen del río 

Gualaceo, materiales de la Unidad Granitoide Tres Lagunas en la parte alta del territorio 

hacia el límite con la provincia de Morona Santiago, así también tillitas y materiales de la 

Unidad El Pan. 
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Ilustración 17. Mapa geológico del cantón Chordeleg 

 

Fuente: Plan de Riesgos del Azuay, 2012 

Elaboración: Autor 
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La valoración más alta presentan las unidades litológicas con mayores probabilidades a 

sufrir inestabilidades, es así que los Depósitos Coluviales tienen una valoración de 5 por 

haber sufrido poco transporte, son muy heterogéneos dependiendo de la zona y el 

fenómeno inestable que les dio origen, la formación Tarqui 4, Unidad El Pan y Tobas de 

Gualaceo 3, Tillitas, Terraza Fluvio glaciar y Unidad Maguazo 2 y los Depósitos Aluviales 

y la Unidad Granitoide Tres Lagunas 1 debido a que se trata de un Granitoide bastante 

estable, esta valoración se ha realizado en base a la composición litológica, textura, 

profundidad de los materiales y características geomecánicas de cada una de las 

unidades litológicas presentes en el territorio cantonal.  

La clasificación y valoración se ejecutó en función de los criterios antes mencionados, la 

cual se halla en el Cuadro 20, correspondiente a la clasificación litológica de las 

formaciones presentes en el cantón Chordeleg. 

 

Cuadro 20. Clasificación litológica de las formaciones presentes en el cantón Chordeleg 

Formaciones Geológicas Clasificación Valoración 

Depósitos Coluviales Muy Alta 5 

Formación Tarqui Alta 4 

Unidad El Pan Media 3 

Tobas de Gualaceo Media 3 

Tillitas Moderada 2 

Terrazo Fluvioglaciar    Moderada 2 

Unidad Maguazo Moderada 2 

Depósito Aluvial Muy Alta 1 

Unidad Granitoide Tres Lagunas Baja  1 

Fuente: (Gobierno Provincial del Azuay, 2012) 

 

Pendientes 

 

Para generar el mapa de pendientes se utilizó cartografía a escala 1:50.000 publicada por 

el Instituto Geográfico Militar –IGM, para lo cual se elaboró un TIN 3D y en función de eso 

obtener el mapa de pendientes a través de la utilización de los Sistemas de Información 

Geográfica. 

El mapa de pendientes se ha reclasificado según la Clasificación de Pendientes adoptada 

por el Programa MAG-PRONAREG-ORSTOM en 1983, la cual clasifica a las pendientes 

en seis rangos característicos que a continuación se detallan: 

 0 - 5%: Contempla pendientes denominadas débiles, en las cuales se puede 

realizar todo tipo de mecanización agrícola, generalmente los suelos ubicados 

sobre estas pendientes no contienen piedras.  

 

 5 – 12%: Corresponden a pendientes suaves y regulares, se pueden realizar 

actividades de mecanización agrícola con ciertas restricciones, no presentan 

dificultades para el riego. 
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 12 – 25%: Hasta el 20% corresponden a pendientes regulares. Las restricciones 

para la mecanización son más fuertes y existen dificultades para regar. 

 

 25 – 50%: Las mayores limitaciones que se presentan para este tipo de pendientes 

es el hecho de que existen enormes dificultades para el riego; existen peligros de 

erosión hídrica y eólica, además de movimientos en masa más conocidos como 

derrumbes. 

 

 50 – 70%: Es imposible realizar labores agrícolas, los problemas de erosión y 

deslizamientos se vuelven frecuentes, es recomendable la repoblación forestal 

para este tipo de pendientes. 

 

 > 70%: Pendientes abruptas en las cuales no es posible desarrollar actividades 

agropecuarias. Los peligros de erosión  deslizamientos son mucho más latentes 

que en los casos anteriores. Se aconseja para estos casos el establecimiento de 

áreas destinadas a la conservación del patrimonio natural. 

 

En el Cuadro 21 e Ilustración 18, se observan las clases de pendientes obtenidas para el 

cantón Chordeleg, en donde se puede apreciar que terreno casi plano y suave 

únicamente cubre una extensión de 11.11 km2, con pendientes moderadas encontramos 

25.52 km2 del territorio, mientras que terrenos con pendientes superiores al 25% ocupan 

más de la mitad del territorio en una área de 68.34 Km2.  

 

Cuadro 21. Clases de pendientes en el cantón Chordeleg 

Descripción Clasificación 
Área  

Valoración 
Km

2
 

Plano o casi plano 0 - 5  3.62 1 

Suave 5 - 12 7.49 2 

Moderada 12 - 25 25.52 3 

Fuerte 25 - 50 43.22 4 

Muy Fuerte 50 - 70 15.4 5 

Abrupta > 70 9.72 6 

Total 104.97  

Fuente: MAG-PRONAREG, 1983 
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Ilustración 18. Mapa de pendientes del cantón Chordeleg 

 

Fuente: MAG-PRONAREG, 1983 

Elaboración: Autor 
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4.3.3 Método Mora-Vahrson 

 

A continuación se describen cada uno de los parámetros utilizados en el método de Mora 

y Vahrson: 

 

Índice de Relieve Relativo 

Para el análisis del índice de relive relativo se considerará el ángulo de pendiente de 

terreno, que corresponderá al mapa de pendientes generado para el método anterior 

según la clasificación adoptada para el Programa MAG-PRONAREG-ORSTOM en 1983. 

Índice de Influencia Litológica 

Para el análisis del índice de influencia litológica, se valorará varias propiedades 

geomecánicas como son: composición mineralógica o tipo de material, textura, estructura, 

grado de meteorización y grado de fracturamiento, los tipos de suelos y rocas constituyen 

un papel importante en el comportamiento dinámico de las laderas, por lo que se 

correlacionará la litología existente en el cantón con la propuesta en la Clasificación de 

Mora y Vahrson y que se encuentra detallada en el Cuadro 3 de este documento. 

A los Depósitos Coluviales y Aluviales se los calificará con una valoración Muy Alta 

correspondiéndoles un factor 5,  a la  Formación Tarqui en cambio se le asigna una 

calificación Alta con factor de 4, a la Unidad El Pan se le califica como Media y se le 

asigna un factor 3, a las Tillitas, terraza fluvioglaciar y Unidad Maguazo se les califica 

como Moderada con factor 2 y finalmente a la Unidad Granitoide Tres Lagunas como Baja 

con un factor 1, debido principalmente a que esta Unidad se encuentra bastante estable 

sin presencia de estructuras falladas. 

 

Cuadro 22. Valoración de las unidades litológicas del cantón Chordeleg 

 Formaciones Geológicas Calificación Valoración 

Depósitos Coluviales Muy Alta 5 

Formación Tarqui Alta 4 

Unidad El Pan Media 3 

Tobas de Gualaceo Media 3 

Tillitas Moderada 2 

Terrazo Fluvioglaciar    Moderada 2 

Unidad Maguazo Moderada 2 

Depósitos Aluviales Muy Alta 1 

Unidad Granitoide Tres Lagunas Baja  1 
Fuente: Autor 
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Índice de Influencia de la Humedad del Suelo 

Las variaciones de humedad del terreno esta relacionadas directamente con las 

interacciones del ciclo hidrológico especialmente con las precipitaciones, la humedad del 

terreno es un factor a ser considerado puesto que a través de la percolación se pueden 

crear altas condiciones de presiones de poros en el suelo y rocas; las cuales producirían 

movimientos de masas de tierra durante el período de lluvia como resultado de 

torrenciales precipitaciones en suelos o rocas meteorizadas y poco estables.   

Para determinar el índice de influencia de la humedad del suelo, se revisarón valores 

promedios mensuales de precipitación de la estación Punguhuayco ubicada en el cantón 

Chordeleg que registra valores desde el año 2006 hasta el año 2010, Ilustración 19. La 

precipitación mínima se registra en el mes de septiempre con un valor de 47.2 mm de 

lluvia y la máxima en el mes de abril con un valor de 135.9 mm de lluvia, según se 

observa en la Ilustración 19. 

Ilustración 19. Promedio de lluvias mensuales en la estación Punguhuayco 
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Fuente: (Gobierno Autónomo Descentralizado Cantonal de Chordeleg, 2015) 

 

Si categorizamos a estas precipitaciones según el Cuadro 4, podemos observar que todos 

los valores tendrán como valor asignado el número 0 a excepción de la precipitación 

mensual correspondiente al mes de abril en donde el valor asignado es de 1. 

Una vez sumados los valores asignados se obtiene un valor de 1 que corresponde al 

calificativo muy bajo con un parámetro de 1. 

 

Índice de Influencia de Actividad Sísmica 

Para el análisis del índice de influencia de actividad sísmica, se utilizó la información 

presentada en la Norma Ecuatoriana de la Construcción –NEC, en el capítulo 

correspondiente a Peligro Sísmico, Diseño Sismo Resistente, en el cual el Ministerio de 

Desarrollo Urbano y Vivienda – MIDUVI,  como ente rector de las políticas de hábitat y 

vivienda a nivel nacional, ha formulado una normativa “que propicie el desarrollo ordenado 
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y seguro de los Asentamientos Humanos, la densificación de las ciudades y el acceso a la 

vivienda digna” (Ministerio de Desarrollo Urbano y Vivienda, 2014). 

El Ecuador al estar localizado en una zona calificada de alto riesgo sísmico, cuenta con 

un mapa de zonificación sísmica para diseño, el cual proviene del resultado del estudio de 

peligro sísmico para un 10% de excedencia en 50 años (período de retorno 475 años), 

que incluye una saturación a 0.50 g de los valores de aceleración sísmica en roca en el 

litoral ecuatoriano que caracteriza la zona VI. 

Cuadro 23. Valores del factor Z en función de la zona sísmica adoptada 

Zona Sísmica I II III IV V VI 

Valor factor Z 0.15 0.25 0.30 0.35 0.40 ≥ 0.50 

Caracterización 
del peligro 

sísmico 
Intermedia Alta Alta Alta Alta Muy Alta 

Fuente: (Ministerio de Desarrollo Urbano y Vivienda, 2014) 

 

 

Todo el territorio ecuatoriano esta catalogado como de amenaza sísmica alta, con 

expeción del: 

 Nororiente que presenta una amenaza sísmica intermedia. 

 Litorial ecuatoriano que presenta una amenaza sísmica muy alta. 

En el diseño de edificios se utiliza el valor Z, que representa la aceleración máxima en 

roca esperada para el sismo de diseño, expresada como fracción de la aceleración de la 

gravedad. 

Para facilitar la determinación del valor de Z, del cantón Chordeleg nos referimos al 
Cuadro 23, de la NEC Peligro Sísmico Diseño Sismo Resistente, en la cual se encuentra 
el valor Z de 0.25, que correspondería a la Zona Sísmica II y tendría una caracterización 
de peligro sísmico Alta. 

Al ocupar este factor en la generación del mapa de amenazas, el mismo no es 

representativo debido a que todo el territorio del cantón Chordeleg, se encuentra en la 

Zona Sísmica II, lo cual no representa ningún cambio, en el resultado final, una vez que 

se realiza el cruce con el resto de factores. 

 

Índice de influencia de las lluvias intensas 

Para analizar el índice de influencia de lluvias intensas se utilizó el shape correspondiente 

a zona hidrológica en el que se observa dos rangos de precipitaciones marcadas, la 

primera hacia el norte y centro del cantón con valores ente 750 – 1250 mm de lluvia anual 

y la segunda en el sur con precipitaciones entre 1250 – 2500 mm de lluvia anual. 
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La marcada división de las precipitaciones registradas afecta al resto de factores que 

intervienen en el análisis es decir, para que el factor influya en el análisis, la escala de la 

información a trabajar deberá ser lo más pequeña posible.  

La Ilustración 21, permite observar la marcada división en las lluvias presentadas en el 

territorio del cantón Chordeleg. 

4.4 ZONIFICACIÓN DE LAS AMENAZAS 

 

Una vez que se han analizado cada uno de los factores que intervienen en los  métodos 

de la Sercretaría de Gestión de Riesgos, Brabb y Mora-Vahrson se presentan los mapas 

de amenazas obtenidos una vez realizadas las operaciones en el sistema de información 

geográfica ArcGis. 

 

Previa a la operación en el Raster Calculator, los shapefiles fueron transformados a 

raster, para lo cual se ingreso a Spatial Analyst Tools > Convert > Features to raster en 

función de la valoración asignada previamente en el análisis de cada uno de los 

parámetros. 

 

Los parámetros convertidos en raster se añadieron al raster calculator, seleccionando 

Spatial Analyst Tools > Raster Calculator > Evaluate, para así obtener cada uno de los 

mapas de amenazas como se observan en las Ilustraciones 23, 24 y 25. 

 

4.4.1 Método de  la Secretaría de Gestión de Riesgos 
 

La Ilustración 20, muestra la expresión algebraica utilizada en la metodología de la 

Secretaría de Gestión de Riesgos para obtener el mapa de amenazas mediante la 

utilización de la herramienta informática Raster Calculator. 

Ilustración 20. Expresión algebraica utilizada en la metodología de la Secretaría de Gestión de Riesgos 

 
Elaboración: Autor 
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Ilustración 21. Mapa de influencia de lluvias del cantón Chordeleg 

 

Fuente: SNI - SENPLADES 

Elaboración: Autor 
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La Ilustración 22, describe las clasificaciones de las amenazas por movimientos en masa 

en el mapa de riesgos geológicos de la Secretaría de Gestión de Riesgos. 

Ilustración 22. Clasificación de las amenazas por movimientos en masa 

 
Fuente: (Secretaria de Gestion de Riesgos, 2010) 

 

4.4.2 Método de Brabb 

 

El mapa de amenazas resultante de la aplicación del método de Brabb, se observa en el 

Ilustración 24, en donde la mayor parte del territorio presenta amenaza nula, y sitios 

puntales alrededor de los centros poblados amenazas altas y muy altas. 

4.4.3 Método Mora y Vahrson 

 

En el método de Mora y Vahrson Ilustración 25, la amenaza nula se presenta en el sur 

del cantón y en sitios en los cuales los terrenos son planos y las unidades litológicas 

buenas, amenaza baja en el centro y norte del cantón en terrenos suaves, con unidades 

litológicas buenas y baja presencia de movimientos en masa, amenaza media se observa 

en zonas con pendientes moderadas, presencia de fenómenos de remoción en masa y 

unidades litológicas con características geotécnicas medias, amenaza alta hacia el norte 

del cantón en zonas con pendientes fuertes, con presencia de fenómenos de remoción en 

masa en unidades litológicas malas, no existe la presencia de amenaza muy alta en el 

territorio cantonal. 

 

4.5 CLASIFICACIÓN DE LAS AMENAZAS 

Una vez definidas las áreas con similares características y aplicado el método Standard 

Deviation se tienen los siguientes rangos de clasificación: 

Amenaza Nula: Zonas en donde la combinación de los parámetros analizados tiene 

influencia nula en el territorio, es decir terrenos planos, con unidades litológicas buenas y 

nula presencia de movimientos en masa. 

Amenaza Baja: Zonas en donde la combinación de los parámetros analizados tiene 

influencia baja en el territorio, es decir terrenos suaves, con unidades litológicas buenas y 

baja presencia de movimientos en masa. 
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Ilustración 23. Mapa de amenazas del cantón Chordeleg - método Secretaría de Gestión de 
Riesgos  

 
Elaboración: Autor 
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Amenaza Media: Zonas en donde la combinación de los parámetros analizados tiene 

influencia media en el territorio, es decir, zonas con pendientes moderadas, con presencia 

de fenómenos de remoción en masa y unidades litológicas con características 

geotécnicas medias. 

Amenaza Alta: Zonas en donde la combinación de los parámetros analizados tiene 

influencia alta en el territorio, es decir, zonas con pendientes fuertes, con presencia de 

fenómenos de remoción en masa en unidades litológicas malas. 

Amenaza Muy Alta: Zonas en donde la combinación de los parámetros analizados tiene 

influencia muy alta en el territorio, es decir, mayor cantidad de fenómenos de remoción en 

masa, en unidades litológicas malas, sobre pendientes muy fuertes y abruptas. 
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Ilustración 24. Mapa de amenazas del cantón Chordeleg - método Brabb 
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Elaboración: Autor 

Ilustración 25. Mapa de amenazas del cantón Chordeleg - método Mora y Vahrson 
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Elaboración: Autor 

 

5. VULNERABILIDADES 

 

5.1 ANÁLISIS DE INFORMACIÓN EXISTENTE 

 

Para analizar el componente de vulnerabilidad, se hará referencia a los siguientes 

parámetros: 

5.1.1 Distribución poblacional por Unidades Censales 

 

El Instituto Nacional de Estadísticas y Censos -INEC, ha determinado Unidades Censales 

en base a los límites político administrativos de las cabeceras cantonales y parroquias 

rurales del país. Cada una de éstas se divide en Unidades Censales Dispersas y 

Unidades Censales Amanzanadas. 

 

Las Unidades Censales Dispersas están constituidas por: Zonas Dispersas, Sectores 

Dispersos y Localidades Dispersas.  

 

Las Unidades Censales Amanzanadas en cambio por Zonas Amanzanadas, Sectores 

Amanzanados y Manzanas. 

 

Cada una de ellas tiene ciertas características que para el caso del cantón en estudio las 

han dividido en 56 según el shape de sectores censales elaborado por el INEC y en el 

que se puede observar una serie de variables que permiten identificar las características 

de la población existente en cada una de estas áreas definidas como por ejemplo: índice 

de servicios básicos, porcentaje de hogares hacinados, número de personas ocupadas 

por rama de actividad, NBI por hogares y datos relacionados a la población 

economicamente activa –PEA, además del número de personas por sexo. 

 

Para nuestro caso utilizaremos la población registrada en cada una de estas áreas para 

obtener así la densidad poblacional existente, Ilustración 26. 

 

5.1.2 Ubicación de equipamientos 

 

La ubicación de los equipamientos existentes en el cantón Chordeleg,  deben estar 

mapeados con la finalidad de que se conozca el tipo de infraestructuras existentes en el 

territorio, especialmente las correspondientes a Salud y Educación debido a que al 

momento que se produzca un riesgo, la población necesitaría acudir a estos Centros de 

Salud que serían los más próximos a su ubicación o utilizar las escuelas como posibles 

albergues hasta que ellos puedan regresar a sus viviendas. 
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Ilustración 26. Mapa de densidad poblacional del cantón Chordeleg 

 
Fuente: INEC 

Elaboración: Autor 



 
Universidad de Cuenca                                                                                                                 
Facultad de Arquitectura y Urbanismo 
Maestría en Ordenación Territorial II Cohorte                                                                     

102 
Ing. Andrea Valerie Brito Puni 

 

 

Salud 

La atención médica en el cantón Chordeleg la brindan fundamentalmente los centros del 

Sistema Salud Pública y los dispensarios del Seguro Social Campesino presentes en las 

zonas rurales, Cuadro 24, a los cuales la población podría asistir en caso de presentar 

alguna amenaza en el territorio, cabe indicarse que en el territorio del cantón Chordeleg 

no existe servicio de emergencias las 24 horas del día ni disponen de ambulancia, lo cual 

representa un grave peligro para la salud de la población en caso de presentarse una 

emergencia médica fuera de la jornada laboral.  

 

Además, es importante resaltar que la atención del Sistema de Salud Pública y Seguro 

Social Campesino es gratuita, la Ilustración 27 muestra la ubicación de los Equipamientos 

de Salud en el cantón Chordeleg. 

 
Cuadro 24. Equipamientos de salud en el cantón Chordeleg 

Descripción 
Unidad de 

Salud 
Cantidad Ubicación Personal 

Sistema de 

Salud Pública 

Centro de 

Salud 
1 Chordeleg 

6 Médicos Generales, 

1 Ginecólogo, 2 

Odontólogos, 3 

Enfermeras y 1 

Inspector de Salud 

Subcentro de 

Salud 
1 Principal 

1 Médico, 1 

Odontólogo y 1 

Enfermera 

Puestos de 

Salud 
3 

San Martín de 

Puzhío 

La Unión 

Delegsol 

Están sin personal 

actualmente julio 

2015 

Seguro Social 

Campesino 

Dispensario 

médico 
2 

Delegsol 

La Unión 

1 Médico, 1 

Odontólogo y 1 

Enfermera 

Gobierno 

Autónomo 

Descentralizado 

Municipal de 

Chordeleg 

Unidad de 

Fisioterapia 
1 Chordeleg 

1 fisioterapista y 2 

enfermeras  

Privado 
Consultorios 

Privados 
5 Chordeleg 5 Médicos Generales 

Fuente: Ministerio de Salud Pública y Seguro Social Campesino 
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Ilustración 27. Mapa de Equipamientos de Salud del cantón Chordeleg 

 
Fuente: (Gobierno Autónomo Descentralizado Cantonal de Chordeleg, 2015) 

Elaboración: Autor 
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Educación 

En el campo educativo podemos mencionar que existen 15 escuelas de las cuales 7 están 

emplazadas en las parroquias rurales con una cobertura de 1.080 alumnos y 3 en el área 

urbana con un total de 881 estudiantes. Dando un total de 1.961 estudiantes. El nombre 

de los establecimientos educativos de educación básica del cantón Chordeleg, su 

ubicación, el número de paralelos y cuantos profesores y alumnos existe en cada Unidad, 

se puede revisar en el Cuadro 25. 

 

Los establecimientos educativos fiscales dan atención a 1.843 estudiantes y el particular a 

118 estudiantes.  

 

 
Cuadro 25. Establecimientos Educativos de Educación Básica del cantón Chordeleg 

No. Parroquia Comunidad 
Nombre 

Establecimiento 
Urbano Rural Grados Paralelos Alumnos Profesores 

1 

Chordeleg 

Chordeleg 
Federico González 

Suárez 
X 

 
10 10 577 23 

2 Chordeleg 
Sor María de Santo 

Tomás 
X 

 
13 8 342 14 

3 Porrión Carlos Solano 
 

X 6 6 18 2 

4 Soransol 
Francisco de Paúl 

Correa  
X 7 7 126 7 

5 Sondeleg Belisario Andrade 
 

X 7 7 76 4 

6 
San Pedro 

de Zhío 
Ángel Olivo Rivera 

Suárez  
X 6 6 34 2 

7 Chordeleg 
Santa María de la 

Esperanza 
X 

 
10 10 130 10 

8 
Principal 

Principal Francisco Calderón 
 

X 7 7 114 6 

9 Celel José María Vargas 
 

X 7 7 82 5 

10 
La Unión 

La Unión Aurelio Bayas 
 

X 10 10 242 12 

11 El Quinche Saúl T. Mora 
 

X 6 6 36 2 

12 Luis 
Galarza 
Orellana 

Delegsol Joaquín Martínez 
 

X 7 7 189 7 

13 Chocar 11 de Enero 
 

X 7 6 75 4 

14 San Martín 
de Puzhío 

Puzhío 
Rafael Romero y 

Cordero  
X 10 10 160 11 

15 Quicud Quicud 
 

X 6 6 42 3 

 
Cobertura Total de Educación 

  
116 

 
2.243 112 

 
Alumnos por Profesores 

   
8 

  

 
Alumnos por Paralelos 

    
20 

 
Fuente: (Gobierno Autónomo Descentralizado Cantonal de Chordeleg, 2015) 

 

 

El Cuadro 26, hace referencia al número de establecimientos educativos a nivel de 

bachillerato en el cantón Chordeleg, existiendo 4 colegios secundarios con un total de 

1.489 estudiantes. Dos de los colegios son fiscales con una cobertura de 974 estudiantes 

y dos son fisco-misional con una cobertura de 515 alumnos. 

 

Muchos de los estudiantes de las parroquias asisten a los colegios ubicados en el centro 

cantonal, en tanto que otros jóvenes en lugar de estudiar se quedan en sus comunidades 

realizando trabajos que les permiten obtener un ingreso que complemente la escasa 

economía familiar de sus hogares. 

 
Cuadro 26. Establecimientos Educativos a nivel de Bachillerato del cantón Chordeleg 
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Parroquia Comunidad 
Nombre 

establecimiento 
Tipo de 

establecimiento 
Especialización 

No. Estudiantes No. Profesores 

Hombres Mujeres Total Hombres Mujeres Total 

Chordeleg 

Chordeleg 
Colegio Nacional 

Chordeleg 
Fiscal 

Físico 
Matemático 
Químico-
Biológico 

399 465 864 23 18 41 

Chordeleg 

Unidad 
Educativa a 
Distancia 
Monseñor 

Leonidas Proaño 

Fisco-Misional 
Sociales 

Informática 
113 150 263 6 6 12 

Chordeleg 
Colegio Santa 

María de la 
Esperanza 

Fisco-Misional 
Comercio y 

Administración 
138 114 252 13 15 28 

Principal Principal 
Colegio 

Fasayñán 
Fiscal 

Comercio y 
Turismo 

62 48 110 7 6 13 

Cobertura Total 712 777 1.489 49 45 94 

Fuente: (Gobierno Autónomo Descentralizado Cantonal de Chordeleg, 2015) 

 

La Ilustración 28, indica la ubicación de los establecimientos educativos a nivel de 

educación básica y bachillerato existentes en el cantón Chordeleg. 
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Ilustración 28. Mapa de establecimientos educativos del cantón Chordeleg 

 
Fuente: (Gobierno Autónomo Descentralizado Cantonal de Chordeleg, 2015) 

Elaboración: Autor 
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5.1.3 Conectividad Vial 

 

La Red Vial Estatal conecta a Chordeleg con Gualaceo, Cuenca y Sigsig, la red 

secundaria permite el acceso a las parroquias y la comunicación en la cabecera urbana, 

mientras que la red terciaria es la que tiene infraestructura de menor jerarquía, que brinda 

cobertura local a sitios que se encuentran alejados de los centros poblados y se 

encuentran a nivel de lastre, en algunos casos estas comunican a establecimientos 

educativos y de salud. 

 

En la red vial de Chordeleg se observa una coherencia entre las características de diseño 

vial de los caminos y su jerarquía funcional. Únicamente la parroquia La Unión se 

encuentra desarticulada de la red secundaria, ya que a ella se accede por caminos de 

lastre. 

La calidad de la red vial urbana del cantón se puede considerar como buena, debido a 

que se encuentra asfaltada y adoquinada casi en su totalidad. Sin embargo, existe clara 

evidencia de la falta de señalización vial y turística no solo en el sector urbano sino 

también en el rural en donde la señalética es aún deficiente. 

 

Entre Chordeleg y la ciudad de Cuenca  existen 45 km de distancia, la vía se encuentra 

asfaltada y permite la comunicación con los cantones Gualaceo y Sígsig, la conectividad 

con el oriente ecuatoriano y concretamente con la provincia de Morona Santiago a traves 

de las vías Sigsig – Matanga - Gualaquiza, y Gualaceo - Limón Indanza - Macas. 

 

La red secundaria a nivel de pavimento flexible conecta al centro cantonal de Chordeleg 

con las parroquias Principal, San Martín de Puzhío y Delegsol y la red terciaria a los 

caseríos dispersos que se encuentran en el cantón.  

 

La red vial existente en el cantón Chordeleg se encuentra mapeada en la  

Ilustración 29, la red vial estatal esta mapeada en color rojo, mientras que las vías 

principales y secundarias en verde y amarillo respectivamente. 

 

5.1.4 Sistema Hidrográfico 

 

El sistema hidrográfico del cantón Chordeleg pertenece a la Subuenca del río Santa 

Barbara, en la cual se encuentran las microcuencas del río Gualaceo Bajo, San Francisco 

y Zhío, un área muy pequeña del territorio se encuentra en la Subcuenca del río Negro, 

cada uno de los afluentes de estos ríos principales que se encuentran dentro del cantón 

Chordeleg se observan en la Ilustración 30. 

 

Para las microcuencas existentes en el cantón se determinó una precipitación promedio 

anual de 1040 mm. Lo cual equivale a 91.7 He3 al año, considerando el área del cantón 

de 104,9 km2  (Gobierno Autónomo Descentralizado Cantonal de Chordeleg, 2015).   
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Ilustración 29. Mapa de conectividad vial del cantón Chordeleg 

 
Fuente: Plan de Desarrollo y Ordenamiento Territorial del cantón Chordeleg 

Elaboración: Autor 
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Los ríos Gualaceo, Gulag, Cabuncay, Zhío, San Francisco y Burra Playa constituyen el 

límite del cantón, mientras que las quebradas Chorro Blanco, Dentrofuera, Zhinasdaray 

son afluentes de los ríos Guallmincay, Tarqui, Maylas, Osococha, Tres Lagunas y 

Punguhuayco, los cuales a su vez desembocan en el río Santa Bárbara. 

 

5.2 ANÁLISIS DE LOS FACTORES A SER CONSIDERADOS PARA LA 

DETERMINACIÓN DE LAS VULNERABILIDADES 

5.2.1 Distribución poblacional por áreas censales 

 

Para analizar la distribución poblacional por áreas censales, se utilizará valores de 

densidad poblacional (hab/km2) en función de la información registrada en cada una de 

las áreas censales establecidas dentro del cantón, como se mencionó anteriormente, en 

base a la población registrada se estableció una clasificación para así asignar factores 

que permitirán su posterior análisis. 

 

La Ilustración 31 muestra la densidad poblacional por área censal en el cantón Chordeleg 

de acuerdo a los rangos establecidos en el Cuadro 27. 

Cuadro 27. Factores atribuidos a las densidades poblacionales del cantón Chordeleg 

Densidad Poblacional 
(hab/km

2
) 

Factor 

 0 - 500 1 

500 - 1000 2 

1000 - 2500 3 

2500 - 4000 4 

> 4000 5 
Fuente: Autor 

 

5.2.2 Conectividad Vial 

 

El análisis  de vulnerabilidad en las vías existentes del cantón Chordeleg, consideró un 

buffer de 100 m para las vías de primer orden, 50 m segundo orden y 25 m tercer orden, 

el Cuadro 28 muestra la clasificación utilizada. 

Las vías de primer orden correspondiente a la Red Vial Estatal comunican Chordeleg con 

Gualaceo, Sígsig y el Oriente ecuatoriano, las cuales están en proceso de ejecución por 

parte del Ministerio de Transporte y Obras Públicas y por problemas técnicos, 

administrativos y jurídicos no han sido concluidas3. 

 

 

 

 

                                                           
3
 Ing. Eduardo Merchán, Funcionario Público MTOP, 2015 
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Ilustración 30. Mapa del sistema hidrográfico del cantón Chordeleg 

 
Fuente: Plan de Desarrollo y Ordenamiento Territorial del cantón Chordeleg 

Elaboración: Autor 
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Ilustración 31. Reclasificación de densidad poblacional en función de los factores 
establecidos del cantón Chordeleg 

 

Elaboración: Autor 
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Las vías de segundo orden comunican Chordeleg con las parroquias San Martín de 

Puzhío, Delegsol y Principal se encuentran a cargo del Gobierno Provincial del Azuay, 

vías del área urbana del cantón a cargo del Gobierno Autónomo Descentralizado 

Municipal de Chordeleg. 

Las vías de tercer orden comunican a los caseríos existentes dentro del cantón 

Chordeleg, de la información y la información revisada estás se encuentran a nivel de 

lastre, los diferentes Gobiernos Autónomos Descentralizados a nivel parroquial dan 

mantenimiento a estas arterias viales a través de la contratación anual del mantenimiento 

de estas carreteras. 

La Ilustración 32, muestra la reclasificación vial del cantón Chordeleg en función de los 

buffer establecidos para cada tipo de vía existente en el territorio. 

En el ArcGis se generaron ingresando a la opción Analysis Tools > Proximity > Buffer, una 
vez creados los tres buffer se restaron del polígono cantonal utilizando la herramienta 
Erase (Analysis Tools > Overlaly > Erase).  

Con la opción Union (Analysis Tools > Overlaly > Union) se integraron los Buffer y el 

polígono cortado y se consolidaron utilizando Dissolve (Data Management Tools > 

Generalization > Dissolve). 

Cuadro 28. Reclasificación vialidad del cantón Chordeleg 

Vías Buffer (m) 

Primer orden 100 

Segundo orden 50 

Tercer orden 25 

Fuente: Autor 

 

Para el análisis de estos factores en la vulnerabilidad global del cantón se consideró un 

buffer de 500 m alrededor de los mismos, para lo cual se utilizó la herramienta informática 

ArcGis y se procedió a crear un Buffer, se ingresó a la opción Analysis Tools > Proximity > 

Buffer, de la misma manera una vez generados los Buffer se cortaron del polígono 

cantonal a través de Erase (Analysis Tools > Overlaly > Erase). 

Con la opción Union (Analysis Tools > Overlaly > Union) se integraron los Buffer y el 

polígono cortado y se consolidaron utilizando Dissolve (Data Management Tools > 

Generalization > Dissolve), en áreas sin equipamientos y con equipamientos de Salud y 

Educación respectivamente. 

Una vez realizado el Dissolve se añadió un nuevo campo, dando click derecho sobre el 

shapefile y abriendo la opción Open Attribute Table, se coloca el nombre "Valor" y al área 

sin equipamiento se le asigna  un valor de 1 y con equipamiento un valor de 5. 

 

La Ilustración 33 e Ilustración 34 muestran la ubicación de estos equipamientos en el 

territorio cantonal, así como el área de impacto en caso de producirse la amenaza. 
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Ilustración 32. Reclasificación vial del cantón Chordeleg 

 

Elaboración: Autor 
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5.2.3 Sistema Hidrográfico 

 

Para analizar el sistema hidrográfico, se trazó un buffer de 100 m alrededor de ríos y de 

50 m alrededor de quebradas. El Cuadro 29, muestra los valores alrededor de los ríos y 

quebradas utilizados para el análisis del cantón. 

La incidencia del sistema hidrográfico se ve reflejado en los movimientos en masa que 

debido a la erosión de laderas y saturación de las mismas por el agua que transportan 

podría ocasionar, a esto se podría sumar la crecida de alguno de estos afluentes, lo cual 

traería consigo efectos sobre la población que se encuentra aguas abajo, debido a la 

formación de algún represamiento por materiales caídos en los cauces de ríos o 

quebradas, que en algún momento produzcan una salida brusca de agua hacia los 

poblados existentes. 

Cuadro 29. Clasificación del sistema hidrográfico del cantón Chordeleg 

Ríos Buffer (m) 

Ríos 100 

Quebradas 50 

Fuente: Autor 

 

La Ilustración 35, muestra la reclasificación del sistema hidrográfico existente en función 

de los criterios antes mencionados. 

5.3 ZONIFICACIÓN DE LAS VULNERABILIDADES 

 

En la zonificación de las vulnerabilidades, se utilizó la herramienta informática  ArcGis, en 

la cual se analizaron los factores densidad población, reclasificaciones del sistema 

hidrográfico y vial del cantón, así como la ubicación de los equipamientos de salud, 

educación, descritos en los ítems anteriores y en los cuales se manejó el criterio de que si 

las zonas se encuentran dentro de los buffers creados tienen un peso de 5 caso contrario 

se consideró un valor de 1, el Cuadro 30 muestra las combinaciones establecidas en el 

análisis de la zonificación de las vulnerabilidades, a través de la herramienta raster 

calculation. 

 

 Cuadro 30. Combinación de Parámetros para zonificación de vulnerabilidades 

Combinación de Parámetros Valor 

Vías + Ríos + Hospitales 5 

Vías + Ríos + Educativos 4 

Vías + Hospitales 3 

Ríos + Hospitales 3 

Vías + Ríos 2 

Todo lo demás 1 
Fuente: Autor 
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Ilustración 33. Reclasificación de los equipamientos de Salud del cantón Chordeleg 

 
Elaboración: Autor 
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Ilustración 34. Reclasificación de los equipamientos de Educación del cantón Chordeleg 

 

Elaboración: Autor 
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Una vez establecida la valoración de los parámetros a considerar en la zonificación de 

vulnerabilidades, se procedió a  cruzar con los factores de densidad población para así 

obtener la vulnerabilidad del cantón Chordeleg, previa reclasificación de los valores 

obtenidos. La Ilustración 36 muestra el mapa de vulnerabilidades, en donde se observa 

que la mayor vulnerabilidad se presenta alrededor de los centros poblados del cantón 

Chordeleg. 
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Ilustración 35. Reclasificación del sistema hidrográfico del cantón Chordeleg 

 
Elaboración: Autor 
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Ilustración 36. Mapa de vulnerabilidad del cantón Chordeleg 

 

Elaboración: Autor 
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6. RIESGO GEOLÓGICO 

 

6.1 ANÁLISIS DE INFORMACIÓN EXISTENTE 

6.1.1 Gobierno Autónomo Descentralizado Provincial del Azuay 

 

El Gobierno Autónomo Descentralizado Provincial del Azuay, cuenta con el mapa de 

riesgos para la provincia del Azuay elaborado con la metodología del ITC de Holanda, que 

consiste en aplicación del método del índice de deslizamiento, en el que a través de la 

valoración de ponderación para una clase de parámetro,  tal como una cierta unidad 

litológica o una cierta clase de pendiente, es definido como el logaritmo natural del grado 

de deslizamiento de la clase divida por el grado de deslizamiento de todo el mapa. 

 

El mapa de riesgos se presenta a escala 1:25.000, y está disponible en formato tipo 

shape (.shp) y pdf. En el mapa se puede observar que existen riesgos altos hacia el norte 

del cantón y en sitios puntuales hacia el este y oeste, las hojas de Gualaceo y Sígsig 

presentan la información de riesgos existentes en el cantón. 

 

Este insumo es de mucha utilidad, debido a que la información ya mapeada los Gobiernos 

Autónomos Descentralizados podrán actualizar el shape de los fenómenos de remoción 

en masa levantados para cada uno de los cantones del Azuay, incluidos Azogues y 

Biblian de la provincia del Cañar, con el que confirmarían aquellos que se encuentran 

activos e incluirían otros que se han desencadenado después del año 2013 hasta la 

presente fecha. 

El resto de cantones de la provincia del Cañar y toda la provincia de Morona Santiago 

deberán revisar el shape de movimientos en masa que se encuentra en la información de 

INFOPLAN a escala 1:100.000, el cual deberá ser actualizado para realizar el análisis 

correspondiente, además es importante que se revisen las ortofotos presentadas por 

SIGTIERRAS, lo cual permitirá  contar con una mejor visión de los sitios en los cuales se 

han producido estos movimientos y de ser el caso confirmar su impacto en el territorio. 

6.2 ANÁLISIS DE LOS FACTORES A SER CONSIDERADOS PARA LA 

DETERMINACIÓN DE LOS RIESGOS 

Los factores que intervienen en el mapa de riesgo geológico, han sido analizados a través 

de la metodología del ITC de Holanda y son los que se describen a continuación: 

El insumo principal para iniciar el análisis es el mapa de fenómenos de remoción en masa 

Ilustración 16, al cual le corresponde un área de 4.3 km2 que representa el 4.11% del 

área de estudio 104.7 km2, por tanto la densidad de deslizamientos es de 0.0411 que 

corresponde al DENSMAP. 
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6.2.1 Peso parámetro geología 

 

Para obtener el peso del parámetro geología, se cruzó el mapa geológico que se presenta 

en la Ilustración 17 con el mapa de fenómenos de remoción en masa Ilustración 16, 

utilizando la herramienta Intersect (Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada unidad litológica y se procedió a colocar el área 

obtenida a cada unidad litológica en un nuevo campo denominado Areaact, las áreas de 

las unidades litológicas presentes en el territorio se obtuvieron creando un nuevo campo 

Areaclase, Click derecho sobre el shapefile > señalar open attribute table > Add Field… > 

señalar el campo > calculate geometry… > property: area > coordinate system: WGS 

1984 UTM Zone 17S  > units: square meters > ok. 

Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 

Las unidades litológicas que no presentan fenómenos de remoción en masa, en el campo 

correspondiente a Areaact se colocará el valor de 0.0001, más que nada porque al 

momento de sacar el logaritmo del número 0 este no existe y nos daría error. 

Con densclase y densmap, se crea un nuevo campo “Pesos” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Pesos > click derecho sobre el 

campo > Field calculator > Pesos = log (Densclase/Desmap)) 

Cuadro 31. Peso parámetro geología del cantón Chordeleg 

 
Fuente: Autor 

 

Al final se deberá dejar transformado el shapefile de geología a un archivo tipo raster 

utilizando la opción Conversion Tools > To Raster > Feature to Raster > en input feature: 

colocar el shapefile a transformar > en field: señalar el campo “peso_geo” > en output 

raster “colocar el nombre de archivo de salida” > output cell size (optional) redondear al 

inmediato inferior el número marcado que se refleje como entero en esta casilla. La 

Ilustración 37, muestra el peso parámetro geología obtenido a través del análisis. 
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Al final, los “pesos positivos” nos indican que los Depósitos Coluviales, Terrazas Fluvio 

Glaciares, Tobas de Gualaceo, Unidad Maguazo y Depósitos Aluviales son más 

susceptibles a desarrollar inestabilidades con respecto a los demás “pesos negativos” 

formación Tarqui, Tillitas, Unidad El Pan y Unidad Granitoide Tres Lagunas. El Cuadro 31, 

nos permite ver los resultados obtenidos. 

6.2.2 Peso parámetro distancia a ríos 

 

Para obtener el peso del parámetro distancia a ríos, se cruzó el mapa de distancia a ríos 

Ilustración 35 con el mapa de fenómenos de remoción en masa Ilustración 16, utilizando 

la herramienta Intersect (Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada área de incidencia y se procedió a colocar el área 

obtenida en cada clase (con o sin río) en un nuevo campo denominado Areaact, las áreas 

de las clases presentes en el territorio se obtuvieron creando un nuevo campo Areaclase, 

Click derecho sobre el shapefile > señalar open attribute table > Add Field… > señalar el 

campo > calculate geometry… > property: area > coordinate system: WGS 1984 UTM 

Zone 17S  > units: square meters > ok. 

Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 

Con el densclase y el densmap, se crea un nuevo campo “Peso” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Peso > click derecho sobre el 

campo > Field calculator > Peso = log (Densclase/Desmap)) 

Cuadro 32. Peso parámetro distancia a ríos del cantón Chordeleg 

Fuente: Autor 

Al final se deberá dejar transformado el shapefile de ríos a un archivo tipo raster utilizando 

la opción Conversion Tools > To Raster > Feature to Raster > en input feature: colocar el 

shapefile a transformar > en field: señalar el campo “peso” > en output raster “colocar el 

nombre de archivo de salida” > output cell size (optional) redondear al inmediato inferior el 

número marcado que se refleje como entero en esta casilla. La Ilustración 38 muestra el 

peso parámetro distancia a ríos. 

Concluimos que la cercanía a drenajes no incide en el desarrollo de inestabilidades, ver 

Cuadro 32; el peso de la zona fuera del área de incidencia tiene baja susceptibilidad 

relativa a generar inestabilidades. 
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Ilustración 37. Mapa peso parámetro geología del cantón Chordeleg 

 

Elaboración: Autor 
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Ilustración 38. Mapa peso parámetro distancia a ríos 

 

Elaboración: Autor 
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6.2.3 Peso parámetro pendiente 

 

Con la curvas de nivel a escala 1:50.000 y la utilización de la herramienta informática 

ArcGis, se generó el modelo digital del terreno –MDT- del cantón Chordeleg, que según 

Miller y Laflamme, lo definen como una “representación estadística del terreno, en forma 

de números digitales, por medio de un conjunto de puntos con coordenadas (x, y, z) 

respecto a un sistema de georreferenciación conocido”  (Miller & Laframme, 1958). 

Con el MDT ingresamos a Arctoolbox > spatial analyst tolos > surface > slope, en Input 

raster file introducimos nuestro archivo raster, en Output raster la carpeta donde 

queremos almacenar nuestro nuevo archivo raster, seleccionamos degrees y el tamaño 

del pixel de acuerdo a la cartografía con la que estamos trabajando, para nuestro caso 

particular se deberá colocar 50 debido a que estamos trabajando a escala 1:50.000. Una 

vez generado el mapa de pendientes se procede a la reclasificación ingresando a la 

opción Reclassify en la cual se deberá colocar clasify y seleccionar el método Manual e 

incluir el número 4 y los valores establecidos en los rangos para clasificar la pendiente, 

como se observa en el Cuadro 33 que se muestra a continuación: 

Cuadro 33. Clases de pendientes  

Clase de 

Pendiente 

Rango 

(Grados) 

Baja 0 – 15 

Media 15 – 35 

Alta 35 – 50 

Muy Alta > 50 

Fuente: (Gobierno Provincial del Azuay, 2012) 

Para obtener el peso del parámetro pendientes, se cruzó el mapa de pendientes 

Ilustración 18 con el mapa de amenazas Ilustración 16, utilizando la herramienta Intersect 

(Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada clase de pendiente y se procedió a colocar el área 

obtenida en cada clase en un nuevo campo denominado Areaact, las áreas de las clases 

presentes en el territorio se obtuvieron creando un nuevo campo Areaclase, Click derecho 

sobre el shapefile > señalar open attribute table > Add Field… > señalar el campo > 

calculate geometry… > property: area > coordinate system: WGS 1984 UTM Zone 17S  > 

units: square meters > ok. 

Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 



 
Universidad de Cuenca                                                                                                                 
Facultad de Arquitectura y Urbanismo 
Maestría en Ordenación Territorial II Cohorte                                                                     

126 
Ing. Andrea Valerie Brito Puni 

Con el densclase y el densmap, se crea un nuevo campo “Peso” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Peso > click derecho sobre el 

campo > Field calculator > Peso = log (Densclase/Desmap)) 

Cuadro 34. Peso parámetro pendiente del cantón Chordeleg 

 
Fuente: Autor 

 

Al final se deberá dejar transformado el shapefile pendiente a un archivo tipo raster 

utilizando la opción Conversion Tools > To Raster > Feature to Raster > en input feature: 

colocar el shapefile a transformar > en field: señalar el campo “peso” > en output raster 

“colocar el nombre de archivo de salida” > output cell size (optional) redondear al 

inmediato inferior el número marcado que se refleje como entero en esta casilla. La 

Ilustración 39 muestra el peso del parámetro pendiente obtenido. 

Del análisis realizado y el peso asignado concluimos que las pendientes de clase baja les 

corresponde la mayor susceptibilidad a inestabilizarse que las demás clases, siendo la 

menos susceptible la clase muy alta, y de forma intermedia la clase media y alta, revisar 

Cuadro 34. 

 

6.2.4  Peso parámetro fallas 

 

Para obtener el peso del parámetro fallas, se cruzó el mapa de fallas Anexo 4, con el 

mapa de fenómenos de remoción en masa Ilustración 16, utilizando la herramienta 

Intersect (Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada área de incidencia y se procedió a colocar el área 

obtenida en cada clase (con o sin falla) en un nuevo campo denominado Areaact, las 

áreas de las clases presentes en el territorio se obtuvieron creando un nuevo campo 

Areaclase, Click derecho sobre el shapefile > señalar open attribute table > Add Field… > 

señalar el campo > calculate geometry… > property: area > coordinate system: WGS 

1984 UTM Zone 17S  > units: square meters > ok. 

Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 
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Ilustración 39. Mapa peso parámetro pendiente 

 
Elaboración: Autor 
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Con el densclase y el densmap, se crea un nuevo campo “Peso” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Peso > click derecho sobre el 

campo > Field calculator > Peso = log (Densclase/Desmap)). 

Cuadro 35. Peso parámetro fallas del cantón Chordeleg 

 
Fuente: Autor 

 

Al final se deberá dejar transformado el shapefile fallas en un archivo tipo raster utilizando 

la opción Conversion Tools > To Raster > Feature to Raster > en input feature: colocar el 

shapefile a transformar > en field: señalar el campo “peso” > en output raster “colocar el 

nombre de archivo de salida” > output cell size (optional) redondear al inmediato inferior el 

número marcado que se refleje como entero en esta casilla.  

Del análisis realizado y el peso asignado concluimos que la cercanía a lineamientos no es 

incidente en la susceptibilidad de inestabilidades del terreno, Cuadro 35. 

 

6.2.5 Peso parámetro uso de suelo 

 

El peso del parámetro uso de suelo, se obtuvo cruzando el mapa uso de suelo Ilustración 

10, con el mapa de fenómenos de remoción en masa Ilustración 16, utilizando la 

herramienta Intersect (Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada uso de suelo y se procedió a colocar el área obtenida a 

cada uso de suelo en un nuevo campo denominado Areaact, las áreas de los usos de 

suelo presentes en el territorio se obtuvieron creando un nuevo campo Areaclase, Click 

derecho sobre el shapefile > señalar open attribute table > Add Field… > señalar el campo 

> calculate geometry… > property: area > coordinate system: WGS 1984 UTM Zone 17S  

> units: square meters > ok. 

Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 

Los usos de suelo que no presentan fenómenos de remoción en masa, en el campo 

correspondiente a Areaact se colocará el valor de 0.0001, más que nada porque al 

momento de sacar el logaritmo del número 0 este no existe y nos daría error. 
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Ilustración 40. Mapa peso parámetro Fallas del cantón Chordeleg 

 

Elaboración: Autor 
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Con el densclase y el densmap, se crea un nuevo campo “Pesos” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Pesos > click derecho sobre el 

campo > Field calculator > Pesos = log (Densclase/Desmap)). 

 
Cuadro 36. Peso parámetro uso de suelo del cantón Chordeleg 

 
Fuente: Autor 

 

Al final se deberá dejar transformado el shapefile uso de suelo en un archivo tipo raster 

utilizando la opción Conversion Tools > To Raster > Feature to Raster > en input feature: 

colocar el shapefile a transformar > en field: señalar el campo “peso” > en output raster 

“colocar el nombre de archivo de salida” > output cell size (optional) redondear al 

inmediato inferior el número marcado que se refleje como entero en esta casilla. La  

Ilustración 41, presenta el peso parámetro Uso de Suelo. 

Los “pesos positivos” nos indican que los cultivos de ciclo corto y agua son los más 

susceptibles a desarrollar inestabilidades con respecto a los demás “pesos negativos” 

pastos, mosaico cultivos, bosque y páramo. El Cuadro 36, permite ver estos resultados. 

 

6.2.6 Peso parámetro dirección de la pendiente 

 

Para obtener el peso del parámetro dirección de la pendiente, se cruzó el mapa de 
dirección  de pendiente Anexo 1, con el mapa de fenómenos de remoción en masa 
Ilustración 16, utilizando la herramienta Intersect (Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada dirección de pendiente y se procedió a colocar el área 

obtenida a cada dirección en un nuevo campo denominado Areaact, las áreas de 

dirección de la pendiente presentes en el territorio se obtuvieron creando un nuevo campo 

Areaclase, Click derecho sobre el shapefile > señalar open attribute table > Add Field… > 

señalar el campo > calculate geometry… > property: area > coordinate system: WGS 

1984 UTM Zone 17S  > units: square meters > ok. 

Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 
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Ilustración 41. Mapa peso parámetro uso de suelo del cantón Chordeleg 

 

Elaboración: Autor 
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El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 

Con el densclase y el densmap, se crea un nuevo campo “Pesos” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Pesos > click derecho sobre el 

campo > Field calculator > Peso = log (Densclase/Desmap)) 

Cuadro 37. Peso parámetro dirección de pendiente del cantón Chordeleg 

 
Fuente: Autor 

 

Al final se deberá dejar transformado el shapefile dirección de pendiente en un archivo 

tipo raster utilizando la opción Conversion Tools > To Raster > Feature to Raster > en 

input feature: colocar el shapefile a transformar > en field: señalar el campo “peso” > en 

output raster “colocar el nombre de archivo de salida” > output cell size (optional) 

redondear al inmediato inferior el número marcado que se refleje como entero en esta 

casilla. El peso del parámetro dirección de pendiente se observa en la Ilustración 42.  

Concluimos que los “pesos positivos” nos indican que la clase Noreste y Noroeste 

presentan pesos mayores que las otras clases y por lo tanto mayores susceptibilidades a 

inestabilizarse con respecto a los demás “pesos negativos”. El Cuadro 37, que se muestra 

a continuación nos permite ver estos resultados. 

 

6.2.7 Peso parámetro cercanía a vías 

 

Para obtener el peso del parámetro cercanía a vías, se cruzó el mapa de cercanía a vías 
Ilustración 32 con el mapa de amenazas Ilustración 16, utilizando la herramienta Intersect 
(Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada área de cercanía y se procedió a colocar el área 

obtenida en cada clase (con o sin vía) en un nuevo campo denominado Areaact, las áreas 

de las clases presentes en el territorio se obtuvieron creando un nuevo campo Areaclase, 

Click derecho sobre el shapefile > señalar open attribute table > Add Field… > señalar el 

campo > calculate geometry… > property: area > coordinate system: WGS 1984 UTM 

Zone 17S  > units: square meters > ok. 
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Ilustración 42. Mapa peso parámetro dirección de pendiente del cantón Chordeleg 

 
Elaboración: Autor 
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Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 

Con el densclase y el densmap, se crea un nuevo campo “Peso” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Peso > click derecho sobre el 

campo > Field calculator > Peso = log (Densclase/Desmap)) 

Cuadro 38. Peso parámetro cercanía a vías del cantón Chordeleg 

 
Fuente: Autor 

 

Al final se deberá dejar transformado el shapefile cercanía a vías a un archivo tipo raster 

utilizando la opción Conversion Tools > To Raster > Feature to Raster > en input feature: 

colocar el shapefile a transformar > en field: señalar el campo “peso” > en output raster 

“colocar el nombre de archivo de salida” > output cell size (optional) redondear al 

inmediato inferior el número marcado que se refleje como entero en esta casilla. El 

proceso realizado se ve reflejado en la Ilustración 43 

 

El Cuadro 38, permite concluir que las áreas cercanas a vías presentan mayor 

susceptibilidad a inestabilizarse que las áreas alejadas de las mismas.  
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Ilustración 43. Mapa peso parámetro cercanía a vías del cantón Chordeleg 

 
Elaboración: Autor 
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6.2.8  Peso parámetro caracterización geotécnica 

 

Para obtener el peso del parámetro caracterización geotécnica, se cruzó el mapa de 

caracterización geotécnica que resulta de valorar las formaciones geológicas presentes 

en el área de estudio Ilustración 17, con el mapa de fenómenos de remoción en masa 

Ilustración 16, utilizando la herramienta Intersect (Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada unidad litológica y se procedió a colocar el área 

obtenida a cada unidad litológica en un nuevo campo denominado Areaact, las áreas de 

las unidades litológicas presentes en el territorio se obtuvieron creando un nuevo campo 

Areaclase, Click derecho sobre el shapefile > señalar open attribute table > Add Field…                                                                                        

> señalar el campo > calculate geometry… > property: area > coordinate system: WGS 

1984 UTM Zone 17S  > units: square meters > ok. 

Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 

Con el densclase y el densmap, se crea un nuevo campo “Pesos” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Pesos > click derecho sobre el 

campo > Field calculator > Pesos = log (Densclase/Desmap)) 

Cuadro 39. Peso parámetro caracterización geotécnica del cantón Chordeleg 

 
Fuente: Autor 

 

Al final se deberá dejar transformado el shapefile caracterización geotécnica a un archivo 

tipo raster utilizando la opción Conversion Tools > To Raster > Feature to Raster > en 

input feature: colocar el shapefile a transformar > en field: señalar el campo “peso” > en 

output raster “colocar el nombre de archivo de salida” > output cell size (optional) 

redondear al inmediato inferior el número marcado que se refleje como entero en esta 

casilla. 

Los “pesos positivos” nos indican que Terrazas Fluvio Glaciares y Tillitas son las más 

susceptibles a desarrollar inestabilidades con respecto a los demás “pesos negativos”. El 

Cuadro 39 y la Ilustración 44, permiten mostrar los resultados obtenidos luego del análisis. 
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Ilustración 44. Mapa peso parámetro caracterización Geotécnica del cantón Chordeleg 

 
Elaboración: Autor 
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6.2.9  Peso parámetro morfología 

 

Para obtener el peso del parámetro morfología, se cruzó el mapa de morfología Anexo 2, 

con el mapa de fenómenos de remoción en masa Ilustración 16, utilizando la herramienta 

Intersect (Analysis Tools > Overlay > Intersect). 

Una vez realizada la intersección se determinó las áreas de fenómenos de remoción en 

masa que se encuentran en cada unidad morfológica y se procedió a colocar el área 

obtenida a cada unidad morfológica en un nuevo campo denominado Areaact, las áreas 

de las unidades morfológicas presentes en el territorio se obtuvieron creando un nuevo 

campo Areaclase, Click derecho sobre el shapefile > señalar open attribute table > Add 

Field… > señalar el campo > calculate geometry… > property: area > coordinate system: 

WGS 1984 UTM Zone 17S  > units: square meters > ok. 

Una vez definidas las áreas se obtuvo el Densclase, (Click derecho sobre el shapefile > 

señalar open attribute table > Add Field… > Densclase > click derecho sobre el campo > 

Field calculator > Densclase = Areaact/Areaclase). 

El Densmap, también hay que crearle en la tabla de atributos (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field…> Densmap > click derecho sobre el 

campo > Field calculator > Densmap = 0.0411). 

Con el densclase y el densmap, se crea un nuevo campo “Pesos” (Click derecho sobre el 

shapefile > señalar open attribute table > Add Field… > Pesos > click derecho sobre el 

campo > Field calculator > Pesos = log (Densclase/Desmap)) 

Cuadro 40. Peso parámetro morfología del cantón Chordeleg 

 
Fuente: Autor 

 

Al final se deberá dejar transformado el shapefile morfología a un archivo tipo raster 

utilizando la opción Conversion Tools > To Raster > Feature to Raster > en input feature: 

colocar el shapefile a transformar > en field: señalar el campo “peso” > en  raster “colocar 

el nombre de archivo de salida” > output cell size (optional) redondear al inmediato inferior 

el número marcado que se refleje como entero en esta casilla. 

La Ilustración 45 y el Cuadro 40, permite ver que los “pesos positivos” indican que las 

vertientes convexas y terrazas bajas son las más susceptibles a desarrollar 

inestabilidades con respecto a los demás “pesos negativos”. 
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Ilustración 45. Mapa Peso parámetro Morfología del cantón Chordeleg 

 
Elaboración: Autor 
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6.3 ZONIFICACIÓN DEL RIESGO GEOLÓGICO 

 

Para realizar la zonificación del riesgo geológico hemos analizado dos alternativas para 

obtenerlo, la primera a través de la multiplicación de amenazas y vulnerabilidades y la 

segunda a través de la aplicación del Índice de Deslizamiento. 

La primera alternativa considera el cálculo de las amenazas por los métodos de la 

Secretaria de Gestión de Riegos Ilustración 23, Brabb Ilustración 24 y Mora – Vahrson 

Ilustración 47, definidas las amenazas se procedió a multiplicar por  el mapa de 

Vulnerabilidad  

Ilustración 36, para así obtener el mapa de Riesgos por los distintos métodos, Ilustración 

46 correspondiente al de Brabb e Ilustración 47 al de Mora y Vahsron, esta multiplicación 

de mapas se la realizó utilizando la herramienta informática raster calculation con la cual 

en función de los valores asignados a cada factor de análisis se obtuvo el mapa de 

riesgos.  

La segunda alternativa del “Índice Deslizamiento” desarrollado por el ITC de Holanda que 

considera 9 parámetros para realizar el análisis del riesgo y los cuales se encuentran 

descritos en el ítem 7.2, la suma de los pesos parciales determinados en cada uno de los 

parámetros analizados, se puede interpretar como la susceptibilidad general del territorio 

a que se produzca inestabilidades sobre el mismo. La Ilustración 48 muestra el mapa de 

riesgos obtenido por este método. 
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Ilustración 46. Mapa de riesgos del cantón Chordeleg – método de Brabb 

 

Elaboración: Autor 
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Ilustración 47. Mapa de riesgos del cantón Chordeleg – método Mora - Vahrson 

 

Elaboración: Autor 
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Ilustración 48. Mapa de riesgos – método Índice de Deslizamiento 

 

Elaboración: Autor 
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6.4 CLASIFICACIÓN DEL RIESGO GEOLÓGICO 

 

Para clasificar el riesgo geológico hemos utilizado el método Standard Deviation, que 

representan 5 zonas de riesgo: Muy Alto, Alto, Medio, Bajo y Despreciable, es decir que 

los valores de frontera entre estas cualificaciones se definan a partir del Histograma de 

Frecuencias de los valores de peso total obtenidos (-17.90 - 9.12) de manera que los 

mismos representen cambios cualitativos importantes y se vean reflejados en las 

observaciones realizadas en campo. El Cuadro 41, presenta los límites de frontera 

determinados para cada zona de riesgo. 

 

Cuadro 41. Clasificación del riesgo geológico 

 

Fuente: Autor 

 

Una vez realizada la clasificación podemos encontrar: Riesgo Muy Altos, Altos, Medios, 

Bajos y Despreciables. La delimitación espacial de los resultados, permitirá a los 

Planificadores proponer acciones para mitigar los posibles efectos del riesgo geológico en 

el territorio cantonal, los cuales deberán ir acompañados de una planificación y gestión 

territorial a corto, mediano y largo plazo de acuerdo a una jerarquización realizada con los 

actores locales en el territorio.  



 
Universidad de Cuenca                                                                                                                 
Facultad de Arquitectura y Urbanismo 
Maestría en Ordenación Territorial II Cohorte                                                                     

146 
Ing. Andrea Valerie Brito Puni 

7. MATRIZ DE DECISIONES 

 

Dentro de las Disposiciones Especiales de los Gobiernos Metropolitanos y Municipales del 

Código Orgánico de Organización Territorial Autonomía y Descentralización –COOTAD-, 

en el artículo 466 referente a atribuciones en el ordenamiento territorial, les corresponden 

a los gobiernos municipales “el control sobre el uso y ocupación del suelo en el territorio 

del cantón, por lo cual los planes y políticas de ordenamiento territorial de este nivel 

racionalizarán las intervenciones en el territorio de todos los gobiernos autónomos 

descentralizados (COOTAD, 2010). 

 

El plan de ordenamiento territorial deberá contemplar estudios parciales… y la 

evaluación de riesgos de desastres…  (COOTAD, 2010). 

 

El Artículo 42 del Código Orgánico de Planificación y Finanzas Públicas –COPYFP- y el 

295 del Código Orgánico de Organización Territorial Autonomía y Descentralización, 

hacen referencia a los contenidos mínimos que los planes de desarrollo deberán contener 

Diagnóstico, Propuesta y Modelo de Gestión. 

 

Los puntos considerados dentro de esta matriz son los que según Domingo Gómez Orea, 

en su libro Ordenación Territorial, en la Ilustración 49 se indica las etapas por las cuales 

debería pasar el Plan de Ordenamiento Territorial son: diagnóstico territorial, planificación 

territorial y gestión territorial  (Gómez Orea, 2008).  

 

Por tanto, la matriz de decisiones se refiere a las acciones que los Planificadores de los  

Gobiernos Autónomos Descentralizados, deberán considerar al momento de elaborar y/o 

actualizar los Planes de Ordenamiento Territorial a nivel cantonal, en el tema referente a 

Riesgos Geológicos, es decir, los contenidos mínimos que deberían analizarse en cada 

una de las etapas indicadas en los instrumentos de planificación COOTAD, COPYFP y 

Domingo Gómez Orea.                                                                         

Ilustración 49. Etapas del Plan de Ordenamiento Territorial,  (Gómez Orea, 2008) 

 
Elaboración: Autor 
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7.1 DIAGNÓSTICO TERRITORIAL 

 

El literal a) del Artículo 42 del COPYFP, correspondiente al Diagnóstico indica que “para 

la elaboración del diagnóstico, los gobiernos autónomos descentralizados deberán 

observar, por lo menos, contenidos que describan las inequidades y desequilibrios socio 

territoriales, potencialidades y oportunidades de su territorio, la situación deficitaria, los 

proyectos existentes en el territorio, las relaciones del territorio con los circunvecinos, la 

posibilidad y los requerimientos del territorio articuladas al Plan Nacional de Desarrollo y, 

finalmente, el modelo territorial actual;”  (COPYFP, 2011) 

 

En la metodología propuesta por Gómez Orea, los riesgos geológicos deben analizarse 

dentro de la etapa de Diagnóstico Territorial, en el subsistema Diagnóstico del Medio 

Físico y Recursos Naturales, debido a que en este capítulo se podrá conocer los 

elementos y procesos que operan en el territorio, así como detectar, localizar y valorizar 

los procesos, amenazas, vulnerabilidades y riesgos naturales (inundación, erosión, 

desprendimiento, deslizamiento, expansividad, sismicidad, vulcanismo, etc), a los que 

estaría expuesto el territorio  (Gómez Orea, 2008). 

 

Además, entre una de las tareas a realizar como parte del diagnóstico esta la 

“Determinación de la fragilidad del medio y sus recursos frente a actividades que debe 

ordenar el plan. Por tal se entiende el grado de vulnerabilidad de sus elementos y 

procesos, es decir la mayor o menor facilidad de soportar las incidencias procedentes de 

tales actividades”, lo cual está desarrollado en el capítulo 6  de este documento, así como 

los factores considerados para obtener el mapa de vulnerabilidad referente a riesgos 

geológicos en el territorio cantonal  (Gómez Orea, 2008). 

 

Para iniciar el análisis de los riesgos geológicos en la fase de diagnóstico, de los Planes 

de Ordenamiento Territorial, es necesario seguir los siguientes pasos: 

 

1. Buscar información del territorio motivo de análisis, consultando la página del 

Sistema Nacional de Información en donde se podrá conseguir información 

cartográfica y estadística, sin embargo, se podría visitar las Instituciones citadas 

en este documento con la finalidad de obtener  la información necesaria. Se 

deberá levantar información en recorridos de campo, consultando a la población si 

han existido movimientos previos que ameriten un mayor análisis y revisar 

documentación existente al respecto. 

 

2. En base a la información recopilada se procederá a analizar las amenazas y 

vulnerabilidades. 

 

3. En las amenazas se podrá aplicar cualquiera de los métodos analizados en este 

documento, como son el de la Secretaría de Gestión de Riesgos, Brabb y Mora – 

Vahrson. 

 En  el método de la Secretaría de Gestión de Riesgos se deberán preparar 

los mapas de pendientes, uso de suelo, textura, profundidad del suelo, 



 
Universidad de Cuenca                                                                                                                 
Facultad de Arquitectura y Urbanismo 
Maestría en Ordenación Territorial II Cohorte                                                                     

148 
Ing. Andrea Valerie Brito Puni 

unidades litológicas, geomorfología, estructuras e isoyetas, para en base a 

los factores de ponderación obtener el mapa de amenazas. 

 Para utilizar el método de Brabb, se deberá contar con el mapa de 

fenómenos de remoción en masa, unidades litológicas y pendientes. 

 El método de Mora y Vahrson utiliza como parámetros los índices de 

relieve relativo, influencia litológica, humedad del suelo, actividad sísmica e 

influencia de lluvias intensas. 

  

4. Con respecto a las vulnerabilidades, es necesario se elaboren los mapas de 

distribución poblacional por áreas censales, ubicación de equipamientos (Salud, 

Educación), Conectividad Vial y Sistema Hidrográfico. Realizados cada uno de 

ellos en base a las combinaciones propuestas se obtendrá la zonificación de las 

vulnerabilidades presentes en el territorio de análisis. 

 

5. Con el cruce de los mapas de amenazas y vulnerabilidades se obtiene el mapa de 

riesgos geológicos. 

 

6. Hay que destacar que dentro de este análisis se presentó, el método del Índice de 

Deslizamiento, en el que se obtiene el método de riesgos analizando los 

parámetros geología, distancia a ríos, pendiente, fallas, uso de suelo, cercanía a 

vías, morfología, caracterización geotécnica y dirección de pendientes. 

 

Las actividades antes mencionadas nos resumen los pasos a seguir para obtener el mapa 

de riesgos, por los diferentes métodos analizados, además nos permite demostrar que no 

se necesita de ninguna experticia del Planificador del GAD Municipal para realizar este 

análisis. 

 

Los mapas de zonificación y su respectiva clasificación del riesgo geológico son insumos 

importantes para analizar la determinación de la capacidad de acogida, debido a que una 

vez valoradas las Unidades Ambientales,  estas forman parte del modelo de diagnóstico 

que permiten tener una  lectura del medio físico al especificar los usos vocacionales, 

compatibles e incompatibles por cada Unidad Ambiental. Hay que recalcar que “las 

amenazas se entienden como una especie de prospectiva sobre degradaciones y son 

previas a la determinación de la capacidad de acogida, mientras los conflictos surgen en 

un momento más elaborado de la información” (Gómez Orea, 2008).  

 

La determinación de los riesgos geológicos asociados a los fenómenos de remoción en 

masa, constituyen un aporte a la planificación territorial, en el sentido que “posibilita una 

mejor valoración de las condiciones del medio geológico, de las causales y condicionales 

de los deslizamientos, y su influencia sobre las actividades socio-económicas” en 

determinado territorio  (Ellis & Guardado Lacaba, 2012). 

  

 

La Ilustración 50, muestra un esquema para realizar el análisis de los riesgos geológicos 

en la fase del Diagnóstico Territorial de los Planes de Ordenamiento Territorial a nivel 
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cantonal y en la que podrían guiarse para zonificar las amenazas, vulnerabilidades y 

determinar el riesgo. 

 

 

7.2 PLANIFICACIÓN TERRITORIAL 

 

El literal b) del Artículo 42 del COPYFP, correspondiente a la Propuesta menciona que 

“los gobiernos autónomos descentralizados tomarán en cuenta la visión de mediano y 

largo plazos, los objetivos, políticas, estrategias, resultados y metas deseadas, y el 

modelo territorial que debe implementarse para viabilizar el logro de sus objetivos, 

Ilustración 51  (COPYFP, 2011). 
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Ilustración 50. Esquema para el análisis de los riesgos geológicos en la fase del Diagnóstico Territorial  

 

 
Elaboración: Autor 
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Ilustración 51. Esquema de la propuesta de los Planes de Desarrollo y Ordenamiento Territorial  (COPYFP, 2011)  

 
 Elaboración: Autor 
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Según Gómez Orea, la planificación territorial se refiere a la formulación de las propuestas 

del plan, las cuales son de dos tipos: uno se refiere a la imagen objetivo o modelo del 

Sistema Territorial al que tenderán a largo plazo; el otro a las medidas de regulación, 

intervención y de gestión para avanzar a la imagen objetivo  (Gómez Orea, 2008). 

Una vez que el GAD Municipal cuente con el Mapa de Riesgos, los Planificadores 

deberán sobreponer el mapa de fenómenos de remoción en masa Ilustración 16, al mapa 

de riesgos obtenido por el método que mejor se ajuste a la realidad territorial, método de 

la Secretaría de Gestión de Riesgos, método de Brabb  

Ilustración 46, método de Mora – Vahrson Ilustración 47 y/o método del Índice de 

Deslizamiento Ilustración 48, y determinar de esta manera si las áreas con riesgo muy 

alto, alto y medio están cerca a los sitios de fenómenos de remoción en masa Ilustración 

52. 

Realizada la sobreposición, se deberá ejecutar una jerarquización de las acciones o 

propuestas a plantear tomado en consideración las siguientes situaciones que se podrían 

presentar en los territorios, según (Ellis & Guardado Lacaba, 2012): 

 

1. Zonas con riesgo muy alto no mitigable. En las que la presencia de una 

amenaza puede provocar altas pérdidas y no es posible realizar obras de 

protección, o en las que las que estas no son viables en términos económicos o 

sociales. Sugiriéndose convertirlas en zonas de protección de uso forestal 

exclusivo. En las cuales no es posible realizar ninguna actividad o solo aceptar la 

presencia humana restringida y regulada para uso recreativo de baja densidad, 

con el respaldo de un sistema de alerta temprana. En caso de existir 

asentamientos humanos en estas zonas se deberá formular un programa de 

reubicación de las familias en riesgo y de conversión del área en zona de 

protección con las características descritas. 

 

2. Zonas con riesgo alto mitigable. Aquellas en las que la presencia de una 

amenaza específica puede producir altas pérdidas, que es viable evitar mediante 

obras de protección. Estas zonas se deben convertir en zonas de tratamiento 

especial por riesgo, siendo preciso asignarles la máxima prioridad para la 

elaboración de un análisis detallado de los riesgos y el diseño y ejecución de 

medidas de protección. Se debe procurar, además que exista baja densidad 

poblacional y la ubicación de viviendas livianas, para que no aumente la 

vulnerabilidad. 

 

Para las zonas de tratamiento especial por riesgo deben definirse las siguientes 

medidas de protección: 
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Ilustración 52. Sobreposición del mapa de fenómenos de remoción en masa al mapa de riesgos 
método del Índice de Deslizamiento 

 

Elaboración: Autor 
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a) Medidas estructurales: Referido a programas integrales de modificación de 

las condiciones de vulnerabilidad (por ejemplo, en una zona de riesgo por 

movimientos en masa, planes de manejo de fenómenos de remoción en 

masa que incluya manejo de aguas superficiales y subterráneas que estén 

causando superficies de falla). 

 

b) Medidas complementarias: Actividades que se llevan a cabo fuera de la 

zona de riesgo que contribuyen a reducir la vulnerabilidad (por ejemplo, 

construcción de reservorios de manera planificada, con estudios técnicos 

que demuestren su viabilidad técnica). 

 

c) Medidas de mantenimiento: Actividades permanentes destinadas a 

conservar las condiciones de menor riesgo posible (por ejemplo, limpieza 

de cauces y drenajes que provoquen represamiento de agua y por tanto 

infiltración aguas abajo). 

 

d) Medidas de reacción inmediata: sistemas de alerta temprana y movilización 

ciudadana. 

 

e) Medidas de recuperación: planes de emergencia y contingencia. 

 

3. Zonas con riesgo medio. Aquellas que requieren el diseño y la ejecución de 

medidas estructurales, complementarias y de mantenimiento y el establecimiento 

de sistemas de alerta temprana y capacidad de reacción, así como la 

normalización de los asentamientos humanos y la optimización de los servicios 

públicos. Se deben establecer requisitos para el otorgamiento de licencias 

urbanísticas y de construcción, que logren minimizar el grado de exposición a la 

amenaza y maximizar los niveles de protección. 

 

4. Zonas con riesgo bajo o nulo: Zonas aptas para la ubicación de viviendas, 

escuelas y centros de afluencia masiva de personas, así como de programas de 

vivienda social. 

 

Una vez priorizadas las áreas y definidas cada una de las situaciones que se podrían 

presentar en el territorio, los Planificadores deberán contratar un profesional que realice 

una visita técnica a los sitios de interés e indique la pertinencia o no de realizar estudios a 

detalle en cada uno de ellos. 

 

Una vez que se realice la selección del profesional, y se definan las áreas a ser 

investigadas, el Consultor en su informe deberá elaborar Términos de Referencia, que al 

menos contengan la siguiente información. 

 

 Delimitación del área a ser estudiada. 
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 Requerimiento de cartografía (especificar escala) o topografía, de acuerdo al nivel 

de detalle que requiera la investigación. 

 Cuantificación de las exploraciones a realizar en campo, es decir: ensayos de 

geofísica, excavaciones a cielo abierto o perforación, tipo de ensayos de 

laboratorio, etc. 

 Detalle de productos a entregar: Informe técnico de la solución con sus respectivos 

planos constructivos, especificaciones técnicas, presupuesto de intervención y 

plazo de entrega. 

 

Una vez realizados los Términos de Referencia, el GAD Municipal deberá contratar las 

Consultorías necesarias que permitan obtener los estudios técnicos que determinen la 

viabilidad técnica de las obras de remediación a ejecutarse, es importante, que las 

Consultorías realizadas se lleven a nivel de perfil de proyecto por lo menos con la 

finalidad de contar con datos que permitan conocer: 

 

 Unidad Operativa encargada de la ejecución del proyecto 

 Monto de inversión y fuentes de financiamiento 

 Plazo de ejecución y cronograma de intervención 

 Área de influencia e impacto territorial 

 Población beneficiaria directa e indirecta 

 Análisis de oferta y demanda 

 Indicadores de evaluación económica 

 Estrategias de seguimiento y evaluación 

 Estructura operativa 

 Indicadores de resultado 

 

Con los criterios técnicos ya obtenidos en base a la planificación de las consultorías, el 

equipo de Planificación del GAD Municipal, deberá dejar planteadas las acciones de 

intervención a corto, mediano y largo plazo con objetivos, políticas, estrategias, resultados 

y metas deseadas para el territorio. 

 

7.3 GESTIÓN TERRITORIAL 

 

El literal c) del Artículo 42 del COPYFP, correspondiente al Modelo de Gestión menciona 

que “los gobiernos autónomos descentralizados deberán precisar, por lo menos, los datos 

específicos de los programas y proyectos, cronogramas estimados y presupuestos, 

instancias responsables de la ejecución, sistema de monitoreo, evaluación y 

retroalimentación que faciliten la rendición de cuentas y el control social Ilustración 53 

(COPYFP, 2011). 
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Ilustración 53. Esquema del Modelo de Gestión de los Planes de Desarrollo y Ordenamiento Territorial  
(COPYFP, 2011)  

 

Elaboración: Autor 

 

Gómez Orea, indica que esta etapa consiste en establecer los gestores, la forma,  el 

presupuesto, la financiación, etc. Necesarios para materializar el plan. Pero la gestión del 

plan no debe entenderse como una fase secuencial que sigue a la de formulación del 

plan, sino que ambas son iterativas, se van sucediendo en ciclos de retroalimentación, 

conformando un proceso de planificación continua  (Gómez Orea, 2008). 

 

En el artículo 140, del Código Orgánico de Organización Territorial, Autonomía y 

Descentralización  - COOTAD- correspondiente al Ejercicio de la competencia de gestión 

de riesgos, “que incluye las acciones de prevención, reacción, mitigación, reconstrucción y 

transferencia, para enfrentar todas las amenazas de origen natural o antrópico que 

afecten al cantón se gestionarán de manera concurrente y de forma articulada con las 

políticas y los planes emitidos por el organismo nacional responsable, de acuerdo a la 

Constitución y la ley…” (COOTAD, 2010). 

 

Es así que una vez definido los proyectos el GAD Municipal deberá formular un programa 

de intervención relacionado al tema de Riesgos, en el cual incluya todos los proyectos a 

ejecutarse con sus respectivos montos de inversión y plazos, como el número de 

Términos de Referencia o consultorías que deban contratarse, con la finalidad de tener un 

detalle de la planificación a corto, mediano y largo plazo en el tema de riesgos en el 

territorio. 

 

Con estas definiciones se deberá poner en marcha los proyectos planteados, los cuales 

deberán contar con un equipo de Supervisión y Fiscalización por parte de GAD Municipal, 

es decir que la priorización para la ejecución de los mismos este en función de su impacto 
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en el territorio, es decir aquellos que estén a punto de causar daños tanto a población, 

infraestructuras, vías de comunicación, establecimientos educativos, etc, deberán 

considerarse como prioritarios y ser ejecutados en el menor tiempo posible. 

 

El GAD Municipal deberá considerar de su presupuesto institucional asignaciones para la 

ejecución de estos proyectos con la finalidad de reducir el riesgo en el territorio, o 

gestionar financiamiento externo que permita su ejecución, o a través de la creación de un 

equipo técnico que se encargue de realizar dichas actividades  ante Instituciones de 

carácter público y/o privado. 

 

Una vez puesta en marcha los proyectos, el equipo técnico deberá nombrar un 

Administrador, Supervisor y Fiscalizador, el cual se encargará que las actividades 

relacionadas a la estabilidad de taludes u obras de mitigación contempladas en las 

diferentes consultorías se cumplan a satisfacción de acuerdo a las especificaciones 

técnicas establecidas en los referidos estudios. 

 

Al ser proyectos que necesitan contar con un monitoreo continuo una vez realizadas las 

intervenciones, el Planificador deberá revisar que los estudios técnicos indiquen el tipo de 

evaluaciones a realizar una vez  que se termine de realizar las intervenciones con la 

finalidad de conocer si las obras realizadas están dando los resultados esperados. 

 

A continuación, se presentan los principios conceptuales para el establecimiento de un 

proceso estratégico que conduzca a la gestión de riesgos  en las Municipalidades, 

desarrolladas por la CEPAL y Martha Llanos: 

 

1. Diagnóstico y documentación del medio recogiendo la memoria histórica, de modo 

de lograr la adecuada orientación de la planificación para el desarrollo sostenible 

del municipio, territorio o región. Tomando a la prevención como elemento 

fundamental, de modo de no reconstruir la vulnerabilidad. 

 

2. Emplear una tipología única de desastres. 

 

3. Desarrollar un sistema cartográfico, y sus consecuencias sobre la base de 

fotografías aéreas, imágenes satelitales, mapas, y sistemas de información 

geográfica. Emplear escalas apropiadas. 

 

4. Analizar y evaluar los factores humanos que determinan la vulnerabilidad, e 

influyen en la intensidad de los desastres, vinculados a la influencia de los 

aspectos económicos, la actividad productiva, y la dinámica social como el 

crecimiento demográfico, la expansión caótica del urbanismo, la infraestructura, la 

producción de bienes y servicios, la situación sociocultural, la estructura de 

liderazgo y la situación de pobreza. 
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5. Desarrollar un sistema de planificación física, de ordenamiento territorial, 

adecuando la legislación y normas vigentes así como las herramientas de control y 

la existencia de planes de emergencia, estabilización y corrección. 

 

6. Incorporar los factores de vulnerabilidad y riesgos en la preparación de proyectos y 

programas por medios tecnificados de vigilancia y evaluación y el establecimiento 

de situaciones hipotéticas y procesos correspondientes. 

 

7. Considerar la prevención como política de Estado. 

 

 

8.  CONCLUSIONES Y RECOMENDACIONES 

 

8.1 CONCLUSIONES 

 

 Los fenómenos de remoción en masa constituyen un riesgo geológico que 

combina factores naturales y/o antrópicos que deben ser considerados en el 

Ordenamiento Territorial, debido a que estos modifican el uso del suelo para el 

cual estaba destinado o siendo utilizado en determinado momento.  

 

 Analizar el riesgo geológico en los planes de Ordenamiento Territorial a nivel 

cantonal, constituye una herramienta fundamental para la planificación de los 

territorios, en el sentido que, determina las zonas en las cuales existen o podrían 

presentarse problemas de amenazas por movimientos en masa y como la 

activación de los mismos pondría en peligro a poblaciones e infraestructura ahí 

asentadas.  

 

 La información requerida en el análisis de los distintos parámetros de las 

metodologías analizadas, se la puede obtener ingresando al Sistema Nacional de 

Información –SNI- o a través de una solicitud dirigida a la Secretaría Nacional de 

Planificación y Desarrollo -SENPLADES-.  

 

 Los mapas de amenazas determinados en las distintas metodologías analizadas 

utilizando un sistema de información geográfico, nos permiten dar cuenta que son 

sencillos de obtener, cuando se cuenta con información secundaria.  

 

 Contar con un mapa de riesgo geológico permite tener identificadas áreas con 

fenómenos de remoción en masa presentes o potenciales y su grado de afectación 

en el cantón, y a través, de estudios posteriores determinar los componentes 

condicionantes y desencadenantes que han ocasionado o pueden ocasionar tales 

deslizamientos y valorar los efectos que producirían a actividades económicas, 

sociales y ambientales que se encuentra en el área directa e indirecta del 

fenómeno.  
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 Los mapas de riesgo geológico identifican áreas con fenómenos de remoción de 

masa activos o potenciales y su grado de afectación al cantón. Esta información 

proporciona áreas de interés prioritario para realizar estudios posteriores que 

determinen los componentes condicionantes y desencadenantes de estos 

fenómenos así como también  valorar los efectos a las actividades económicas, 

sociales y ambientales. 

 

 Caracterizado el cantón Chordeleg y analizados cada uno de los parámetros que 

intervienen en los distintos métodos revisados en este documento, sobre 

amenazas y vulnerabilidades, se concluye que el mapa de riesgos calculado por el 

método del Índice de Deslizamiento es el que mejor se ajusta a la ubicación de los 

fenómenos de remoción en masa detectados en el territorio. 

 

 Una vez realizada la zonificación de los mapas de amenazas, vulnerabilidades y 

riesgo geológico, su clasificación va a depender del tipo de método que se utilice; 

para nuestro análisis utilizamos el de la Desviación Estándar, que es el que mejor 

resultado nos dio con la problemática registrada en el cantón. 

 

 El riesgo nulo y bajo no necesitan ser analizados en evaluaciones posteriores. 

 

 La matriz de decisiones resume los puntos mínimos a desarrollar cuando se 

analice el riesgo geológico en un Plan de Ordenamiento Territorial a nivel cantonal 

dentro de las fases de diagnóstico, planificación y gestión territorial planteadas por 

Domingo Gómez Orea y que están en relación a lo que solicita el Código Orgánico 

de Planificación y Finanzas Públicas. 

 

8.2 RECOMENDACIONES 

 

 La regulación del uso y ocupación del suelo en el territorio cantonal deberá 

considerar durante el proceso de planificación el tema de riesgos geológicos, el 

modelo de territorio actual debería actualizarse conforme se presenten nuevas 

activaciones de movimientos de masa en el territorio. 

 

 El Gobierno Autónomo Descentralizado Municipal del cantón Chordeleg debería 

utilizar la información resultante de esta investigación como insumo para analizar 

las fases posteriores del PDOT planificación y gestión territorial referente al tema 

de riesgos geológicos. 

 

 Recomendar estos procedimientos a los GADs Cantonales de la Zona 6 de 

planificación, para que los mismos sean aplicados de forma previa a la 

contratación de una consultoría sobre el tema, con el fin de priorizar las 

intervenciones o focalizar la obtención de información adicional. 
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 Introducir en un sistema de información geográfica único los parámetros aquí 

presentados para que sirvan, además de herramienta de evaluación de riesgo, 

como una plataforma única de planificación a nivel cantonal. 

 

 Capacitar con base a este documento a los GADs cantonales de la regional 6 para 

que apliquen estás metodologías en su territorio. 

 

 Los mapas de riesgos geológicos deben ser actualizados periódicamente y de ser 

necesario mejorar su escala. El mapa deberá interpretarse como una referencia y 

no como valores absolutos a aplicarse directamente al territorio. 
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ANEXOS 

Anexo 2. Mapa morfológico del cantón Chordeleg 

 
Elaboración: Autor 
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Anexo 3. Mapa dirección de pendiente del cantón Chordeleg 

 

Elaboración: Autor 
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Anexo 4. Mapa de fallas del cantón Chordeleg 

 

Elaboración: Autor 


